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Introduction

his document describes how to install and upgrade the SAP Enterprise Inventory and Service-
Level Optimization (EIS) application. It includes information about the requirements for using 
EIS, instructions for installing the applications and database schemas, and specifications for 

configuring the data loader. It also provides information about testing, customizing, and maintaining 
EIS.

EIS installation workflow
The EIS Installation and Upgrade Guide is organized into chapters that follow the workflow of a typical 
installation of the EIS software. Each installation has two main parts: configuring the database and 
installing the schemas, and installing and configuring the application server. Before loading a data set 
from your supply chain, you will want to review the data loader configuration options. This guide also 
contains simple data loading tests that can be run to verify the installation, as well as how to configure 
individual EIS modules (DIM, SLO, PIM, and SIM).

After you install the software, you can customize the EIS’s properties and settings, configure 
processors for specific tasks, and set up regular maintenance procedures. This guide also describes 
procedures for upgrading to a new version of EIS.

• Chapter 1: Requirements — describes the software and hardware requirements for 
installing and using the EIS applications.

• Chapter 2: Configuring the EIS database and installing the schemas — describes how to 
install and configure the MIPO database schemas (SOPS_MIPO and SOPS_DLASM) 
used to load and store supply chain data, as well as how to install and configure the Data 
Gateway and Data Store schemas.

T
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• Chapter 3: Installing and configuring EIS for the SAP Web Application Server — 
describes how to install and configure an EIS instance on a Windows machine running 
SAP’s NetWeaver.

• Chapter 4: Configuring the data loader — describes how to configure the data loader 
service and application code installed on the application server and database server.

• Chapter 5: Testing EIS — describes a series of short tests that ensure that all parts of 
your EIS system are functioning.

• Chapter 6: Customizing EIS — describes how to customize the EIS application by 
changing properties and configuration files.

• Chapter 7: Configuring EIS Processors — describes the functionality of the EIS proces-
sors and their specific configuration settings.

• Chapter 8: Maintaining EIS — describes how to perform administrative and cleanup 
tasks in EIS.

• Chapter 9: Configuring DIM —describes how to configure the DIM application.

• Chapter 10: Configuring SLO —describes how to configure the SLO application.

• Chapter 11: Configuring PIM —describes how to configure the PIM application.

• Chapter 12: Configuring SIM —describes how to configure the SIM application.

• Chapter 13: Upgrading EIS — describes how to backup and upgrade EIS from a previ-
ously installed version.

• Appendix: Alert Definitions — provides a reference to the EIS alerts, organized by alert 
type, and includes severity levels and detailed descriptions.



Introduction

     13

About this guide

Notation conventions

This section describes notation and formatting conventions used throughout EIS documentation. 
These conventions have been defined and are used to provide consistency and clarity as well as to aid 
visual recall of information.

Intended audience

This document is intended for members of the EIS implementation team, database administrators 
(DBAs) at customer sites, and customer Information Technology (IT) staff.

Your company’s DBA is most qualified to install and configure the Oracle database instance and the 
EIS database schemas. After the database and EIS database schemas are successfully installed, the 
DBA should be responsible for the ongoing administration and performance of the Oracle database 
instance containing the EIS database schemas.

Convention Example

Any item that appears literally on the computer screen such as a text 
field label, a menu name, or a button label is printed in boldface.

Information that should be entered exactly as shown is also printed in 
boldface.

• click Settings 

• click LOGOUT

• Type 2 in the Factor by text 
box.

Keyboard keys are indicated by the text of the key face displayed in 
upper case and small caps.

Key combinations include multiple keys. A plus sign connects names of 
keys that should be pressed simultaneously.

• ALT

• SHIFT

• CTRL+ALT+DELETE

• SHIFT+S

Information you enter that is specific to your own environment, such as 
your user name or a specific unit cost, is designated by an italic variable 
name.

Italic text is also used to indicate a new term or concept.

• Type User Name and press 
ENTER.

• lead time, also called total lead 
time

This symbol indicates information that emphasizes or supplements 
important points of the main text.

This symbol indicates a note of caution. Items that warrant a note of 
caution include warnings that could protect against a loss of data or 
other undesired behavior.
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This documentation assumes the DBA has experience in the following areas:

• Installing Oracle 

• Creating Oracle database instances

• Database backup and recovery 

• Database performance tuning 

A member of the EIS Implementation Team or a member of your company’s IT staff is most qualified 
to perform the setup and administration of the application server, the Web server (optional), and the 
installation of EIS. Participants in the EIS installation process can include, but are not limited to the 
following:

• UNIX Administrator 

• Network Administrator 

• Windows Administrator / PC Support

In addition, a member of your company’s IT staff should be familiar with administering application 
server software.
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Chapter 1:
Requirements

his chapter describes the software requirements for the client machines, application server, and 
database server in EIS. Listed are the software requirements for each that must be met to 
install and run the EIS applications. 

EIS consists of three main components: 

• Client PCs that access the EIS application server via Internet Explorer

• Application server running the EIS applications 

• Relational database in which to load and store supply chain data

Your organization’s supply chain data can be loaded into the EIS database by using the data loader 
software that is installed with EIS and the database instance. Figure 1 depicts the main components 
used by EIS.

T
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Figure 1: Components of EIS

Note: Differences in hardware and software can affect EIS optimization results. 
Specifically, different chip sets, Java Virtual Machine (JVM) versions, Java vendors, and 
order of operations have been observed to cause very minor differences in output 
results. Typically, you will not notice these differences. However, when batch sizes are 
used, an additional batch size for an order can be triggered, which is noticeable only on 
a period-by-period basis. The cumulative effect is that a batch size is shifted one period, 
which will not significantly impact average results per annum.

Note: Data integrity within the EIS design architecture relies on input data sets 
following the Unicode standard character set. The use of non-Unicode input data with 
EIS could lead to data loss issues on the back-end processes and might affect 
optimization results.
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Hardware requirements
Hardware requirements for EIS depend on several factors, for example:

• existing infrastructure

• supply chain topology

• volume of data being loaded, stored, and extracted from the database

During the requirements analysis phase of the EIS product implementation, a formal capacity study 
will determine the minimum hardware requirements for your organization.

Third party software requirements
This section discusses third party client and server software required to run the EIS applications, 
including: client PC, application server, Java and database requirements and components, and other 
recommended or required third-party software products.

Database – Oracle Enterprise, Oracle Standard

• 10.2.0.4, 10.2.0.5

• 11.2.0.2, 11.2.0.3

App Server

• NetWeaver 7.2 (single stack), 7.3, 7.4

• OS: independent

• Java: NetWeaver-specific

• Oracle-JDBC: 1.4 or higher

Client – OS

• Windows XP, Latest Service Pack

• Windows Vista SP 1

• Windows 7

Client – JRE

• Oracle Java JRE 1.6.0_45 or higher

• Oracle Java JRE 1.7.0_35 or higher

Client – Browser

• Internet Explorer 7, 8, 9, 10 (compatibility-mode only)
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• Resolution - 1024 x 768 or higher

Client – Spreadsheet

• Microsoft Excel 2007, 2010

Database software requirements
EIS requires that you run the Oracle software specified under the Application Server software 
requirements. For Oracle installation instructions, refer to the appropriate Oracle Installation Guide for 
your platform.

Note: For Internet Explorer 7.0, it is recommended to add the EIS URL as a 
trusted application to ensure all functionality works properly. For more 
information, see “Setting the EIS URL as a Trusted site” on page 61.

Note: EIS supports partitioned or non-partitioned tables. We recommends using 
partitioned tables to increase performance. 

Note: If your database server is running the Solaris operating environment, it is 
recommended that volumes containing Oracle data files, temporary files, and redo logs 
are mounted using the forcedirectio option. Volumes containing the Oracle binaries 
should be mounted without using forcedirectio.
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Chapter 2:
Configuring the

EIS database and
installing the schemas

his chapter discusses requirements and basic instructions for configuring the Oracle database 
instance for EIS and installing the EIS database schemas used for loading and storing supply 
chain data. 

Oracle setup and requirements
This section describes the general requirements for the Oracle database instance that contains the EIS 
schemas, including recommendations for character sets, database sizing, tablespaces, rollback 
segments, redo logs, archiving, initialization parameters, system user privileges, TNS settings, 
environment variables, and performance tuning.

Note: The database portion of the EIS installation must be performed by either a 
database administrator (DBA) or someone who has an advanced background working 
directly with Oracle database systems. Please refer to documentation supplied with the 
Oracle database for further information on specific Oracle functionality.

T
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Character set

The Oracle database instance created for MIPO must be a AL32UTF instance: 

CHARACTER SET AL32UTF8

NATIONAL CHARACTER SET AL16UTF16

In addition, set the NLS_LANG environment variable for the Oracle client, as follows:

NLS_LANG=american_america.AL32UTF

Database sizing

Database sizing estimates depend on your supply chain topology, how much data you plan to load/
save, and other factors. Your initial database size requirements are determined through a formal 
capacity study performed during the requirements analysis phase of the MIPO product 
implementation.

Tablespaces

The table below lists the tablespaces used by the MIPO application. These tablespaces should be 
created using the following parameters:

• locally-managed tablespaces

• initial size of 1 GB

• autoextend feature on

• extent size set to autoallocate 

Tablespace name Description

ADMIN_TS Tablespace used during execution of scripts to delete marked supply 
chains and scenarios

DLASM_DATA Data loading tablespace

DLASM_INDEX Data loading index

MIPO_DATA MIPO application data tablespace

MIPO_INDEX MIPO application index

UNDOTBS1 Undo tablespace required for the automatic undo feature (see the 
section on rollback segments below)

TEMP (Temporary Tablespace) Tablespace dedicated for standard operation temporary segments. 
Name of temporary tablespace must be TEMP; it should be locally-
managed with contents=temporary

GATEWAY_DATA Data Gateway tablespace

GATEWAY_INDEX Data Gateway index
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Rollback segments

Instead of using rollback segments, we recommend using Oracle’s automatic undo feature. This 
feature uses the UNDOTBS1 tablespace and is enabled by setting the UNDO_MANAGEMENT 
initialization parameter as described in “Initialization parameters” on page 21.

Redo logs

For the MIPO database, it is recommended you create a total of ten 1 GB redo log groups, with two 
log files each. 

Archiving

Due to the potential large data volume being processed by the Oracle database, it is recommended 
that database archiving be turned off for the database instance used with the MIPO application. If 
your company policies and procedures require that archiving is turned on, the Oracle DBA at your site 
is responsible for sizing and disk space maintenance of the archive area.

Initialization parameters

The table below lists example Oracle initialization settings for the MIPO database.

Increasing the values of the parameters listed below increases the memory usage of the database 
instance. If necessary, you can modify additional Oracle initialization parameters based on your 
company’s guidelines for creating database instances. In addition, you are responsible for tuning 
database performance as the amount of resources used by the EIS system increases.

DATASTORE_DATA Data Store tablespace

DATASTORE_INDEX Data Store index

Note: The ADMIN_TS tablespace is used only when executing scripts to delete 
marked supply chains and scenarios. When you are not performing these operations, it 
can be taken offline and dropped.

Initialization parameter Recommended value

db_block_size 8192

db_file_multiblock_read_count 16

DEFERRED_SEGMENT_CREATION FALSE

Note: Only applicable to Oracle 11g environments.

Tablespace name Description
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event 38043 trace name context forever, level 1

Note: the equivalent is _optimizer_mjc_enabled = false.

job_queue_processes 4

_like_with_bind_as_equality TRUE

log_buffer 2097152

memory_target For Oracle 11g, set to two-thirds of the physical 
RAM installed on the server.

NLS_LENGTH_SEMANTICS CHAR

open_cursors 500

_optim_peek_user_binds FALSE

_optimizer_mjc_enabled FALSE

optimizer_index_caching 100

optimizer_index_cost_adj 5

optimizer_mode CHOOSE

pga_aggregate_target 800 MB

parallel_max_servers 16

plsql_optimize_level 3

Note: Only applicable to Oracle 11g environments.

processes 300

Note: It is recommended that a value of 150 or 
greater be used for this parameter.

query_rewrite_enabled TRUE 

sga_target For Oracle 10g, set to half of the physical RAM 
installed on the server.

For Oracle 11g, see memory_target.

star_transformation_enabled TRUE

session_cached_cursors 0

timed_statistics TRUE

Initialization parameter Recommended value
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SYSTEM user role and privileges

The Oracle user SYSTEM is used during the installation of the EIS schemas. Ensure that SYSTEM is 
granted the DBA role and the following privileges:

GRANT EXECUTE ON SYS.DBMS_LOCK TO SYSTEM WITH GRANT OPTION;

GRANT SELECT ON SYS.V_$PARAMETER TO SYSTEM WITH GRANT OPTION;

GRANT SELECT ANY TABLE TO SYSTEM WITH ADMIN OPTION;

GRANT SELECT ON SYS.V_$TIMER TO SYSTEM WITH GRANT OPTION;

TNS settings

Ensure that the tnsnames.ora file contains an entry that refers to the database instance that will 
contain the EIS database schemas. For example:

smartops_db.your_domain.com =

  (DESCRIPTION =

   (ADDRESS_LIST =

      (ADDRESS = (PROTOCOL = TCP)(HOST = 10.9.8.07)(PORT = 1521))

    )

    (CONNECT_DATA =

      (SERVICE_NAME = smartops_db.your_domain.com)

    )

  )

In this example, smartops_db represents the name of the database instance, your_domain represents the 
domain name of the server, and the value for the HOST setting represents the IP address of the 
database server. Refer to your Oracle documentation for more information about modifying the 
tnsnames.ora file.

undo_management AUTO

undo_retention 10800

utl_file_dir /tmp (or another directory)

Initialization parameter Recommended value
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Oracle environment variables

If you will be installing the EIS database schemas from a UNIX machine, verify that the Oracle 
environment variables listed in the table below are specified for the UNIX user performing the EIS 
schema installation.

Installing the MIPO database schemas
This section describes how to install the MIPO database schemas (SOPS_MIPO and SOPS_DLASM) 
from a Windows or UNIX machine connected to the Oracle database server.

Prerequisites:

Gather the following information in preparation for the schema installation process:

• Name of the database instance created for the MIPO schemas

• Full path name of the directory containing the schema installation files (e.g., /temp/mipo 
and /temp/dloader)

• Password for the user SYSTEM

Installing the MIPO database schemas on UNIX

Step 1: Create the data loader user (dlasm)

Use your standard operating system procedures to create a UNIX user account named dlasm on the 
database server. This user ID is used when data sets are transferred from the application server to the 

Environment variable Example setting Description

ORACLE_HOME $ORACLE_BASE/product/11.2.0 Oracle product installation 
directory.

ORACLE_SID Automatically set and confirmed 
during database creation

Oracle server database instance 
identifier.

PATH $ORACLE_HOME/bin;/usr/bin; 
/etc;/usr/ccs/bin;/usr/openwin/bin

Shell’s search path for 
executables. Verify that 
$ORACLE_HOME/bin is 
included in the PATH variable.

Note: On the installation media, the MIPO schemas are located under the INTERNAL 
directory. 



Chapter 2: Configuring the EIS database and installing the schemas

     25

database server via SSH. In addition, the user dlasm is the owner of directories on the database server 
used to store and process loadsets. 

Use your standard operating system procedures to add the dlasm user to the same operating system 
group as the Oracle software owner (the UNIX user ID used during Oracle installation). This ensures 
that the user ID can read and write to database and data loading directories as needed.

Step 2: Create directories and directory objects for loadset processing

The MIPO data loading software requires that you create operating system directories and 
corresponding Oracle directory objects on the database server. A directory object maps a name within 
Oracle to a directory name on the file system. The following directories support Oracle external tables 
that are used by the data loader:

• /dloader — root working directory for the data loader application after loadsets are 
transferred to the database server

• /bad — interim storage area for invalid data files

• /dat — area where loadsets are processed

• /log — contains log entries written during load set processing

• /reverse — area where .dat files from exported scenarios (reverse loadsets) are processed

To create operating system directories and directory objects for the MIPO data loader:

1. Log into the database server as root and create the dloader OS directory as a 
subdirectory of $ORACLE_BASE/admin/$ORACLE_SID and grant operating system 
permissions as shown in the example below:

# mkdir $ORACLE_BASE/admin/$ORACLE_SID/dloader

# cd $ORACLE_BASE/admin/$ORACLE_SID

# chmod -R 770 dloader

2. Create the bad, log and reverse subdirectories under the /dloader subdirectory and 
grant operating system permissions as shown in the example below:

# cd dloader

# mkdir bad log reverse

# chmod 770 bad log reverse

# chown -R dlasm:group_name 

In the last command example above, group_name represents the name of the UNIX group 
to which the user dlasm and the Oracle software owner both belong.

Note: The system will create the /dat directory during loadset 
processing. You do not need to create a /dat directory. 
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3. Execute the following commands in SQL*Plus to create the directory objects named 
dloader_bad_dir, dloader_data_dir, dloader_log_dir, and dloader_reverse_dir, and 
map them to the OS directories. 

CREATE OR REPLACE DIRECTORY DLOADER_BAD_DIR AS '/ORACLE_BASE/admin/
DB_NAME/dloader/bad';

CREATE OR REPLACE DIRECTORY DLOADER_DATA_DIR AS '/ORACLE_BASE/admin/ 
DB_NAME/dloader/dat';

CREATE OR REPLACE DIRECTORY DLOADER_LOG_DIR AS '/ORACLE_BASE/admin/ 
DB_NAME/dloader/log';

CREATE OR REPLACE DIRECTORY DLOADER_REVERSE_DIR AS '/ORACLE_BASE/
admin/DB_NAME/dloader/reverse';

In this example, ORACLE_BASE represents the full path name of the Oracle 
installation directory (the value of the $ORACLE_BASE variable) and DB_NAME 
represents the name of the database instance (the value of the $ORACLE_SID variable).

4. Grant the Oracle software owner and the user dlasm permissions for the Oracle directory 
objects by granting read/write access to the SOPS_MIPO and SOPS_DLASM schema 
owners. Alternatively, within the database instance, which should contain only MIPO-
related schemas, you can grant read and write access for the bad, data, log, and reverse 
directory objects to PUBLIC, as in the following examples: 

GRANT READ, WRITE ON DIRECTORY DLOADER_BAD_DIR TO "PUBLIC";
GRANT READ, WRITE ON DIRECTORY DLOADER_DATA_DIR TO "PUBLIC";
GRANT READ, WRITE ON DIRECTORY DLOADER_LOG_DIR TO "PUBLIC";
GRANT READ, WRITE ON DIRECTORY DLOADER_REVERSE_DIR TO "PUBLIC";

Step 3: Copy the schema installation files to a UNIX machine

The MIPO database schema installation files are located on the EIS MIPO installation media. Follow 
the instructions appropriate to the operating system (Windows or UNIX) from which you will be 
installing these files.

• Log in to the machine containing the database instance and create a new directory to con-
tain the copied files.

Note: Directory objects can be created by a DBA or any user with 
the CREATE ANY DIRECTORY privilege. The directory 
location specified by the directory object should be on the 
database server where the MIPO database is running.
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• Copy and uncompress the files from the /INTERNAL<version>/Database and the /
DataLoader<version>/Database directories on the EIS installation media into the new 
directory.

The installation creates two directories, DataLoader<version>\Database\Install and 
INTERNAL<version>\Database\Install, which contain the following 
subdirectories:

compile Scripts for compilation

indexes Scripts to install database table indexes

plsql Scripts and binary files to install PL/SQL objects

sequences Scripts to install database sequences

static Scripts to import static data into the database schemas

tables Scripts to install database tables, primary keys and foreign keys

users Script to create the SOPS_MIPO and SOPS_DLASM schema owners

views Scripts to install views

Step 4: Edit configuration settings in the MIPO install SQL script - Optional

To edit the MIPO install.sql script:

1. Log in to the machine where the Oracle database instance is located.

2. Navigate the EIS installation files to find the INTERNAL<version>\Database 
directory.

3. Use a text editing tool to open the install.sql script you copied onto the EIS database 
server. You can update the configuration settings for the following:

- Name and password of the MIPO schema you are creating

- Name of the data loading schema to be created later (steps 6 & 7)

- Tablespace names

4. Save your changes and close the text editor.

Note: <version> represents the release number for the software 
application.

Note: During installation, EIS automatically detects whether or 
not the partitioning feature has been implemented on the database 
server. You can override this by changing the partitioning 
preference from Default to No. 
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Step 5: Install the MIPO database schema (SOPS_MIPO)

To install the database schemas:

1. From the INTERNAL<version>\Database directory, log into SQL*Plus as the system 
user.

2. Execute the install.sql script.

Installation of the database schema begins and can take several minutes to complete.

- The schema owner SOPS_MIPO is created. 

- The SOPS_MIPO schema is created.

- Static data is imported into the schema.

A message indicates that the PL/SQL procedure and installation was successfully 
completed.

3. Verify that no errors occurred during the installation or static data import process by 
checking the .log files created in the \Database directory after you exit SQL*Plus. If the 
log files contain unknown errors, contact SAP support.

Note: Errors can be generated when the installation script attempts to drop tables, 
sequences, indexes, or views that do not exist. It is safe to ignore these errors.

Step 6: Edit configuration settings in the Data Loader install SQL script - 
Optional

To optionally edit the Data Loader install.sql script:

1. Navigate the EIS installation files to find the DataLoader<version>\Database 
directory. 

2. Use a text editor to open the install.sql script. You can update the configuration settings 
for the following:

- Name and password for the data loading schema

- Name of the MIPO schema (created in steps 4 and 5)

- Tablespace names

- Data loader directory objects (note: edit only if necessary)

Step 7: Install the Data Loader schema (SOPS_DLASM)

To install the database schemas:

1. From the DataLoader<version>\Database directory, log into SQL*Plus as the system 
user.

2. Execute the install.sql script.

Installation of the database schema begins and can take several minutes to complete. 
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- The data loader schema owner SOPS_DLASM is created. 

- The SOPS_DLASM schema is created.

A message indicates that the PL/SQL procedure and installation was successfully 
completed.

3. Verify that no errors occurred during the installation process by checking the .log files 
created in the \Database directory after you exit SQL*Plus. If the log files contain 
unknown errors, contact SAP support.

Installing the MIPO database schemas on Windows

Step 1: Create the data loader user (dlasm)

Use your standard operating system procedures to create a Windows user account named dlasm on 
the database server. This user ID is used when data sets are transferred from the application server to 
the database server via SSH. In addition, the user dlasm is the owner of directories on the database 
server used to store and process loadsets. 

Use your standard operating system procedures to add the dlasm user to the same operating system 
group as the Oracle software owner (the user ID used during Oracle installation). This ensures that 
the user ID can read and write to database and data loading directories as needed.

Step 2: Create directories and directory objects for loadset processing

1. The MIPO data loading software requires that you create operating system directories 
and corresponding Oracle directory objects on the database server. A directory object 
maps a name within Oracle to a directory name on the file system. The following 
directories support Oracle external tables that are used by the data loader:

- /dloader — root working directory for the data loader application after loadsets are 
transferred to the database server

- /bad — interim storage area for invalid data files

- /dat — area where loadsets are processed

- /log — contains log entries written during load set processing

Note: Errors can be generated when the installation script 
attempts to drop tables, sequences, indexes, or views that do not 
exist. It is safe to ignore these errors.
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- /reverse — area where .dat files from exported scenarios (reverse loadsets) are 
processed

 Use the standard Windows procedure for creating directories to create these directories.

2. Execute the following commands in SQL*Plus to create the directory objects named 
dloader_bad_dir, dloader_data_dir, dloader_log_dir, and dloader_reverse_dir, and 
map them to the OS directories. 

CREATE OR REPLACE DIRECTORY DLOADER_BAD_DIR AS '/ORACLE_BASE/admin/
DB_NAME/dloader/bad';

CREATE OR REPLACE DIRECTORY DLOADER_DATA_DIR AS '/ORACLE_BASE/admin/ 
DB_NAME/dloader/dat';

CREATE OR REPLACE DIRECTORY DLOADER_LOG_DIR AS '/ORACLE_BASE/admin/ 
DB_NAME/dloader/log';

CREATE OR REPLACE DIRECTORY DLOADER_REVERSE_DIR AS '/ORACLE_BASE/
admin/DB_NAME/dloader/reverse';

In this example, ORACLE_BASE represents the full path name of the Oracle 
installation directory (the value of the $ORACLE_BASE variable) and DB_NAME 
represents the name of the database instance (the value of the $ORACLE_SID variable).

3. Grant the Oracle software owner and the user dlasm permissions for the Oracle 
directory objects by granting read/write access to the SOPS_MIPO and SOPS_DLASM 
schema owners. Alternatively, within the database instance, which should contain only 
MIPO-related schemas, you can grant read and write access for the bad, data, log, and 
reverse directory objects to PUBLIC, as in the following examples: 

GRANT READ, WRITE ON DIRECTORY DLOADER_BAD_DIR TO "PUBLIC";
GRANT READ, WRITE ON DIRECTORY DLOADER_DATA_DIR TO "PUBLIC";
GRANT READ, WRITE ON DIRECTORY DLOADER_LOG_DIR TO "PUBLIC";
GRANT READ, WRITE ON DIRECTORY DLOADER_REVERSE_DIR TO "PUBLIC";

Note: The system will create the /dat directory during loadset 
processing. You do not need to create a /dat directory. 

Note: Directory objects can be created by a DBA or any user with 
the CREATE ANY DIRECTORY privilege. The directory 
location specified by the directory object should be on the 
database server where the MIPO database is running.
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Step 3: Copy the schema installation files

The MIPO database schema installation files are located on the EIS MIPO installation media. Follow 
the instructions:

Copy all files from the \INTERNAL<version>\Database and the \DataLoader<version>\Database 
directories on the EIS installation media to the C:\temp directory on a Windows machine that is 
connected to the database server.

The installation creates two directories, DataLoader<version>\Database\Install and 
INTERNAL<version>\Database\Install, which contain the following subdirectories:

compile Scripts for compilation

indexes Scripts to install database table indexes

plsql Scripts and binary files to install PL/SQL objects

sequences Scripts to install database sequences

static Scripts to import static data into the database schemas

tables Scripts to install database tables, primary keys and foreign keys

users Script to create the SOPS_MIPO and SOPS_DLASM schema owners

views Scripts to install views

Step 4: Edit configuration settings in the MIPO install SQL script - Optional

To edit the MIPO install.sql script:

1. Log in to the machine where the Oracle database instance is located.

2. Navigate the EIS installation files to find the INTERNAL<version>\Database 
directory.

3. Use a text editing tool to open the install.sql script you copied onto the EIS database 
server. You can update the configuration settings for the following:

- Name and password of the MIPO schema you are creating

- Name of the data loading schema to be created later (steps 6 & 7)

- Tablespace names

Note: <version> represents the release number for the software application

Note: During installation, EIS automatically detects whether or 
not the partitioning feature has been implemented on the database 
server. You can override this by changing the partitioning 
preference from Default to No. 
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4. Save your changes and close the text editor.

Step 5: Install the MIPO database schema (SOPS_MIPO)

To install the database schemas:

1. From the INTERNAL<version>\Database directory, log into SQL*Plus as the system 
user.

2. Execute the install.sql script.

Installation of the database schema begins and can take several minutes to complete.

- The schema owner SOPS_MIPO is created. 

- The SOPS_MIPO schema is created.

- Static data is imported into the schema.

A message indicates that the PL/SQL procedure and installation was successfully 
completed.

3. Verify that no errors occurred during the installation or static data import process by 
checking the .log files created in the \Database directory after you exit SQL*Plus. If the 
log files contain unknown errors, contact SAP support.

Note: Errors can be generated when the installation script attempts to drop tables, 
sequences, indexes, or views that do not exist. It is safe to ignore these errors.

Step 6: Edit configuration settings in the Data Loader install SQL script - 
Optional

To optionally edit the Data Loader install.sql script:

1. Navigate the EIS installation files to find the DataLoader<version>\Database 
directory. 

2. Use a text editor to open the install.sql script. You can update the configuration settings 
for the following:

- Name and password for the data loading schema

- Name of the MIPO schema (created in steps 4 and 5)

- Tablespace names

- Data loader directory objects (note: edit only if necessary)

Step 7: Install the Data Loader schema (SOPS_DLASM)

To install the database schemas:

1. From the DataLoader<version>\Database directory, log into SQL*Plus as the system 
user.
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2. Execute the install.sql script.

Installation of the database schema begins and can take several minutes to complete. 

- The data loader schema owner SOPS_DLASM is created. 

- The SOPS_DLASM schema is created.

A message indicates that the PL/SQL procedure and installation was successfully 
completed.

3. Verify that no errors occurred during the installation process by checking the .log files 
created in the \Database directory after you exit SQL*Plus. If the log files contain 
unknown errors, contact SAP support.

Note: Errors can be generated when the installation script attempts to drop tables, 
sequences, indexes, or views that do not exist. It is safe to ignore these errors. 

Installing the Data Gateway schema
The Data Gateway consists of an Oracle database schema that should be installed in the EIS database 
instance. This section describes how to install the Data Gateway schema (SOPS_GATEWAY) from a 
Windows or UNIX machine connected to the Oracle database server. 

Step 1: Copy Installation files to database server

Copy the database installation folder containing the Data Gateway schema installation files from the 
EIS installation media to the MIPO database server. These files are located under the 
\DataGateway<version>\Database directory (where <version> represents the release number for 
the software application). Make sure you maintain the directory structure under the \Database 
directory.

Step 2: Update the Installation SQL script- Optional

Use a text editing tool to open the install.sql script you copied onto the EIS database server. You will 
see the following configuration settings:

DEFINE GATEWAY_SCHEMA='SOPS_GATEWAY'

DEFINE GATEWAY_PASSWORD='SOPS_GATEWAY'

DEFINE MIPO_SCHEMA='SOPS_MIPO'

DEFINE GATEWAY_DATA_TS='GATEWAY_DATA'

DEFINE GATEWAY_INDEX_TS='GATEWAY_INDEX'

DEFINE TEMP_TS='TEMP'

Note: The MIPO database schema must be installed on the database server prior to 
installing the Data Gateway schema. 
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DEFINE PARTITIONED='DEFAULT' -- VALID VALUES ARE 'DEFAULT' 'YES' 'NO'

Edit any configuration settings to match your current MIPO settings and save your changes.

Step 3: Configure Statistics Gathering capability (optional Step)

The amount of time associated with the Gateway data loading process has been improved by changing 
the default configuration for the statistics gathering process. This change eliminates time-consuming 
full statistics gathering for each data set. If you wish to include full statistics gathering as part of the 
data loading process, you must edit the pack_supply_ratio.sql file to change the statistics gathering 
level configuration parameter from S (for Stale) to F (for Full). This file can be found in the 
DataGateway<Revision#>/Database/install/plsql/package_spec/ directory.

Step 4: Run the Installation SQL script

Start the Command Prompt application and use the Change Directory command (cd) to access the 
database server and go to the \DataGateway<version>\Database folder.

Log on the SQL*Plus as system administrator with system ID (e.g., 
system@sopsdmp4.smartops.com) and password.

Run the Data Gateway Installation script by typing the following at the command prompt:

@install

The script will notify you when the Data Gateway schema is complete. For any error messages 
displayed during installation, see the gateway_install.log file for more information. 

Exit SQL*Plus by typing exit at the command prompt.

Installing the Data Store Schema
The Data Store consists of an Oracle database schema that is installed as part of the MIPO database 
instance. This section describes how to install the Data Store schema (SOPS_DATASTORE) from a 
Windows or UNIX machine connected to the Oracle database server. 
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 Figure 2-1 Installing Data Store schema schematic 

Step 1: Copy Installation files to database server

Copy the Data Store schema installation files from the EIS installation media to the MIPO database 
server. These files are located under the \DataStore<version>\Database directory (where 
<version> represents the release number for the software application). Make sure you maintain the 
directory structure under the \Database directory.

Step 2: Update the Installation SQL script - Optional

Optionally, you can use a text editing tool to open the install.sql script you copied onto the EIS 
database server. You will see the following configuration settings:

DEFINE DATASTORE_SCHEMA='SOPS_DATASTORE'

DEFINE DATASTORE_PASSWORD='SOPS_DATASTORE'

DEFINE MIPO_SCHEMA='SOPS_MIPO'

DEFINE DATASTORE_DATA_TS='DATASTORE_DATA'
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DEFINE DATASTORE_INDEX_TS='DATASTORE_INDEX'

DEFINE TEMP_TS='TEMP'

DEFINE PARTITIONED='DEFAULT'  -- VALID VALUES ARE 'DEFAULT' 'YES' 'NO'

Edit any configuration settings to match your current MIPO settings and save your changes.

Step 3: Run the Installation SQL script

Start the Command Prompt application and use the Change Directory command (cd) to access the 
database server and go to the location where you copied the installation files.

Log on the SQL*Plus as system administrator with system ID (e.g., 
system@sopsdmp4.smartops.com) and password.

Run the Data Store Installation script by typing the following at the command prompt:

@install

The script will notify you when the Data Store schema is complete. For any error messages displayed 
during installation, see the datastore_install.log file for more information. 

Exit SQL*Plus by typing exit at the command prompt.
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Chapter 3:
Installing and

configuring EIS
for the SAP Web

Application Server

his chapter provides instructions for installing EIS software on an SAP Web Application Server 
(NetWeaver) and deploying the SmartOps.sca file to NetWeaver.

Note: Some NetWeaver-specific features may not be available through the EIS user 
interface.

Note: NetWeaver installations are supported for MIPO 6.3 and above, along with 
NetWeaver CE 7.1 and future versions.

T
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Installing EIS for SAP Web Application Server
This section provides instructions for installing the EIS application on a machine running SAP’s Web 
Application Server.

Prerequisites:

Before configuring the application server, install the EIS database and dataloader schemas as 
described in “Chapter 2: Configuring the EIS database and installing the schemas” on page 19 of this 
guide.

We also recommend that all servers in a customer’s environment support reverse DNS lookup.

When the EIS application uses the SAP Web Application Server mechanism for Secure Sockets Layer 
(SSL) configuration, we recommend using encryption at the network layer, by using the SSL protocol 
for HTTP connections. See your SAP NetWeaver documentation for more information on 
"Configuring Network and Transport Layer Security" (http://help.sap.com).

Step 1: Copy EIS installation files

1. Create a temporary directory on the SAP web application server to place the EIS 
installation files.

2. Copy the contents of the \EISAPP<version>\netweaver directory (where <version> 
represents the release number for the software application) from the EIS installation 
media to the temporary directory.

Step 2: Acquire and install EIS Licence

1. Acquire an EIS license from the SAP Marketplace.

2. Install the EIS license on NetWeaver. Refer to your SAP NetWeaver documentation for 
more information.

Step 3: Run EIS Installer application

1. Access the EIS installation media go to the EISAPP<version>\netweaver directory.

2. Execute the install-smartops.cmd script for Windows or the install-smartops.sh 
script for UNIX installations. A command prompt window opens.

3. Enter the full path name of the application server directory where the EIS application 
will be installed (e.g., c:/MIPO-netweaver/smartops). 

Note: Windows users must use a forward slash (/) when entering 
this parameter.
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4. Enter the name and password of the Oracle user created for the MIPO database schema 
(e.g., SOPS_MIPO).

5. Enter the name of the Oracle database instance created for the MIPO database schema, 
and the domain name if one configured as part of the schema (e.g., SOPS_MIPO).

6. You will be prompted to enter the domain name separately, but you can skip this step and 
leave the field blank.

7. Enter the IP address of the machine containing the Oracle database (e.g., 10.9.8.07). 

8. You will be prompted to enter the database port number. Enter the port number on 
which the database listener is configured (i.e., 1521).

9. Press ENTER to launch the installation. A message indicates that the EIS installation is 
complete.

Step 4: Configure JVM settings

1. Locate the SAP AS Java - Config Tool, for example:

c:\usr\sap\J2E\JC00\j2ee\configtool\configtool.bat

Double click configtool.bat to launch the tool.

2. Select the environment to configure by clicking the environment name listed in the 
directory tree displayed on the left side of the screen.

3. Click the VM Environment tab to access property data parameter settings.

If desired, set the DebugMode parameter to true to enable Debug mode.

If NetWeaver is not running Oracle, add ojdbc14.jar to the classpath. (Skip this 
if NetWeaver is running Oracle.)

For example, add: 
C:\usr\sap\J2E\J00\j2ee\cluster\apps\smartops.com\SmartOpsApp\serv
erlet_jsp\SmartOps\root\WEB-INF\lib\ojdbc14.jar

4. From the menu, click View > Expert Mode.

5. Click the VM Parameters tab to access the VM Parameters screen. You’ll see a section 
called VM Parameters with a series of tabs labeled Memory, System, and Additional.

6. Use the section associated with the Additional tab to add file encoding (and verify that it 
is enabled):

-Dfile.encoding=AL32UTF-8

7. Use the section associated with the Memory tab to configure memory settings.

8. Use the section associated with the System tab to create the smartops.home custom 
setting by clicking the New button, then filling out the parameter information using the 
New Parameter dialog box. Click OK when you are finished. For example:

Name (without ‘-D’) = smartops.home
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Value (optional) = C:\SmartOps
Description (optional) = SmartOps Home Directory

You should see the smartops.home parameter listed under Custom Parameters. This 
parameter gets created by the EIS Installer application (see Step 2) when the EIS 
directory and associated files are placed on the application server.

9. Save your changes. 

10. You will need to restart NetWeaver for the changes to take effect. Open the SAP 
Management Console (located under the Program menu).

11. From the directory tree, select your system name, then right-click with your mouse to 
view the context menu and select Restart. The SAP System Restart dialog box appears.

12. If you are restarting a production system with other applications, then select Soft and 
click OK. Otherwise you can select a Hard shutdown.

Deploying SmartOps.sca with JSPM.

The Java Support Package Manager (JSPM) can be used to deploy the SmartOps.sca file. Perform the 
following steps to use this application:

1. Copy the SmartOps.sca file to the JSPM Inbox. For example: 

C:\usr\sap\trans\EPS\in

2. Run the Go.bat file, located in the JSPM directory, to start the JSPM application. For 
example: 

C:\usr\sap\C01\J00\j2ee\JSPM\go.bat

You will see the Log On screen.

3. Enter your administrative J2EE user account name and password, then click Log On.
You will see the Select Package Type screen.

4. Click the radio button associated with New Software Components, then click Next.
You will see the Specify Queue screen.

Note: JSPM is not available for NetWeaver 7.4 and greater. 

Note: smartops.com/SmartOpsApp should be listed in the 
deployment queue under Vender/Name.
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5. Click Next.
You will see the Check Queue screen.

6. Click Next.
You will see the Deploy Queue screen. A message will appear informing you that 
deployment has started. You can monitor the deployment process by checking the Status 
field of the deployment queue. When the Status changes to Deployed, you will see a 
message indicating that the deployment process is finished.

7. Click Next.
You will see the Completed screen.

8. Click Exit.

The EIS application automatically starts after it is deployed.

Deploying SmartOps.sca with NetWeaver Developer Studio
The NetWeaver Developer Studio application can also be used to deploy the SmartOps.sca file.

Step 1: Configure NetWeaver Developer Studio

1. Start the NetWeaver Developer Studio application.

2. From the menu, select Window > Show view > Other.

3. From the Show View dialog box, click on the Deploy View folder to open it. 

a. From the menu, select Help > Software Updates > Find and Install.

b. From the Password Required dialog box, enter your User Name and Password.

c. From the Install/Update dialog box, click the radio button associated with Search 
for New Features to Install, then click Next >.

d. From the Install dialog box, click New Remote Site.

e. From the New Update Site dialog box, type in a name and the following URL:
https://nwds.sap.com/swdc/downloads/updates/netweaver/nwds/ce/710

f. Click OK. The Install dialog box will now show the URL in the Sites to include in 
search section.

g. Select the check box next to the URL, then click Finish. You will see the Search 
Results in the Updates dialog box, including a list of patches automatically selected 
via check boxes.

Note: If the Deploy View folder isn’t listed, you will need to do 
the following:
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h. Click Next to install the selected patches. Once the installation is complete, return to 
the Show View dialog box (step 2) and open the Deploy View folder.

4. Select all of the views listed under the Deploy View folder, then click OK. You will see 
the tabs for the Config View, Deploy View, Repository View, and Undeploy View 
appear at the bottom of the Netweaver Developer Studio window. The tab for the 
Deploy View Console also appears at the top right part of the window.

Once you have the EIS application installed and configured, you can use the NetWeaver Developer 
studio to deploy and start the application, as well as undeploy and stop it.

Step 2: Deploy SmartOps.sca

1. From the NetWeaver Developer Studio window, click the Deploy View tab.

2. Add the SmartOps.sca file to the External Deployable Archives folder by right 
clicking on the folder, then choose Add from the menu to select the SCA file. The 
SmartOps.sca file now appears under the External Deployable Archives folder. 
Manifest information associated with the SCA file is displayed on the right panel.

3. Right click on the SmartOps.sca file, then choose Deploy from the menu. At the 
bottom right of the window, you will see the progress of the deployment.

You can use the NetWeaver Developer Studio to start the EIS application.

Deploying SmartOps.sca with SAP NetWeaver Telnet 
Administrator Tool
The NetWeaver Telnet Administrator Tool can also be used to deploy or undeploy the SmartOps.sca 
file..

1. Log into the Netweaver server as an administrator.

2. Launch the SAP Telnet Administration Tool with the telnet command:

telnet localhost 5NN08

Replace NN with the instance number of your central instance of Netweaver. This instance 

Note: You can click the Process icon to show the Progress view, 
which allows you to cancel the deploy task if necessary.

Note: The SAP NetWeaver Telnet Administrator Tool can only be run from the 
NetWeaver server.
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number can be seen from the directory where the J2EE engine is installed. As an 
example, under the directory /usr/sap/<SID>/J01, the instance number would be 01.

3. When following displays, log in with the NetWeaver Administrator credentials:

telnet localhost 50108
Trying 127.0.0.1...

Connected to localhost.

Escape character is '^]'.

 ***********************************************

 **********************************************

 ****###*******####*****#######**************

 **##***##****##**##****##****##************

 ***##*******##****##***##****##**********

 *****##*****########***######***********

 ******##****##****##***##*************

 **##***##**##******##**##************

 ****###****##******##**##**********

 **********************************

 ********************************

 Telnet Administration

 SAP Java EE Application Server v7.40

User name: Administrator

Password:

4. To deploy the SmartOps.sca file, type this command:

deploy  /<path>/SmartOps.sca  on_deploy_error=stop  workflow=normal

Substitute <path> with the full path to where your SmartOps.sca file is located.

The deployment begins.

5. When deployment is complete, you will see a successful status for the two components 
smartops.com_EIS-APP and smartops.com_SmartOpsApp.

6. Verify the current status of the SmartOpsApp with the following command:

list_app | grep SmartOpsApp

The following should be returned:
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smartops.com/SmartOpsApp  STARTED  always 
13746650

To undeploy:

1. Verify that the application has been stopped:

stop_app smartops.com/SmartOpsApp

2. Use the undeploy command:

undeploy name=SmartOpsApp vendor=smartops.com undeploy_error=stop

Manually Create a Database Connection Pool.

1. If the EIS application is running, stop the application. (See “Stopping the EIS application 
with NetWeaver Developer Studio” on page 45.)

2. Log into the SAP Netweaver Administrator and click the Configuration tab.

3. Click Infrastructure in the sub menu, and then click Application Resources.

4. From the Show dropdown menu, select JDBC Custom DataSources.

5. Fill out the Settings tab as follows:

• Application Name: SmartOpsPool

• DataSource Name: SmartOpsPool

• Driver Name: SYSTEM_DRIVER

• SQL Engine: NATIVE SQL

• Isolation Level: Default

• JDBC Version: 1x (without XA support)

• Driver Class Name: oracle.jdbc.OracleDriver

• Database URL: jdbc:oracle:thin:@server:port:SID, where @server is the name or IP 
address of the server on which the EIS database is located, port is the port number 
for the Oracle database listener (default is 1521), SID is the database name/identifier

• User Name: SOPS_MIPO (or the MIPO schema name)

• Password: Your password for the SOPS_MIPO (or the MIPO schema password)

6. Click the Connection Pooling tab.

Note: Only applicable if the Netweaver database is Oracle.
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7. Change the Initial Connections value to 1 and the Maximum Connections value to 
40.

8. Save the database settings.

9. On the Applications Resources: Overview screen, verify that the state of the database 
(SmartOpsPool) is green.

10. Start the EIS application. (See “Starting the EIS application with NetWeaver Developer 
Studio” on page 45.)

Copy Oracle ojdbc14.jar file.

If NetWeaver is not running Oracle, the ojdbc14.jar file must be placed on the application server 
in order for EIS to function properly. 

Manually copy the ojdbc14.jar file from the ORACLE application library to the lib directory. 

For example: 
C:\usr\sap\J2E\J00\j2ee\cluster\apps\smartops.com\SmartOpsApp\serverlet_jsp\SmartOps\roo
t\WEB-INF\lib\

Starting the EIS application with NetWeaver Developer 
Studio

1. From the NetWeaver Developer Studio window, click the Repository tab.

2. From the directory list of applications in the left panel, click the 
SmartOpsApp(smartops.com) folder to show the application sub folder.

3. Right click on the EIS application subfolder, then choose Start from the menu. The 
EIS application will start running on the NetWeaver application server.

Stopping the EIS application with NetWeaver Developer 
Studio

1. From the NetWeaver Developer Studio window, click the Repository tab.

2. From the directory list of applications in the left panel, click the SmartOpsApp 
(smartops.com) folder to show the application sub folder.

3. Right click on the EIS application subfolder, then choose Stop from the menu. The EIS 
application will stop running on the NetWeaver application server.

Note: If Netweaver is running Oracle, skip this section.
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Undeploying the EIS application
1. Wile in NetWeaver Developer Studio, select WindowsShow ViewsOther

Deploy ViewUndeploy View.

2. Click the Refresh button to display the most recent list of deployed archives.

3. Open the Undeploy View tab.

4. Set the Undeployment Strategy to If depending stop.

5. Set the Error Strategy to Stop when first error occurs.

6. Select the EIS archive to undeploy, then click the + sign to add it to the list on the right-
hand side of the screen.

7. Select the EIS archive from the list on the right-hand side of the window, then click the 
Undeploy button (this button has quick info text that says Undeploy). 

Note: You can click the Show Undeployment Status button 
(this button has quick info text that says Show undeployment status) to 
check the status of the undeployment. 



      47

Chapter 4:
Configuring the

data loader

he EIS data loader bulk-loads your organization’s supply chain data into the EIS database. The 
data loader is installed on both the application server and the database server as part of the full 
EIS installation described in the previous chapters of this guide. Before you can begin to load 

data, minor configuration is required to connect the application and database servers in your 
environment. This chapter provides instructions for configuring properties for the data loader.

Prerequisites:

Before completing the instructions in this chapter, you should: 

• Verify connectivity in tnsnames.ora (see page 23).

• Create a data loader user (see page 24).

• Create Oracle directory objects and directories in which to archive successfully loaded 
and rejected datasets (see page 24).

• Install and configure the MIPO (SOPS_MIPO) schema (see page 27).

• Install and configure the dataloader (SOPS_DLASM) schema (see page 29).

• Install and configure the EIS application server software as described in Chapters 3 of 
this guide.

This chapter describes data loader configuration tasks, including:

T
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• Configuring file transfer via SSH

• Setting the relevant Data Loader parameters

• Modifying the default load set translator configuration

Data Loader configuration tools
Configuring the data loader requires the use of two tools: the Manage Module Settings feature 
available through the EIS user interface, and the smartops.properties file.

You can access the Manage Module Settings feature by logging on to MIPO and clicking the Settings 
menu to select Module Settings.

Depending on your application server and platform, smartops.properties is installed in the following 
directory:

• SAP Application Server — \SmartOps\MIPO.

Configuring a file transfer mechanism
Data sets can be transferred from the application server to the database server by using SSH

Step 1: Set up SSH

UNIX Application Server:

SSH is a UNIX shell program for executing commands on a remote computer, providing secure 
encrypted communications between two untrusted hosts over an unsecure network. Setting up SSH 
involves generating keys and creating a known_hosts file. To set up SSH:

1. Log in to the application server as the MIPO user.

Note: The EIS application does not support non-Unicode character sets. 

Note: When specifying path names to directories on Windows in the 
smartops.properties file, use a single forward slash (/) or two back slashes (\\) for the 
full path name to be interpreted correctly.

Note: This step is only required if the application and database are located on separate 
servers and if the application server is UNIX-based. If the database and application are 
on the same server, skip to step 2.
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2. Connect to the database server as the dlasm user using the following command: 

ssh dlasm@database_server_name

3. Enter the dlasm password when prompted. Once connected to the database server, exit 
from the database server.

4. Ensure that a known_hosts file now exists in the .ssh directory for the MIPO user.

5. Generate the required keys from the command line using the following command: 

ssh-keygen -t rsa

This generates the following files:

~/.ssh/id_rsa 

~/.ssh/id_rsa.pub

6. Copy the id_rsa.pub file to the database server and name it smartops_key.pub using 
the following command: 

scp id_rsa.pub dlasm@database_server_name:.ssh/smartops_key.pub

7. Connect to the database server as the dlasm user using the following command again: 

ssh dlasm@database_server_name

8. Navigate to the .ssh directory for the dlasm user and append the contents of the 
smartops_key.pub to authorized_keys using the following command:

cat smartops_keys.pub >> authorized_keys

9. Once the file has been appended, exit from the database server.

10. Now test the seamless connectivity from the application server to the database server 
from the MIPO user’s .ssh directory by using the following command:

ssh dlasm@database_server_name

11. If you connect to the database server without having to enter a password, SSH is now 
configured properly. If you do not, please contact SAP Support for help.

Windows Application Server:

A SSH client is not needed on a Windows-based application server as the Java JVM handles the SSH 
session.

Note: When using a passphrase, you must specify the passphrase in 
the Remote File Manager module in Step 2. 

Note: If you specified a passphrase in the Remote File Manager 
module in Step 2, you will need to enter the passphrase when testing 
the connection. 
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Step 2: Set the SSH settings for MIPO

To set the SSH settings for the MIPO application, perform the following steps:

1. Access the Manage Module Settings screen by logging on to MIPO and clicking Settings 
> Module Settings. Select the Remote File Manager module from the dropdown list.

2. For the setting labeled Import Server - Basic Configuration - Protocol Provider, 
verify that the setting value is SSH. If not, click the dropdown list value to select SSH. 
Fill out all of the subsequent settings for Import Server - SSH Configuration.

3. For the setting labeled Export Server - Basic Configuration - Protocol Provider, 
verify that the setting value is SSH. If not, click the dropdown list value to select SSH. 
Fill out all of the subsequent settings for Export Server - SSH Configuration.

4. Click OK when your configuration is complete.

Step 3: Set environment variables on database server

In order for the Data Gateway to properly communicate with the database server, you need to set the 
following environment variables:

ORACLE_HOME=<Oracle product installation directory>

LD_LIBRARY_PATH=$ORACLE_HOME/lib

NLS_LANG=american_america.AL32UTF8

For Windows servers:

Use the Environment Variables dialog box, found under the Advanced tab in System 
Properties (right click the My Computer icon on desktop and select Properties).

For Unix servers:

Set up a proxy SQL Loader file. First, create a Gateway directory on the database server. 
Then use a text editor to create the proxy script file. Name the file and place it on the 
database server. We recommend naming this configuration file sqlldr-proxy and placing 
it in the home directory of the dlasm user.

See example below:

#!/bin/bash

ORACLE_HOME=/u01/app/oracle/product/10.2.0

LD_LIBRARY_PATH=$ORACLE_HOME/lib

NLS_LANG=american_america.AL32UTF8

export ORACLE_HOME LD_LIBRARY_PATH NLS_LANG

${ORACLE_HOME}/bin/sqlldr $*

Note: For Windows application servers, enter the explicit path for all 
parameter settings involving specific directory/file locations.
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exit $?

Application and Database located on same server
If the application and database are located on the same server, SSH is not required. However, you 
should set the Remote File Manager to use local:

1. Access the Manage Module Settings screen by logging on to MIPO and clicking Settings 
> Module Settings. Select the Remote File Manager module from the dropdown list.

2. For the setting labeled Import Server - Basic Configuration - Protocol Provider, click 
the dropdown list value to select Local. 

3. For the setting labeled Export Server - Basic Configuration - Protocol Provider, click 
the dropdown list value to select Local. 

4. Click OK when your configuration is complete.

Data Loader parameter settings
The Manage Module Settings feature, available through the EIS Portal interface, contains 
parameters for configuring the data loader application code that is installed on the database server. 
These parameters let you specify the file-transfer protocol between servers, the user IDs of schema 
and directory owners, and path names to the archiving and processing directories. 

Configuring the Data Loader 
The Data Loader module contains the configuration settings used by the Data Loader to transfer data 
into the MIPO database schema. You can access this module by doing the following:

1. Log on to the EIS application.

2. Select Module Settings under the Settings menu.

3. Select Data Loader from the dropdown list.

4. Scroll through the configuration list and fill out the appropriate Data Loader parameters. 

5. When you are finished with your configuration, click OK.

If you decide not to implement the changes you made, click Cancel.

Certain parameters, as indicated, require you to stop and restart the application server for your 
changes to take effect. Clients connected to the EIS system must stop and restart the EIS application 
for the changes to take effect.
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A list of the parameters and their functions is provided below.

Parameter Definition Notes

Archive Directory Identifies the name of the archive 
directory on the application server 
relative to the DataLoader directory.

Requires application 
server restart.

Automatically Rename Existing 
Scenario

Identifies whether to automatically 
rename existing scenario by appending 
the time-date stamp.

Does not require 
application server 
restart.

Data Loader Translated Format Defines the Data Loader translated 
format.

Requires application 
server restart.

Entity File Extensions Defines the file extension of the Data 
Loader data files.

Requires application 
server restart.

External Drop Directory Identifies the name of the Oracle 
directory where the load set is 
processed.

Requires application 
server restart.

Listener Directory Identifies the name of the Listener 
directory on the application server for 
load sets.

Requires application 
server restart.

Load Set Check Interval Defines the sleep duration, in seconds, 
for the Data Loader service before 
checking the DataLoader directory for 
load sets.

Requires application 
server restart.

Reject Directory Identifies the name of the reject 
directory on the application server 
relative to the DataLoader directory.

Requires application 
server restart.

SGLT Translated Format Defines the SGLT translated format. Requires application 
server restart.

Save Archived Load Sets Identifies whether to save successful 
load sets on the application server.

Does not require 
application server 
restart.

Save Rejected Load Sets Identifies whether to save rejected load 
sets on the application server.

Does not require 
application server 
restart.

Table 4-1  Data Loader module setting definitions
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Configuring the Remote File Manager 
The Remote File Manager module lets you to configure specific parameters for the data loader to 
execute commands on the database server through SSH. You can access this module by doing the 
following:

1. Log on to the EIS application.

2. Select Module Settings under the Settings menu.

3. Select Remote File Manager from the dropdown list.

4. Scroll through the configuration list and fill out the appropriate Remote File Manager 
parameters. 

5. When you are finished with your configuration, click OK.

If you decide not to implement the changes you made, click Cancel.

Changes made to the Remote File Manager settings do not require a restart of the EIS application for 
the changes to take effect.

A list of the parameters and their functions is provided below.

Parameter Definition Notes

Import Server - Basic 
Configuration - Protocol Provider

Provider to handle connection protocol 
for the Import Server. Possible Values: 
Local, SSH.

Does not require 
application server 
restart.

Import Server - Basic 
Configuration - Default Remote 
Directory

Default directory to use for relative 
paths on the Import Server.

Does not require 
application server 
restart.

Import Server - SSH 
Configuration - Server Name

Remote SSH server to connect to for 
Import Server.

Does not require 
application server 
restart.

Import Server - SSH 
Configuration - Server Port

SSH Server port to use for Import 
Server. The default SSH port is 22.

Does not require 
application server 
restart.

Import Server - SSH 
Configuration - Username

Remote user name on SSH server for 
Import Server.

Does not require 
application server 
restart.

Import Server - SSH 
Configuration - Password 

Remote password to use for 
authenticating to Import Server using 
SSH. This password is not required if 
an identify file is used.

Does not require 
application server 
restart.

Table 4-2  Remote File Manager module setting definitions
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Import Server - SSH 
Configuration - Identity File

SSH identity file to use for 
authenticating to the Import Server. 
The default value is ~/.ssh/id_rsa. ~ 
gets expanded to the home directory of 
the user running this server.

Does not require 
application server 
restart.

Import Server - SSH 
Configuration - Passphrase for 
Identity File

Passphrase for SSH identity file for 
authenticating to the Import Server. It 
is not required if you are using 
password to connect or if the identity 
file does not have a passphrase.

Does not require 
application server 
restart.

Import Server - SSH 
Configuration - Known Hosts File 

Known hosts file that contains the 
signature for Import Server. The 
default value is ~/.ssh/known_hosts. ~ 
gets expanded to the home directory of 
the user running this server.

Does not require 
application server 
restart.

Import Server - FTP 
Configuration - Server Name

Remote FTP server to connect to for 
Import Server.

Does not require 
application server 
restart.

Import Server - FTP 
Configuration - Server Port

FTP Server port to use for Import 
Server. The default FTP port is 21.

Does not require 
application server 
restart.

Import Server - FTP 
Configuration - Username

Remote FTP server to connect to for 
Import Server.

Does not require 
application server 
restart.

Import Server - FTP 
Configuration - Password

Remote password to use for 
authenticating to Import Server using 
FTP.

Does not require 
application server 
restart.

Import Server - FTP 
Configuration - Transfer mode

FTP Transfer mode to Import Server. 
Possible Values: Passive, Active.

Does not require 
application server 
restart.

Export Server - Basic 
Configuration - Protocol Provider

Provider to handle connection protocol 
for the Export Server. Possible Values: 
Local, SSH, FTP.

Does not require 
application server 
restart.

Export Server - Basic 
Configuration - Default Remote 
Directory

Default directory to use for relative 
paths on the Export Server.

Does not require 
application server 
restart.

Parameter Definition Notes

Table 4-2  Remote File Manager module setting definitions



Chapter 4: Configuring the data loader

  55

Export Server - SSH 
Configuration - Server Name 

Name of the remote SSH server used 
with Export Server connectivity.

Does not require 
application server 
restart.

Export Server - SSH 
Configuration - Server Port

SSH Server port used with Export 
Server connectivity - the default SSH 
port is 22.

Does not require 
application server 
restart.

Export Server - SSH 
Configuration - Username

Administrative account user name for 
remote SSH server used with Export 
Server connectivity.

Does not require 
application server 
restart.

Export Server - SSH 
Configuration - Password

Administrative account password for 
remote SSH server used for 
authenticating to Export Server using 
SSH - this password is not required if 
an identify file is used.

Does not require 
application server 
restart.

Export Server - SSH 
Configuration - Identity File

SSH identity file to use for 
authenticating to the Export Server. 
The default value is ~/.ssh/id_rsa. ~ 
gets expanded to the home directory of 
the user running this server.

Does not require 
application server 
restart.

Export Server - SSH 
Configuration - Passphrase for 
Identity File

Passphrase for SSH identity file for 
authenticating to the Export Server. It 
is not required if you are using 
password to connect or if the identity 
file does not have a passphrase.

Does not require 
application server 
restart.

Export Server - SSH 
Configuration - Known Hosts File 

Known hosts file that contains the 
signature for Export Server. The 
default value is 
~/.ssh/known_hosts. ~ gets expanded 
to the home directory of the user 
running this server.

Does not require 
application server 
restart.

Export Server - FTP 
Configuration - Server Name

Name of the remote FTP server used 
with Export Server connectivity. 

Does not require 
application server 
restart.

Export Server - FTP 
Configuration - Server Port

FTP Server port to use for Export 
Server. The default FTP port is 21.

Does not require 
application server 
restart.

Parameter Definition Notes

Table 4-2  Remote File Manager module setting definitions
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Export Server - FTP 
Configuration - Username

Administrative account user name for 
remote FTP server used with Export 
Server connectivity.

Does not require 
application server 
restart.

Export Server - FTP 
Configuration - Password

Administrative account password for 
remote FTP server used with Export 
Server connectivity.

Does not require 
application server 
restart.

Export Server - FTP 
Configuration - Transfer Mode - 
Active/Passive 

FTP Transfer mode to Export Server. 
Possible Values: Passive, Active.

Does not require 
application server 
restart.

Gateway Server - Basic 
Configuration - Protocol Provider

Provider to handle connection protocol 
for the Gateway Server. Possible Values: 
Local, SSH.

Does not require 
application server 
restart.

Gateway Server - Basic 
Configuration - Default Remote 
Directory 

Default directory to use for relative 
paths on the Gateway Server.

Does not require 
application server 
restart.

Gateway Server - SSH 
Configuration - Server Name

Name of the remote SSH server used 
with Gateway Server connectivity.

Does not require 
application server 
restart.

Gateway Server - SSH 
Configuration - Server Port 

SSH Server port used with Gateway 
Server connectivity - the default SSH 
port is 22.

Does not require 
application server 
restart.

Gateway Server - SSH 
Configuration - Username

Administrative account user name for 
remote SSH server used with Gateway 
Server connectivity.

Does not require 
application server 
restart.

Gateway Server - SSH 
Configuration - Password

Administrative account password for 
remote SSH server used for 
authenticating to Gateway Server using 
SSH - this password is not required if 
an identify file is used.

Does not require 
application server 
restart.

Gateway Server - SSH 
Configuration - Identity File

SSH identity file to use for 
authenticating to the Gateway Server. 
The default value is ~/.ssh/id_rsa. ~ 
gets expanded to the home directory of 
the user running this server.

Does not require 
application server 
restart.

Parameter Definition Notes

Table 4-2  Remote File Manager module setting definitions
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Configuring the Processor Manager connectivity
The Processor Manager module lets you to configure specific parameters for the Data Gateway server 
for connectivity with the database server. You can access this module by doing the following:

1. Log on to the EIS application.

2. Select Module Settings under the Settings menu.

3. Select Processor Management from the dropdown list.

4. Scroll through the configuration list and fill out the appropriate Processor Management 
parameters. 

5. When you are finished with your configuration, click OK.

If you decide not to implement the changes you made, click Cancel.

Certain parameters, as indicated, require you to stop and restart the application server for your 
changes to take effect. Clients connected to the EIS application must stop and restart the EIS 
application for the changes to take effect.

A list of the Data Gateway parameters and their functions is provided below.

Gateway Server - SSH 
Configuration - Passphrase for 
Identity File.

Passphrase for SSH identity file for 
authenticating to the Gateway Server. It 
is not required if you are using 
password to connect or if the identity 
file does not have a passphrase.

Does not require 
application server 
restart.

Gateway Server - SSH 
Configuration - Known Hosts File

Known hosts file that contains the 
signature for Gateway Server. The 
default value is 
~/.ssh/known_hosts. ~ gets expanded 
to the home directory of the user 
running this server.

Does not require 
application server 
restart.

Parameter Definition Notes

Gateway Data Loader - Continue 
Load set Check Interval

The check interval in minutes between 
continuing execution of the Gateway 
Data Loader Processor while a load set 
is being processed in Gateway.

Requires application 
server restart.

Table 4-3  Processor Management module setting definitions

Parameter Definition Notes

Table 4-2  Remote File Manager module setting definitions
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Restart MIPO server
You must restart the MIPO application server in order for your configuration changes to take effect.

Gateway Data Loader - Gateway 
Database

Where the Gateway database resides for 
the Gateway Data Loading Processor.

Requires application 
server restart.

Gateway Data Loader - Gateway 
Schema - Password

The gateway schema password for the 
Gateway Data Loading Processor.

Requires application 
server restart.

Gateway Data Loader - Gateway 
Schema - User name

The Gateway schema user name for the 
Gateway Data Loading Processor.

Requires application 
server restart.

Gateway Data Loader - Maximum 
Load set Check Intervals

The maximum number of checks to 
continue execution of the Gateway 
Data Loading Processor of a load set 
before it is canceled.

Requires application 
server restart.

Gateway Data Loader - 
SQL*Loader Application

Gateway Data Loader SQL*Loader 
Application used for populating the 
staging tables prior to calling Gateway.

Requires application 
server restart.

Parameter Definition Notes

Table 4-3  Processor Management module setting definitions
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Chapter 5:
Testing the

EIS application

he instructions in this section describe how to test the EIS application and database server 
installation and data loader configuration. It includes instructions for performing the 
following tasks:

• Installing the SAP EIS Gateway Loading Tool (SGLT)

• Validating and generating the example data set

• Importing the example data set and viewing the network

SGLT installation
This section describes the procedure for downloading and installing the SAP EIS Gateway Loading 
Tool (SGLT) and prerequisites for using the SGLT with the Data Gateway.

Prerequisites
The SGLT can be used to create data sets on any client PC that meets the MIPO client software 
requirements:

• Microsoft Excel 2007 or later must be installed on your client PC.

T
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• Microsoft .NET Framework Version 2.0 must be installed on your client PC. For 
Windows XP-based client PCs, the .NET Framework may be included with the operating 
system. This can be verified through Add and Remove Programs under the Windows 
Control Panel. For earlier versions of Windows, you must download and install the 
Microsoft .NET Framework Version 2.0 Redistributable Package from the Microsoft 
Download Center.

• You must have Windows Administrator privileges to install the SGLT on your PC.

When you install the SGLT, the authentication certificate will be installed on your PC. The first time 
you open the SGLT or Example Gateway Data Set workbook, you will be prompted to enable macros 
and select a checkbox. Thereafter, you can open the SGLT and example supply chain workbooks in 
Excel without encountering dialog boxes asking you to enable macros. 

Installing the SGLT
The SGLT utility and Data Gateway example spreadsheet are included as part of the Data Loading 
Tool installation. To install the Data Loading Tool, do the following:

1. Log on to the MIPO application with your user account.

2. Click Data Set > Import Data Set to open the Import Data Set window.

3. Click Download in the row containing the setup.exe file. 

The File Download dialog opens.

4. Run the file download utility. 

The InstallShield Wizard opens. 

5. Select the correct language and run the InstallShield Wizard. 

The Certificate Import Wizard opens.

6. Run the Certificate Import Wizard. 

You will see that the InstallShield Wizard has completed the installation.

7. Click Finish.

You can now access the SGLT template and example files through the Windows Start menu 
(Programs > SAP EIS SGLT). 

Uninstalling the SGLT
To remove the SGLT application from your PC, do the following:

1. Click Start > Control Panel to open the Control Panel window.

2. Click Uninstall a Program to open the Add/Remove Programs window.

3. Select SAP EIS Gateway Loading Tool for MIPO <version> from the list of 
currently installed programs.
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4. Click Uninstall. The Add/Remove Programs confirmation dialog opens.

5. Click Yes. The uninstallation status dialog opens, then automatically closes when the 
uninstallation process is complete.

Setting the EIS URL as a Trusted site
To properly view Export windows, Pop Ups and other features in the application, users must add the 
EIS URL to the list of Trusted Sites in Internet Explorer, as follows:

1. Open Internet Explorer and enter the EIS portal URL (http://server:port/, where 
server is the name of the application server provided during the installation and port is 
the assigned port number). 

2. Select the entire EIS URL as it appears in the Address bar and copy it to the clipboard 
(using CTRL+C or Edit > Copy).

3. Select Tools > Internet Options. The Internet Options dialog opens.

4. Select the Security tab. In the Select a Web Content Zone to specify its security 
settings panel, select the Trusted Sites icon.

5. Click the Sites button. The Trusted Sites dialog opens.

6. In the Add this Web site to the Zone text field, enter or paste the EIS application URL 
and click the Add button. 

7. Click OK to exit the Trusted Sites dialog, and OK again to exit the dialog.

Importing the example data set and testing the 
application
To import the example supply chain:

1. Ensure that the EIS application is running on the application server and that you can 
connect to the database server.

2. On a Windows PC, start Internet Explorer and enter the following text in the Address 
field:

http://app_server_name:port_number/

In this example, app_server_name represents the name of the machine on which the 
EIS application server is running and port_number represent the port number on which 
the application server is listening. 

http://app_server:8080/SmartOps/
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3. The EIS Portal window opens to show the pre-login page. Click the Login button, then 
sign in to the application using the default User Name and Password (e.g., smartops/
smartops), and select MIPO from the dropdown list of portal options. 

4. Click Data Set > Import Data Set to open the Import Data Set window. 

Note that the Supply Chain and Scenario Selectors on the left do not contain the name 
of the example supply chain or base scenario.

5. Enter the full path and file name of the .zip file you want to import in the File Name 
field or click Browse... to open the Choose file window. 

6. Navigate to the directory containing the .zip file that you want to import, select it, and 
click Open. 

7. Click OK. The file you selected is imported into the MIPO application. This process can 
take several minutes to complete. 

8. Click Alerts > View Alerts to monitor messages regarding the status of the data set 
being processed. 

9. Click REFRESH to update the window contents.

10. When you see the message Loading of a data set is complete, log out of the EIS 
application and sign in again to enable your privileges to view the supply chain you 
imported.

11. The Supply Chain Selector is refreshed and includes the name of the supply chain 
contained in the SGLT. 

12. The Scenario Selector is refreshed to include the name Base Scenario. In MIPO, a 
base scenario is a protected (read-only) scenario, that contains real-world supply chain 
data. You can now create user scenarios that can be edited and optimized to reflect the 
changes you want to apply to a supply chain.

13. Click Edit > View Network to open the Network window. 

Note: The User Name you enter in the Sign In window must 
match the User Name specified in the Loadset Settings 
worksheet of the SGLT. The example supply chain uses the default 
User Name.

Note: Viewing networks in MIPO requires Java plug-in. If a 
compatible version of the plug-in is not currently installed on your 
machine, you are prompted to download it from Sun’s Web site 
when you select Edit > View Network for the first time. A 
firewall or other network security can prevent you from 
downloading the plug-in. Also, you must have Windows 
Administrator privileges to install it after it is downloaded.
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Verify that you see the supply chain network diagram and associated tools.

14. Click Reports > Output Reports > Inventory Summary to open the Inventory 
Summary Reports window.

a.    Click Refresh.

b. Click Show Charts.

Verify that you see separate window open displaying a bar graph representation of the 
Inventory Summary Report.

15. Click Data Set > Export Data Set to open the Export Data Set window.

a.    Use the Period Selectors to choose a start and end period for the test.

b. Click OK.

c. Click Refresh.

d. Click the link associated with the test export file.

Verify that the test .zip file was created and opens correctly.

5. For more information about viewing supply chain networks, select Online Help from the 
Help menu

Entering data using SGLT
MIPO builds a supply chain’s topology and relevant static and time varying data using the information 
you enter in the SAP EIS Gateway Loading Tool (SGLT). The SGLT generates flat files that the 
Gateway Data Loader software then loads and stores in the Gateway database, making it available to 
import into the MIPO application. 

This section discusses:

• Notes about unsupported characters in the SGLT

• Definitions of the entries contained in the SGLT

• How entries in the SGLT relate to the example data contained in an Gateway Example 
Supply Chain (.xls or .xlsm) workbook

• Entering and saving your supply chain data in the SGLT
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Important notes about entering data in the SGLT

Using SGLT
The SGLT consists of a spreadsheet application to be used to create work files for specific data set 
inputs. These work files, when completed, can be processed by the Data Gateway to be imported into 
the MIPO application. The SGLT includes separate spreadsheet applications for use with Excel 32-bit 
and Excel 64-bit.

The Data Gateway includes an example spreadsheet: Gateway Example Model (.xls or .xlsm). This 
example spreadsheet contains data that can be used to test your Data Gateway installation.

Note: When entering data into the SGLT, the following characters are not supported. 
Using any of these causes validation to fail:

• & (ampersand)

• \ (backslash)

• ‘ (single quote)

• “ (double quote)

• > < (right and left angle brackets)

• | (pipe) 

• leading blank spaces in an entry

• two or more consecutive blank spaces in an entry

Note: When you copy data from other worksheets, the hidden contents of cells (for 
example, hyperlinks, formatting and comments) are copied. To copy and paste only the 
cells’ values, click Edit > Paste Special, select the Values radio button and click OK.

Note: Text cells in the SGLT possess the General format. As a result, Excel may 
change the value you enter in certain situations. For example, if you enter the number 
0345 for a location name, Excel changes the entry to 345. To enter a leading zero, you 
must preceded it with an apostrophe, as in ‘0345.

Note: The SGLT can be used on a computer set to any locale. Dates and numbers can 
be entered in the specified locale and the generated loadset will be written in US 
English, which is the format required by MIPO.
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Saving the SGLT as a work file
1. Open the SGLT though the Windows Start button by selecting Programs > SAP EIS 

SGLT> SAP EIS Gateway Loading Tool (SGLT).

2. Use the Save As feature to save the worksheet in a work directory. 

Main Menu
The Main Menu worksheet of the SGLT contains hypertext links, a summary of contents, and 
general instructions and tips for entering your supply chain data into each worksheet. 

The Main Menu worksheet contains a button labeled Clear All Data in the upper right-hand corner. 
Click Clear All Data when you want to ensure that the SGLT does not contain any residual data.

Entering Data Gateway input data
1. Click any of the links in the Worksheet column on the Main Menu worksheet. The 

associated worksheet is displayed.

2. Fill out the data specified by the selected worksheet.

3. If desired, click Validate Sheet to ensure that the information you entered on this 
worksheet is valid. The SGLT Validate Tab dialog box appears. Click Start.

• If the information on this worksheet is valid, the validation status will display that the 
validation resulted in zero errors and warnings. Click Close to close dialog box.

• If the information on this worksheet contains an error or warning, the validation 
status will display how many errors and warnings were found and the SGLT displays 
the Validate and Generate tab with detailed information. Click Close to close 
dialog box and correct the errors or warnings.

4. When finished, either click on another worksheet tab or return to the Main Menu.

5. Repeat Steps 1-4 to complete all worksheets designed for Data Gateway input.

6. Click File > Save to save your changes to the workbook.

Once you have finished completing the SGLT worksheets, you can validate and generate a data set, as 
described at the end of this chapter.

See the sections below for details about each worksheet.

Note: Do not modify the SGLT worksheets in any way (e.g., change column order or 
rename worksheet tabs). Any worksheet changes will adversely affect Data Gateway 
processing, producing invalid results.
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Loadset Settings
A supply chain includes all stages of a product’s development, from procurement of raw materials, 
through assembly and warehouse storage and distribution centers, and finally to retail stores and into 
the hands of customers. 

The Loadset Settings worksheet of the SGLT includes fields where you can define Loadset 
Settings, Period Settings, and Units of Measure. The values you specify for the parameters listed in 
the Loadset Settings worksheet serve as the “master data” for the supply chain you are creating. 

The Loadset Settings worksheet lets you define values for the following entries.

Entry Description

Supply Chain Name Name of a new or existing supply chain

Supply Chain 
Description 

Optional description of the supply chain

Product Module Name of the EIS module associated with the scenario data set.

User Name User Name that must be used to sign in to the EIS application before importing 
the data set.

Initial Inventory 
Position Specified?

You can choose whether or not you want to specify an Initial Inventory Position 
by selecting Yes or No from the drop-down menu. 
If you select Yes, you are required to enter a value for On Hand for each 
stocking point. Entering a value for Planned Receipts is optional. If you do not 
enter a value for Planned Receipts, zero (0) is assumed for each supply path for 
each period in the data horizon.
If you select No, you are not required to enter a value for On Hand for each 
stocking point or for Planned Receipts for each supply path. 

Master BOM Name The name of the primary manufacturing bill of materials (BOM) for the supply 
chain.

Service Level Type A metric that refers to the probability that demand is met from stock. A desired 
service level can be determined and used as a driver for inventory levels. EIS 
uses two service level types to calculate optimal inventory levels:
Non-stockout probability indicates the number of customer orders that you plan to 
service in full as a proportion of the total number of orders received.
If you select Fill rate your service level will be calculated as a ratio of the total 
number of units to be delivered divided by units ordered over a given period. The 
fill rate is also known as the customer service ratio.

Period Length (Base 
Time Unit)

Unit of time (for example, weeks, months, or quarters) in which time varying data 
is provided. For example, if forecast data is provided in weekly time buckets, the 
base time unit is a week.

Table 5-4 Loadset settings data
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Scenario Settings
The Scenario Settings worksheet of the SGLT includes fields for you to enter additional 
configuration parameters and values for the data set.

Scenario Settings data includes the entries in Table 5-5.

Entering scenario setting data for your supply chain
1. Click the Scenario Settings link in the Worksheet column on the Main Menu 

worksheet. The Scenario Settings worksheet is displayed.

2. Select the first empty cell under the Setting Name column and enter the name of a 
scenario configuration parameter.

3. Enter a Setting Value for the scenario configuration parameter.

4. Repeat Steps 2-3 for each scenario configuration parameter in your data set.

Data Horizon (# of time 
periods of inputs)

The number of periods of data available for optimization (computation). 

Analysis Horizon (# of 
time periods to calculate 
outputs)

The number of periods beyond the base period (in other words, in the future) for 
which accurate results are desired. 

Base Period The latest recognized date in the database when historical data transitions to 
forecast data. The current planning period is determined by the start period for 
the latest available forecast (defines what “future” is in MIPO) and the latest 
period for which sales data is available, if it is later than the available forecast 
(defines what is “historical” in MIPO).

Historical Horizon The total number of periods of historical data available for creating a timeline in 
MIPO. The initial value of the historical data horizon grows with time as more 
data becomes available for use in historical calculations. The historical horizon 
must be greater than or equal to zero and less than 1,096.

Stop Criteria Parameter used by MIPO to identify the location in the MIPO process to stop 
processing the load set.

Entry Description

Setting Name Name of the configuration parameter to be used by the scenario data set.

Setting Value Value associated with the configuration parameter.

Table 5-5 Scenario Settings

Entry Description

Table 5-4 Loadset settings data
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5. Click File > Save to save your changes to the workbook.

6. Click Menu to return to the Main Menu worksheet.

Processor Settings
The Processor Settings worksheet of the SGLT includes fields for you to enter information about 
processors that you want to execute for this load set. Processors are pieces of software code that can 
perform calculations, modify specific data, or perform other functions such as rounding or generating 
flat files. 

Processors can be created and executed for various phases in MIPO. Table 5-6 lists each processor, 
the processing phases, and describes the state that the load set is in when a processor is invoked.

Processor Phase Description

DemandErrorCleanup Preloading Before loading the data for the Demand 
Error Processor, this processor is run to 
truncate the historical sales and demand 
forecast tables so that only new data will be 
populated there.

DemandIntelligenceErrorProcessor Preprocessing Part of the Demand Intelligence Module 
(DIM), this processor determines and 
populates per period demand standard 
deviation by item-location-period at all 
customer facing stocking points (including 
those that contain insufficient demand data 
or no data at all) for periods in the MIPO 
data horizon.

DemandIntelligenceExportProcessor Preprocessing Part of the Demand Intelligence Module 
(DIM), this processor transfers the demand 
outputs from the DIM scenario to a 
selected MIPO scenario.

DemandIntelligenceImportProcessor Report Generation Part of the Demand Intelligence Module 
(DIM), this processor creates a DIM 
scenario data set based on a selected MIPO 
scenario.

DemandNodeCreationProcessor Preprocessing Determines and populates additional 
demand nodes to the supply chain to 
ensure the network topology satisfies 
MIPO validation criteria. This processor 
identifies stocking points having both 
internal and external demand, along with 
single stocking points that have multiple 
customer demand streams.
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GenerateReports Report Generation MIPO loadsets can be configured to 
automatically generate all or a subset of 
published reports for a given loadset. The 
system generates report files and saves 
them automatically to a directory specified 
in the Manage Module Setting feature’s 
Published Reports module.

LeadTimeCleanup Preloading Before loading the data for the Lead Time 
Processor, this processor is run to truncate 
the Purchase Order tables so that only new 
data will be populated there.

LeadTimeProcessor Preprocessing Calculates the mean order processing lead 
time, the mean physical lead time, and the 
total lead time standard deviation for all 
supply paths with sufficient historical 
transactional data.

NewItemProcessor Preprocessing Maps the historical sales and demand 
forecast history and future forecasts from 
an existing stockkeeping unit (SKU) to a 
new SKU. This processor provides the 
ability for MIPO to perform inventory 
optimization calculations on any new 
component or finished good item 
introduced into the supply chain based on 
data associated with an existing, similar 
item.

NodeIdentificationProcessor Preprocessing Identifies demand nodes as non-stocking 
nodes and “marks” them for removal 
before MIPO optimization. It can also be 
used to identify any non-managed item and 
location within a supply chain.

ReviewInventoryTargetsProcessor Report Generation Calculates the data used by the Review 
Inventory Targets feature.

ScenarioAssociationProcessor Preloading Allows MIPO to automatically send out 
user notification of events and alerts for 
new scenarios to any assigned MIPO user, 
rather than just the scenario owner.

Processor Phase Description
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Table 5-6 EIS processors

Processor settings include the entries listed in Table 5-7.

ScenarioTransformationProcessor Preprocessing Part of the Service Level Optimization 
(SLO) module, this processor creates a 
SLO scenario data set based on a selected 
MIPO scenario. 

ServiceLevelToCostProcessor Report Generation Calculates the data used by the Service 
Level to Cost Report feature.

SloOutputCopyProcessor Preprocessing Part of the Service Level Optimization 
(SLO) module, this processor transfers the 
service level outputs from the SLO 
scenario to a selected MIPO scenario. 

SupplyLeadTimeProcessor Preprocessing Part of the Supply Intelligence Module 
(SIM), this processor calculates the mean 
order processing lead time, the mean 
physical lead time, and the total lead time 
standard deviation for all supply paths with 
sufficient historical transactional data. The 
processor then overwrites the values 
originally provided in the loadset with its 
newly calculated values. S

SupplyProcessor Preprocessing Calculates Schedule Attainment and 
Schedule Attainment Error.

UnitCostCalculator Preprocessing As a unit cost value is a required input for 
all Stocking Points in MIPO, the Unit Cost 
Calculator processor determines a more 
accurate cost of an item at a particular 
point in time within the supply chain 
network.

Entry Description

Processor Name The name of the processor. 

Setting Name The specific setting parameter you wish to define.

Setting Value The value to be associated with the setting parameter.

Table 5-7 Processor settings data

Processor Phase Description
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Entering processor settings for your supply chain
You must define the configuration parameters for each processor you intend to use when loading the 
data set. Each parameter must be entered as a separate row on the Processor Settings worksheet.

Refer to the EIS Processors Spreadsheet for more information on the configuration parameters, 
behaviors, and default values associated with each processor you intend to use. For example, certain 
processors only need two defined parameters: a sequence number associated with the processing 
phase and an activation setting. Other processors will require you to fill out several rows of the 
worksheet in order to be properly configured for the data set.

Business Alerts
The Business Alerts worksheet of the SGLT includes fields for you to enter information that defines 
validation rules to be used during MIPO’s exception management process. When MIPO validates 
input or output data against these customer-specific business rules, it will generate an alert whenever it 
is determined that data exceeds the specified trigger value.

There are two steps for configuring business alerts in the SGLT. First you must determine the severity 
level for stopping the MIPO validation and optimization process. Use the Scenario Settings tab to 
set different severity levels for Input and Output validation (Business Alerts Input Stop Severity and 
Business Alerts Output Stop Severity). You have the following options:

• Use Default

• Disabled

• None

• Fatal Error

• Error

• Warning

• Informational

The second step is to configure the specific business alerts using the Business Alerts tab. Refer to the 
tables in Appendix B to provide the configuration settings needed to activate the business alerts 
feature

Business Alert settings include the entries listed in Table 5-7.

Entry Description

Business Alert Name The name of the Business Alert.

Instance Number Used when running the same business alert multiple times to identify each 
instance.

Table 5-8 Business Alert settings data
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Items
The Items worksheet of the SGLT includes fields for you to enter information about the items 
(similar to stock keeping units (SKUs)) in your supply chain. An item is a uniquely identified, single 
product in inventory.

Item data includes the entries listed in Table 5-9.

Locations
The Locations worksheet of the SGLT includes fields for you to enter information about the 
locations in your supply chain. A location is any physical point in the supply chain at which inventory is 
stored. Factories, warehouses, distribution centers, and retail stores are all types of locations. 

Business Alert Property The parameter setting name associated with the Business Alert.

Business Alert Value The configuration value asigned to the defined parameter setting.

Note: If you do not identify a comparison scenario when using one of the comparison 
Business Alerts, a fatal error alert will be generated and the loadset will fail. When this 
alert occurs, the user can either delete the failed scenario, fix the incoming data set, and 
resubmit, or, disable the output business alerts on the Manage Scenarios screen and 
proceed.

Entry Description

Item ID Unique code that identifies item in supply chain.

Item Name Name of the item.

Item Type Type category associated with the item.

Item UOM The unit of measure that applies to each item.

Product Family Product category associated with the item.

Table 5-9 Items data

Entry Description

Table 5-8 Business Alert settings data
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Location data includes the entries in Table 5-10.

Vendors
The Vendors worksheet of the SGLT includes fields for you to enter information about the vendors 
in your supply chain. The Vendors worksheet represents all of the vendor data, including locations.

Vendors data includes the entries in Table 5-11.

Item attributes
The Item Attribute worksheet of the SGLT includes fields for you to enter attribute information 
associated with each item (similar to stock keeping units (SKUs)) in your supply chain. An item is a 
uniquely identified, single product in inventory.

Item attribute data includes the entries listed in Table 5-12.

Entry Description

Location ID Unique code that identifies location in supply chain.

Location Name Name of the location.

Location Type Type category associated with the location.

Table 5-10 Locations data

Entry Description

Vendor Location ID Unique value to identify a supplier location in the supply chain.

Vendor Location Name Name of the supplier location associated with the load set.

Table 5-11 Vendor List data

Entry Description

Item ID Unique code that identifies item in supply chain.

Item Attribute Name Characteristics of an item or set of items that are custom-defined for your supply 
chain. Examples include language and item type.

Item Attribute Value Value associated with the item attribute.

Table 5-12 Item attribute data
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Location attributes
The Location Attribute worksheet of the SGLT includes fields for you to enter information about 
the attributes associated with each location in your supply chain. A location is any physical point in the 
supply chain at which inventory is stored. Factories, warehouses, distribution centers, and retail stores 
are all types of locations. 

Location attribute data includes the entries in Table 5-13.

Node attributes
The Node Attribute worksheet of the SGLT includes fields for you to enter attribute information 
associated with each item-location node. in your supply chain. 

Node attribute data includes the entries listed in Table 5-14.

Forecast
The Forecast worksheet of the SGLT includes fields for you to enter information about the historical 
and future forecast data in your supply chain. A forecast is an estimate of how much inventory will be 
needed in the supply chain during a particular time period. The SGLT lets you add both historical and 
future forecast data so it can be included in the data set for optimization calculations.

Entry Description

Location ID Unique code that identifies location in supply chain.

Location Attribute 
Name

Characteristics of a location or locations that are custom-defined for your supply 
chain. Examples include geographical district, location type (warehouse, factory, 
retail store). 

Location Attribute Value Value associated with the specific location attribute.

Table 5-13 Location attributes data

Entry Description

Item ID Unique code that identifies an item in supply chain.

Location ID Unique code that identifies location in supply chain

Node Attribute Name Characteristics of node or set of nodes that are custom-defined for your supply 
chain. Examples include language and item type.

Node Attribute Value Value associated with the node attribute.

Table 5-14 Item attribute data
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Forecast data includes the entries in Table 5-15.

Sales
The Sales worksheet of the SGLT includes fields for you to enter information about the historical 
sales data in your supply chain. Sales data reflects how much inventory was actually used in the supply 
chain during a particular time period. 

Sales data includes the entries in Table 5-16.

Demand
The Demand worksheet of the SGLT includes fields for you to enter external demand information 
from your supply chain. Demand data reflects how much inventory was expected to be used in the 
supply chain during a particular time period. 

Entry Description

Item ID Unique code that identifies item in supply chain.

Location ID Unique code that identifies location in supply chain.

Ship To Location ID Identifies customer-facing destination of item.

Revision Date The date on which the forecast data for the specific item has been updated for 
the associated period.

Period Date The starting date for the period associated with the forecast data for the specific 
item.

Forecast Value The forecast data related to the period for the specific item.

Table 5-15 Forecast data

Entry Description

Item ID Unique code that identifies item in supply chain.

Location ID Unique code that identifies location in supply chain.

Ship To Location ID Identifies customer-facing destination of item.

Period Date The starting date for the period associated with the historical sales data for the 
specific item.

Sales Value The historical sales data related to the period for the specific item.

Table 5-16 Sales data
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Demand data includes the entries in Table 5-17.

Demand Stream Static
The Demand Stream Static worksheet of the SGLT includes fields for you to enter non-time varying 
information for each demand stream in your supply chain.  

Demand stream static data includes the entries in Table 5-17.

Bill of Material
The Bill of Material worksheet of the SGLT includes fields for you to enter information about the 
manufacturing bill of material (BOM) at location nodes in the supply chain. A manufacturing BOM is a 
many-to-one relationship between multiple incoming items and a single outgoing item at a process or 

Entry Description

Item ID Unique code that identifies item in supply chain.

Location ID Unique code that identifies location in supply chain.

Ship To Location ID Identifies customer-facing destination of item.

Period Date The starting date for the period associated with the historical sales data for the 
specific item.

Forecast The forecast data related to the period for the specific item.

Forecast Error The forecast error data related to the period for the specific item.

Table 5-17 Demand data

Entry Description

Item ID Unique code that identifies item in supply chain.

Location ID Unique code that identifies location in supply chain.

Ship To Location ID Identifies customer-facing destination of item.

Demand Interval Allows you to define a demand interval value as an alternative to the DIM’s 
average demand interval calculation.

Recency Factor Optional static input that specifies the recency factor for the demand stream. The 
recency factor allows recent data to have greater weight in the forecast bias and 
forecast error CV calculations. The value must be greater than zero and less than 
or equal to one.

Table 5-18 Demand Stream Static data
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manufacturing node in a supply chain. It determines the quantity of each incoming item required to 
produce one unit of each outgoing item, when each is represented in their base unit of measure.

BOM data includes the entries in Table 5-19.

Sourcing
The Sourcing worksheet of the SGLT includes fields for you to enter information about the source 
items in your supply chain. Sourcing data lists the original site where each item is located, along with its 
destination site, for a particular time period. It also includes amounts for specific items and the mode 
used to transfer source items to their destinations.

Sourcing data includes the entries in Table 5-20.

Entry Description

Location ID Unique code that identifies the production location of the manufacturing BOM.

Base Item ID Unique code that identifies the finished good of the manufacturing BOM.

Component ID Unique code that identifies the raw material of the manufacturing BOM.

From Date The start date of when this BOM information is active.

To Date The end date of when this BOM information is active.

Quantity The amount of the component item needed to produce the base item.

Table 5-19 Bill of Material data

Entry Description

Item ID Unique code that identifies source item in supply chain.

From Location ID Unique code that identifies the supply chain site where the source item comes 
from.

To Location ID Unique code that identifies the supply chain site where the source item goes to.

From Date The start date of when this sourcing information is active.

To Date The end date of when this sourcing information is active.

Quota The source item amount needed during the sourcing period.

Duration The length of time needed to move item from the source location to the 
destination location (e.g., physical lead time).

Mode Name Identifies how the item is transferred between the From Location and the To 
Location.

Table 5-20 Sourcing data
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Item Location - Static
The Item Location Static worksheet of the SGLT includes fields for you to enter information about 
static stocking point information in your supply chain. A stocking point is a node which represents an 
item-location pair. Each stocking point node may have upstream nodes, downstream nodes, or both, 
and each stocking point node is connected to its upstream and downstream nodes by paths. The Item 
Location Static worksheet represents all of the supply chain node data that does not change over 
time.

Static stocking point data includes the entries in Table 5-21.

Mode Utilization Provides details on how the mode is used to transfer the source item.

Entry Description

Item ID Unique code that identifies item in supply chain.

Location ID Unique code that identifies location of the stocking point node in supply chain.

Stocking Point Type Identifies a stocking point as either a stocking node, non-stocking node, or non-
managed node. (Note: These values may also be entered as StockingNode, 
NonStockingNode, and NonManagedNode.)

Holding Cost Pct. Cost associated with holding inventory at a stocking location. It is defined for 
each item-location combination per annum, but does not vary over time.

Inventory Unit Cost Represents the monetary value of one unit of inventory (expressed in the 
specified unit of measure) for a given item at a given stocking location. This cost 
may include partial processing (for example, assembly or painting) cost on the 
raw material or components.

Unit Purchase Cost Also referred to as unit in cost, the inbound acquisition cost or transfer price for 
each item-location.

Unit Transfer Price Price at which a stocking point sells a unit of a product to its downstream 
stocking point (its customer).

PBR Periods Between Review - Defines the frequency at which inventory position is 
reviewed and replenishment decisions are made for an item at a location. PBR is 
specified in number of periods.

Table 5-21 Static item location data

Entry Description

Table 5-20 Sourcing data
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PSLR Periods Since Last Review - For a given item at a given location, the number of 
periods since placing a replenishment order or determining (based on inventory) 
to not place an order. PSLR can be less than or equal to the periods between 
review (PBR) for that item-location pair. Example: Assume a given item-location 
pair has a period length of one week and the PBR is 4. If a replenishment order 
was placed 2 weeks ago, the PSLR is 2.

Service Level A metric that refers to the probability that demand is met from stock and is the 
minimum acceptable service level that a company feels they must achieve.

Max Ship Life The maximum number of periods an item can remain at a given node before it 
becomes unusable. You can specify that Maximum Ship Life is unconstrained by 
entering a value of -1.

Coverage Duration The number of periods over which Weeks of Stock should be averaged to 
determine the Average Safety Stock Coverage. Weeks of Stock is the number of 
periods of forward expected demand that can be met by the current inventory. 

Schedule Attainment The ratio between the expected attained production and the scheduled 
production.

Schedule Attainment CV The coefficient of variation of the schedule attainment. For example, if the 
schedule attainment is 0.9 and the coefficient of variation is 0.5, then actual 
production can expect to be 90% +/- 45% of the scheduled production.

Storage Capacity Specifies the maximum storage capacity for each item-location.

On Hand Inventory All inventory that is physically available to fill demand, which is all types of stock 
except pipeline. Specifically, on hand inventory includes cycle, safety, 
merchandising, and prebuild (if applicable) stock.

Unused On Hand 
Inventory

Unusable On Hand inventory is the portion of On Hand inventory that should 
not be considered when calculating inventory targets as it cannot be used to 
satisfy demand.

Pooling Factor A heuristic adjustment made to the safety stock computation based on the 
perceived correlation of demand across downstream stocking points.

Processing Cost Per unit cost of manufacturing and assembly for each item-location.

Transportation Cost Cost of moving an item from an upstream node to an immediate downstream 
node for a given inventory stocking location.

Order Admin Cost Per unit cost of administering an order for each item-location.

Handling Cost Cost of material movements within the warehouse, which may include unloading 
costs, breakdown costs, labor costs, and machinery costs.

Entry Description

Table 5-21 Static item location data
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Item Location - Time Varying
The Item Location Time Varying worksheet of the SGLT includes fields for you to enter 
information about time varying stocking point information in your supply chain. A stocking point is a 
node which represents an item-location pair. Each stocking point node may have upstream nodes, 
downstream nodes, or both, and each stocking point node is connected to its upstream and 
downstream nodes by paths. The Item Location Time Varying worksheet represents all of the 
supply chain node data that changes over time.

Time varying item location data includes the entries in Table 5-22.

Other Cost Miscellaneous expenses, including taxes and insurance, related to keeping 
inventory.

Min Service Level An optional field used by the EIS Service Level Optimization (SLO) module to 
define the lower limit on the individual target fill rate at the associated customer-
facing stocking point.

Max Service Level An optional field used by the EIS Service Level Optimization (SLO) module to 
define the upper limit on the individual target fill rate at the associated customer-
facing stocking point.

Lost Sales Pct An optional field used by the EIS Service Level Optimization (SLO) module to 
define the acceptable lost sales percentage to be applied at the minimum service 
level at the associated customer-facing stocking point.

Inventory Allocation 
Policy

Sets policy used for calculating TIP; either Priority or Divide.   

Entry Description

Item ID Unique code that identifies item in supply chain.

Location ID Unique code that identifies location of the stocking point node in supply chain.

Period Date The starting date for the period associated with the path data for the specific 
item.

Min Required Stock The minimum inventory kept at a retail or customer facing location. It may be 
used for showroom or demonstration purposes, but is typically included in 
inventory available to meet demand.

Note: Values entered for minimum required stock must be greater than or equal 
to zero (0).

Table 5-22 Time varying item location data

Entry Description

Table 5-21 Static item location data
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Default Path - Static
The Default Path Static worksheet of the SGLT includes fields for you to enter information about 
the supply paths in your supply chain and their attributes. A path is a connection between two stocking 
point nodes in a supply chain. A path represents the physical movement of materials in a supply chain.

Use the Default Path Static worksheet to enter path data that does not change over time for each 
supply chain item in your data set. This path data relates only to destination locations for the item and 
does not take into account source locations. Use the Override Path Static worksheet to define 
specific source locations for the paths in your supply chain.

Static default path data includes the entries in Table 5-23.

Entry Description

Item ID Unique code that identifies item in supply chain associated with a specific path.

To Location ID Unique code that identifies the supply chain site at the path ending point for the 
item.

Physical Lead Time Time that it takes from when the upstream (supplier) location begins to fill that 
order until it is received in the downstream location. Physical lead time may also 
be defined as the time during which physical goods are being modified 
(assembled, transported) and actual material costs are being incurred. This may 
include manufacturing time, transportation time and material handling 
(warehousing) time.

Processing Lead Time Elapsed time from when the order is placed on an upstream location until that 
location begins to fill that order. This can include order receipt time, processing 
time, and queuing time.

Lead Time Error Statistical measure of uncertainty regarding the magnitude of expected lead time 
in a given period.

Period Between 
Shipments

The frequency at which shipments are made for a path, independent of PBR. 
PBS is specified in number of periods.

Frozen Window Lets you define the number of periods for which variability in incoming demand 
to a stocking point or process point should not be considered.

Service Time The number of periods between the time an order is placed and the time it must 
be shipped before a stockout is considered to have occurred.

Yield The remaining portion of the process’s output after yield loss.

Minimum Batch Size 
(units)

The minimum amount needed, measured by quantity, before an initial order can 
be produced.

Minimum Batch Size 
(periods)

The minimum amount needed, measured by periods of coverage, before an initial 
order can be produced.

Table 5-23 Default Path Static data
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Default Path - Time Varying
The Default Path Time Varying worksheet of the SGLT includes fields for you to enter information 
about the supply paths in your supply chain and their attributes. A path is a connection between two 
stocking point nodes in a supply chain. A path represents the physical movement of materials in a 
supply chain. 

Use the Default Path Time Varying worksheet to enter path data that that changes over time for 
each supply chain item in your data set. This path data relates only to destination locations for the item 
and does not take into account source locations. Use the Override Path Time Varying worksheet to 
define specific source locations for the paths in your supply chain.

Time varying default path data includes the entries in Table 5-24.

Batch Size The order quantity that is agreed-upon between the upstream and downstream 
nodes. The downstream node’s order quantities must be an integer multiple of 
the batch size.

Reliability The probability that an order delivery will be completed within the total lead time 
(cycle time).

Entry Description

Item ID Unique code that identifies item in supply chain associated with a specific path.

To Location ID Unique code that identifies the supply chain site at the path ending point for the 
item.

Period Date The starting date for the period associated with the path data for the specific 
item.

Planned Receipts The shipment quantities on a path for a given period, that are expected at the end 
node in that period, assuming deterministic lead times and service times in 
response to planned orders.

Max Process Capacity The maximum quantity of each item that can be ordered or produced in each 
time period for each supply path.

Note: Unconstrained capacity, or infinite capacity, describes a supply path for 
which a capacity constraint does not exist. You can specify unconstrained 
capacity, or infinite capacity, by entering a value of negative one (-1).

Table 5-24 Default path time varying data

Entry Description

Table 5-23 Default Path Static data
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Override Path - Static
The Override Path Static worksheet of the SGLT includes fields for you to enter information about 
the supply paths in your supply chain and their attributes. A path is a connection between two stocking 
point nodes in a supply chain. A path represents the physical movement of materials in a supply chain. 

Use the Override Path Static worksheet to enter path data that does not change over time for each 
supply chain item in your data set. This path data relates to specific source and destination locations 
for the item. Use the Default Path Static worksheet to define default path data for your supply chain, 
not dependent on the source location.

You can also use this worksheet to define path information between customer-facing stocking points 
and customer nodes, specifically Frozen Window, Service Level, and Service Time.

Static override path data includes the entries in Table 5-25.

Min Process Quantity The minimum quantity of each item that must be produced in each time period 
(typically due to a manufacturer’s desire to avoid labor schedule or shift 
reductions, cutbacks, layoffs, etc.) for each supply path.

Note: Values entered for minimum process quantity must be less than or equal 
to those entered for maximum process capacity.

Entry Description

Item ID Unique code that identifies item in supply chain associated with a specific path.

From Location ID Unique code that identifies the supply chain site at the path starting point for the 
item.

To Location ID Unique code that identifies the supply chain site at the path ending point for the 
item.

Mode Name Identifies the mode used to transfer the associated item from the source location 
to the destination location.

Physical Lead Time Time that it takes from when the upstream (supplier) location begins to fill that 
order until it is received in the downstream location. Physical lead time may also 
be defined as the time during which physical goods are being modified 
(assembled, transported) and actual material costs are being incurred. This may 
include manufacturing time, transportation time and material handling 
(warehousing) time.

Table 5-25 Static Override Path data

Entry Description

Table 5-24 Default path time varying data
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Processing Lead Time Elapsed time from when the order is placed on an upstream location until that 
location begins to fill that order. This can include order receipt time, processing 
time, and queuing time.

Lead Time Error Statistical measure of uncertainty regarding the magnitude of expected lead time 
in a given period.

Period Between 
Shipments

The frequency at which shipments are made for a path, independent of PBR. 
PBS is specified in number of periods.

Frozen Window Lets you define the number of periods for which variability in incoming demand 
to a stocking point or process point should not be considered.

Service Time The number of periods between the time an order is placed and the time it must 
be shipped before a stockout is considered to have occurred.

Service Level A percentage value referring to the probability that demand for the associated 
item is met from stock.

Min Service Level An optional field used by the EIS Service Level Optimization (SLO) module to 
define the lower limit on the individual target fill rate at the associated customer-
facing stocking point.

Max Service Level An optional field used by the EIS Service Level Optimization (SLO) module to 
define the upper limit on the individual target fill rate at the associated customer-
facing stocking point.

Lost Sales Pct An optional field used by the EIS Service Level Optimization (SLO) module to 
define the acceptable lost sales percentage to be applied at the minimum service 
level at the associated customer-facing stocking point.

Loss Free Service Level An optional field used by the EIS Service Level Optimization (SLO) module to 
define a demand stream specific input for loss free service level.

Unit Transfer Price The price at which a stocking point sells a unit of a product to its downstream 
stocking point (its customer).

Yield The remaining portion of the process’s output after yield loss.

Minimum Batch Size 
(units)

The minimum amount needed, measured by quantity, before an initial order can 
be produced.

Minimum Batch Size 
(periods)

The minimum amount needed, measured by periods of coverage, before an initial 
order can be produced.

Batch Size The order quantity that is agreed-upon between the upstream and downstream 
nodes. The downstream node’s order quantities must be an integer multiple of 
the batch size.

Entry Description

Table 5-25 Static Override Path data
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Override Path - Time Varying
The Override Path Time Varying worksheet of the SGLT includes fields for you to enter 
information about the supply paths in your supply chain and their attributes. A path is a connection 
between two stocking point nodes in a supply chain. A path represents the physical movement of 
materials in a supply chain. 

Use the Override Path Time Varying worksheet to enter path data that changes over time for each 
supply chain item in your data set. This path data relates to specific source and destination locations 
for the item. Use the Default Path Time Varying worksheet to define default path data for your 
supply chain not dependent on the source location.

Time varying override path data includes the entries in Table 5-26.

Reliability The probability that an order delivery will be completed within the total lead time 
(cycle time).

Entry Description

Item ID Unique code that identifies item in supply chain associated with a specific path.

From Location ID Unique code that identifies the supply chain site at the path starting point for the 
item.

To Location ID Unique code that identifies the supply chain site at the path ending point for the 
item.

Mode Name Identifies the mode used to transfer the associated item from the source location 
to the destination location.

Period Date The starting date for the period associated with the path data for the specific 
item.

Planned Receipts The shipment quantities on a path for a given period, that are expected at the end 
node in that period, assuming deterministic lead times and service times in 
response to planned orders.

Max Process Capacity The maximum quantity of each item that can be ordered or produced in each 
time period for each supply path.

Note: Unconstrained capacity, or infinite capacity, describes a supply path for 
which a capacity constraint does not exist. You can specify unconstrained 
capacity, or infinite capacity, by entering a value of negative one (-1).

Table 5-26 Time varying override path data

Entry Description

Table 5-25 Static Override Path data
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New Item
The New Item worksheet of the SGLT includes fields for you to enter information related to the 
New Item processor. This processor lets you use sales and forecast data from an existing item to any 
comparable new item being introduced to your supply chain. The New Item worksheet represents all 
of the data needed by the New Item processor. 

Note: You must invoke the New Item processor through the Processors tab.

New Item data includes the entries in Table 5-27.

Purchase Order
The Purchase Order worksheet of the SGLT includes fields for you to enter information about the 
Purchase Order in your supply chain. The Purchase Order worksheet represents all of the Purchase 
Order data related to each item in your supply chain.

Min Process Quantity The minimum quantity of each item that must be produced in each time period 
(typically due to a manufacturer’s desire to avoid labor schedule or shift 
reductions, cutbacks, layoffs, etc.) for each supply path.

Note: Values entered for minimum process quantity must be less than or equal 
to those entered for maximum process capacity.

Entry Description

Item Name Identifies the new item name in the supply chain.

Item Location Identifies the new location name in the supply chain.

Superceded Item ID Identifies the original item name in the supply chain.

Superceded Location ID Identifies the original location name in the supply chain.

Conversion Factor Value represents conversion of new item quantity compared to superseded item.

Historical Sales Transfer 
Date

Historical sales period date to start transfer.

Historical Forecast 
Transfer Date

Demand forecast period to start transfer.

Transfer Future Forecast Indicates whether the data transfer should be used for future forecast.

Table 5-27 New Item data

Entry Description

Table 5-26 Time varying override path data
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Purchase Order data includes the entries in Table 5-28.

Historical Production
The Historical Production worksheet of the SGLT includes fields for you to enter information 
about the historical production in your supply chain. The Historical Production worksheet 
represents data for stocking points linking forecast quantities to the actual qualities used for each 
production time period.

Historical Production data includes the entries in Table 5-29.

Entry Description

Purchase Order Number Number associated with the purchase order.

Creation Date Date when the purchase order was created.

Shipment ID Identifies the shipment associated with the purchase order.

Item ID Unique value to identify an item in the supply chain.

Source Location ID Unique value to identify the source location of a specific path item in the supply 
chain.

Destination Location ID Unique value to identify the destination location of a specific path item in the 
supply chain.

Submission Date Date when the purchase order was submitted for approval.

Receipt Date Date when the items associated with the purchase order were received.

Order Quantity The number of items associated with the purchase order.

UOM The unit of measure associated with the purchase order item.

Mode Identifies the mode used to transfer the associated item from the source location 
to the destination location.

Table 5-28 Purchase Order data

Entry Description

Item ID Unique value to identify an item in the supply chain.

Location ID Unique value to identify a location in the supply chain.

Period Date The starting date for the period associated with the forecast data for the specific 
item.

Planned Production Amount forecasted for production for the time period.

Table 5-29 Historical Production data
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Validating and generating a data set
To create a .zip file containing the valid data for a new supply chain or user scenario:

1. Click the Validate & Generate worksheet tab.

2. Click Go. The SGLT Export dialog box opens

3. Click the Generate Loadset check box to enable or disable generating a .zip file after 
validation.

4. Use the Browse button to change the directory location for the generated .zip file.

5. If you want to hide Warning Details, which are informational warnings, click the Hide 
Warning Details check box. When Warning Details are hidden, information is not 
displayed in the Validate & Generate worksheet when a warning is encountered. Note 
that you cannot hide details about Errors, which are more serious.

6. Validation Options defaults to Extended; choose a different option by clicking the 
corresponding radio button.

Actual Production Amount used for production for the time period.

Entry Description

Table 5-29 Historical Production data
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7. If desired, specify the maximum number of errors that can be generated before 
processing of the load set is stopped in the Max Number of Errors field.

8. Click Start. The bar graphs indicate the amount of progress taken place in the validation 
process. When the process is finished, click Close.

9. Any warnings or errors generated during the validation process will appear on the 
worksheet, with links to the source data (Figure 5-1).

 Figure 5-1 Validate and Generate worksheet

10. If you are generating a loadset, you must fix any errors detected by the validation process 
before the data set can be optimized by MIPO or DIM. See the EIS Online Help for more 
information on importing a data set into MIPO or DIM.

Importing a data set into SGLT
The Import worksheet of the SGLT allows you to migrate existing .zip files created in a previous 
version of the tool into a newer version of the SGLT. During the migration process, the .zip file is 
unzipped and the contents of the data files are copied into the new tool. The Import worksheet lists 
the individual data files that were migrated and displays additional information if a problem is 
encountered. 
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This chapter describes how to migrate a data set created in a previous version of the SGLT to the 
latest tool.

1. Click the Import worksheet tab.

2. Click Import Dataset. The SGLT Import dialog box opens

3. Use the Browse button to set the directory location for the .zip file.

4. Click Start. The bar graphs indicate the amount of progress taken place in the migration 
process. When the process is finished, click Close.

5. Any warnings or errors generated during the validation process will appear on the 
worksheet, with links to the source data.
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Chapter 6:
Configuring EIS

Processors

he EIS application design provides standard processors for generating reports. The following 
processors are available in EIS:

• Demand Node Creation processor

• Economic Order Quantity (EOQ) processor

• Lead Time processor

• New Item processor

• Node Identification processor

• Scenario Association processor

• Supply processor

• Unit Cost Calculator processor

For more information on these processors, see the EIS Processor Spreadsheet.

T 
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Chapter 7:
Customizing EIS

his section describes how to configure and customize EIS to better fit your organization’s 
needs. By modifying files installed with the EIS application, you can customize the appearance 
of the user interface and certain aspects of the EIS application’s functionality. 

This chapter contains the following sections:

• Changing user account security settings

• Changing internationalization settings

• Changing account password settings in secure.smartops.properties

• Changing settings in smartops.properties

• Changing EIS interface properties

• Changing data editing settings

• Changing report settings

• Setting an environment label

• Changing export settings

• Changing published reports settings

• Changing customer support settings

• Changing scenario settings

T
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• Changing the Supply Chain Id in the SST.DAT file

• Transferring MIPO scenario data to the Data Store

• Configuring Business Alert settings

Changing user account security settings
The EIS user account administration feature includes several password strength configuration settings. 
The User Settings module lets you define the default security parameters associated with EIS user 
accounts. 

For security purposes, if a user signed in to the EIS application does not use the application for a 
specified period of time, he or she is automatically logged out. You can specify the amount of time 
that users can remain inactive before being automatically logged out.

You can specify the time between checks for expired authentication tokens.

You can also specify the number of times a user can attempt to sign in before being locked out of the 
application.

In compliance with security best practices, EIS user passwords can be configured to expire after a 
period of time. When a password expires, the user will be prompted to select a new password when 
logging in to the EIS application. The system can also be configured to prevent passwords from being 
reused.

The EIS application’s password security functionality has three components:

• Configurable password security settings in the User Settings module

• A user privilege that allows a given user to enable or disable password security for them-
selves and any other user

• A password security checkbox, visible only to users with the privilege described above, 
that enables or disables password security requirements for a single user on a case-by-case 
basis

You can access the User Settings module by doing the following:

1. Log on to the EIS application.

Note: For security reasons, we recommend protecting the location of the EIS 
.properties configuration files from access on the Operating System level.

Note: For security reasons, we recommend that the password for the default user be 
changed once installation and configuration has been completed. 
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2. Select Module Settings under the Settings menu.

3. Select User Settings from the dropdown list.

4. Scroll through the configuration list and fill out the appropriate account security setting 
parameters. 

5. When you are finished with your configuration, click OK.

If you decide not to implement the changes you made, click Cancel.

A list of user account security parameters is provided below.

Parameter Definition Notes

Account Lockout Threshold Number of consecutive login failures 
which will cause the user account to be 
locked. Set to zero to disable 
lockout.Defaults to zero (0).

Does not require 
application server 
restart.

Initial Password Reset Indicates whether a user must reset 
their password upon first login. 
Defaults to No.

Does not require 
application server 
restart.

Password Expiration Number of days before a user password 
expires. Set to zero to disable password 
expiration. Defaults to zero (0).

Does not require 
application server 
restart.

Password History Number of previous passwords to 
track. Set to zero to disable password 
history. Defaults to zero (0).

Does not require 
application server 
restart.

Security Audit Indicates whether alerts are generated 
for login and logout. Defaults to No.

Does not require 
application server 
restart.

User Session Timeout (Seconds) Number of seconds before a user 
session is terminated due to inactivity. 
Defaults to 3.600.

Does not require 
application server 
restart.

Minimum Password Length Minimum character length of a user 
password. Defaults to five (5).

Does not require 
application server 
restart.

Minimum Upper Case Letters Minimum number of English upper 
case letters that must be used a user 
password. Defaults to zero (0).

Does not require 
application server 
restart.

Table 7-30  User account security settings 
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Assigning Password Security Enable/Disable privileges 

Any user can be assigned the privilege of enabling or disabling the EIS application’s password security 
requirements for themselves and others. Note that this privilege does not activate the password 
security settings defined in the User Settings module. The privilege merely allows one user to view and 
manipulate the EIS application’s password security functionality for themselves and other users. For 
example, if User A has this privilege (along with privileges to create and modify user settings), then 
User A can activate password security settings for Users B, C and D, as described below.

Password security privileges are assigned in the EIS application via the Settings > User Settings 
screen, User Privileges tab, User Settings module, Enable/disable password security for any 
user checkbox.

Enabling password security for individual users

When users with the privilege described above create or modify another user’s account, they will see a 
Password Security Enabled checkbox in the EIS interface (this checkbox will only appear in the 
interface for users with password security privileges assigned). Select this checkbox to enable the 
password security provisions set in the User Settings module for a given user. When the Password 
Security Enabled checkbox is selected, the new or modified user will be subject to password security 
requirements outlined in the User Setting module.

Minimum Lower Case Letters Minimum number of English lower 
case letters that must be used a user 
password. Defaults to zero (0).

Does not require 
application server 
restart.

Minimum Numerals Minimum number of Westernized 
Arabic numerals that must be used a 
user password. Defaults to zero (0).

Does not require 
application server 
restart.

Minimum Special Characters Minimum number of non-
Alphanumeric (special characters) that 
must be used a user password. Defaults 
to zero (0).

Does not require 
application server 
restart.

Parameter Definition Notes

Table 7-30  User account security settings 
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Changing Internationalization settings
The EIS portal interface lets a user select the language, time zone, time format, date format, and 
decimal notation in which EIS data is displayed. The User Settings module lets you define the default 
security parameters associated with EIS user accounts. You can access this module by doing the 
following:

1. Log on to the EIS application.

2. Select Module Settings under the Settings menu.

3. Select User Settings from the dropdown list.

4. Scroll through the configuration list and fill out the appropriate Internationalization 
parameters. 

5. When you are finished with your configuration, click OK.

If you decide not to implement the changes you made, click Cancel.

A list of the parameters and their functions is provided below.

Parameter Definition Notes

Default Date Format Date format that is initially selected 
when a new user is created. Defaults to 
MM/DD/YYYY.

Does not require 
application server 
restart.

Default Decimal Notation Decimal format that is initially selected 
when a new user is created. Defaults to 
1,234.56.

Does not require 
application server 
restart.

Default Language Language that is initially selected when 
a new user is created. Defaults to 
English.

Does not require 
application server 
restart.

Default Time Format Time format that is initially selected 
when a new user is created. Defaults to 
HH:MM AM/PM Z.

Does not require 
application server 
restart.

Table 7-31  Internationalization settings
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Changing settings in 
secure.smartops.properties
The secure.smartops.properties file contains parameters that allow you to configure user account 
password functionality in the EIS application. After you make any modifications to this file, the 
parameter settings are encrypted by the EIS application as a security measure. Depending on your 
platform, the secure.smartops.properties file is installed on the application server in the following 
directory:

• SAP Application Server:

\SmartOps\MIPO

The following secure parameters are available:

• Database user password

Use a text editor to set the password parameters for the database server and email server accounts, and 
save your changes. The EIS application’s password encryption feature will automatically encrypt your 
password settings the next time the EIS application server is started. An example of the 
secure.smartops.properties file is given below:

#All the comments in this file will be lost, once, the application 
server starts up.

# Uncomment and supply the database password(user.password) for the 
user specified in smartops.properties.

user.password=@Oracle Password@

user.password.encrypted=

Changing settings in smartops.properties
The smartops.properties file contains parameters that allow you to configure some functionality in 
the EIS application. Depending on your platform, the smartops.properties file is installed on the 
application server in the following directory:

• SAP Application Server:

\SmartOps\MIPO

Notes: The smartops.properties file can be viewed through the EIS portal by going 
to the Module Settings screen and clicking the smartops.properties link in the top 
right corner.

The EIS application includes functionality that creates a backup copy of the current 
smartops.properties file each time the application server is restarted.
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Configuring EIS safe directories
The smartops.safe.directories parameter can be used to define a list of valid directories 
considered safe by the EIS application for security purposes. This parameter can be found under the 
Environment section of the file.

Please note that you must define each path explicit when using the smartops.safe.directories 
setting as the security validation does not accept wildcard characters.

Changing EIS interface properties
You can customize the behavior and appearance of the EIS user interface by modifying settings in 
different properties files. For example, you can change the label associated with a graphical element or 
field, or suppress the appearance of an entity or field that is not used in your organization’s supply 
chain.  

The following sections provide an overview of the settings you are most likely to modify. It is strongly 
recommended that you create a copy of the Property file before you modify it.

Configuring language localization for User Interface

The EIS Solution Suite includes the ability to display Spanish and German text throughout the EIS 
portal. To set the EIS application to display Spanish or German text, you need to include the 
following parameter at the end of the Java Options environment variable setting:

-Duser.language=es (Spanish)

-Duser.language=de (German)

For example:

export JAVA_OPTS="-Xms128m -Xmx1296m -Djava.awt.headless=true 
-Duser.language=es"

Specifying the number of entities displayed in a selector

In the EIS user interface selectors, the maximum number of entities (supply chains, scenarios, items, 
nodes, locations, etc.) that can be displayed is 20, by default. To limit or increase the number of entities 
displayed in selectors, open the SelectorResources.properties file, and change the following setting:

page.default.size = 20

Save and close the text file. Stop and restart the application server for your changes to take effect. 
Clients connected to the EIS application must stop and restart IE for the changes to take effect.

Note: In order to save changes to the user interface configuration files, you must have 
access to the appropriate application server directory containing the original files. The 
application server must be restarted for your changes to take effect.
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Changing the network view
In MIPO, you can view a graphical representation of a supply chain network and the information 
associated with each entity in the Network window. You can also edit the information and view the 
effects your changes have on the entire supply chain network. You can customize how supply chains 
are displayed in the Network window by modifying the NetworkConfigResources.properties file.

Limiting the number of paths displayed

In the Network window, the maximum number of paths that can be displayed when viewing the 
entire network is limited to 1500 incoming and outgoing paths. To further limit the number of paths 
displayed in the network view, open the NetworkConfigResources.properties file, and change the 
following setting:

PathCutoff = 1500

Save and close the text file. Stop and restart the application server for your changes to take effect. 
Clients connected to the EIS application must stop and restart IE for the changes to take effect.

Specifying the number of characters to display

You can specify the number of characters to display on the text labels for the nodes and other entities 
in the Network window. Open the NetworkConfigResources.properties file, and change the 
following setting:

MaxLabelSize.network = 20

You can also specify the number of characters to display in the data fields below the main Network 
window. Open the NetworkConfigResources.properties file, and change the following setting:

MaxLabelSize.fields = 27

Save and close the text file. Stop and restart the application server for your changes to take effect. 
Clients connected to the EIS application must stop and restart IE for the changes to take effect.

Using custom icons in network diagrams

You can customize the icons used to represent nodes in the network view. To do so, open the 
NetworkConfigResources.properties file, and change the following settings according to the 
parameters documented in the file:

### Default value for node image

DefaultNodeImage=/SmartOps/G3/images/icon-warehouse.gif

NodeImageAttribute=baz

### Comma separated list of all node image keys

### A node first looks for the key nodeType.nodeAttrValue then nodeType

###  Node types are PROCESS POINT, CUSTOMER NODE, VENDOR NODE and 
STOCKING POINT

###  Plus each of those with .GROUPED added

NodeImages=PROCESS POINT,CUSTOMER NODE,VENDOR NODE,STOCKING POINT
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### For each key above, add .icon and provide the image path

###  replacing spaces with _

PROCESS_POINT.icon=/SmartOps/G3/images/icon-factory.gif

VENDOR_NODE.icon=/SmartOps/G3/images/icon-retailer.gif

CUSTOMER_NODE.icon=/SmartOps/G3/images/icon-retailer.gif

STOCKING_POINT.icon=/SmartOps/G3/images/icon-warehouse.gif

Save and close the text file. Stop and restart the application server for your changes to take effect. 
Clients connected to the EIS application must stop and restart IE for the changes to take effect.

Specifying line style and color

You can customize the default color and style of the lines used to represent paths in the Network 
window. This can be useful for differentiating among transportation types, for example. To do so, 
open the NetworkConfigResources.properties file, and change the following settings according to 
the parameters documented in the file:

### Path color and line type configuration options
### Colors are a comma separated list of R,G,B values (0-255)
### Line types are one of
### LINE_DASH_DOT
### LINE_DASH_DOUBLE_DOT
### LINE_DASHED
### LINE_DOUBLE_DASHED
### LINE_LINE_TRIPLE_DOT
### LINE_LONG_DASH
### LINE_NORMAL

### Default values for path color and line type
DefaultPathColor = 75,75,75
DefaultPathLine = LINE_NORMAL

### Customize path color and line types by path attribute 
### using the example below and replacing with your own path
### attributes and values
PathLineAttribute = TRANSPORTATION SPEED
PathColorAttribute = TRANSPORTATION TYPE
### Comma separated list of the possible values for each key are 
listed here
PathLineValues = REGULAR, EXPEDITED, BUDGET
PathColorValues = GROUND, CARRIER
### Each value defines either the .color or .line property
REGULAR.line = LINE_NORMAL
EXPEDITED.line = LINE_DASH_DOT
BUDGET.line = LINE_DASHED
GROUND.color = 0,100,200
CARRIER.color = 200,100,0

Save and close the text file. Stop and restart the application server for your changes to take effect. 
Clients connected to the EIS application must stop and restart IE for the changes to take effect.
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Specifying the number of decimal places to display in network diagrams

You can specify the minimum and maximum number of decimal places to display for numerical data 
in the Network window. To do so, open the NetworkConfigResources.properties file, and change 
the *.minFrac and *.maxFrac settings, as desired. Save and close the text file. Stop and restart the 
application server for your changes to take effect. Clients connected to the EIS application must stop 
and restart IE for the changes to take effect.

Changing the Import History display
You can view a history of data sets imported into MIPO in the Import Data Set window. You can 
also edit the amount of information that is displayed in the associated Data History list. This list 
defaults to 50 records. 

You can change the default value by opening the ImportConfigResources.properties file and 
update the following setting:

history.results=50

Changing data editing settings
You can specify the minimum and maximum number of decimal places to display when viewing and 
editing data, and when creating nodes and paths. Also you can specify the number of rows to display. 
The windows that are affected by changing these settings can be accessed from the Edit menu in the 
MIPO module of the EIS application. 

Changing number of decimal places to display for data editing

To change decimal precision for data editing, open the DataManagementResources.properties file, 
and change the *.minFrac and *.maxFrac settings, as desired. Save and close the text file. Stop and 
restart the application server for your changes to take effect. Clients connected to the EIS application 
must stop and restart IE for the changes to take effect.

Changing number of rows to display for data editing

You can specify the rows to display for when viewing and editing data. The windows that are affected 
by changing these settings can be accessed from the Edit menu in the MIPO module. To change the 
number of rows, open the DataManagementResources.properties file, and change the 
bulk.page.size = 10 setting as desired. Save and close the text file. Stop and restart for your 
changes to take effect. Clients connected to the EIS application must stop and restart IE for the 
changes to take effect.
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Changing report settings
In MIPO, you can generate several different reports that display supply chain data in a table or chart 
format. You can change the following settings to customize the appearance of reports for your 
organization’s supply chain. 

Configuring automatic generation of published reports

You can configure MIPO to automatically generate all or a subset of published reports for a given 
loadset. The system generates report files and saves them automatically to a directory specified in the 
Manage Module Settings window under Published Reports. Once your PSS.dat file has been 
configured, auto-generation functionality will be available for all loadsets where a PSS.dat file is 
included. You can determine whether and how this feature is used by following the configuration 
instructions in this section. 

To configure automatic generation of published reports:

1. In a text editor, open the PSS.dat file for each loadset where you want to configure 
automatic report generation. 

2. In PSS.dat, search for the following parameter, which determines whether report auto-
generation is turned on:

ADD||GenerateReports|Is Active|true

3. To disable automatic generation for all published reports, set this parameter to false.

4. By default, all available published reports are listed in the Report Generation section of 
PSS.dat, as shown below. Remove the entire line containing the name of any report you 
do not want to auto-generate from this section. 

ADD||GenerateReports|ReportName|DataLoadError

ADD||GenerateReports|ReportName|ItemMaster

ADD||GenerateReports|ReportName|LocationMaster

ADD||GenerateReports|ReportName|SKUInputTimeVarying

ADD||GenerateReports|ReportName|StockingPointOutput

ADD||GenerateReports|ReportName|SKUInputOutputStatic

ADD||GenerateReports|ReportName|SupplyChainCostDetails

ADD||GenerateReports|ReportName|AggregatedTIP

5. Save and close the PSS.dat file.

6. Update and close the .zip archive and drop the loadset according to your normal 
workflow. 

Exporting and formatting reports

You can customize the number of pages that can be exported, and other settings for displaying reports 
in MIPO by modifying the following settings in the ReportConfigResources.properties file:
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max.pages.export=10

max.characters.row=40

max.characters.column=20

min.items.chart=1

min.columns.chart=1

max.columns.chart=255

max.items.page=20

max.items.page.excel=2000

Save and close the text file. Stop and restart the application server for your changes to take effect. 
Clients connected to the EIS application must stop and restart IE for the changes to take effect.

Specifying the number of decimal places to display in reports

You can specify the minimum and maximum number of decimal places to display for numerical data 
in reports. To do so, open the ReportsResources.properties file, and change the *.minFrac and 
*.maxFrac settings, as desired. Save and close the text file. Stop and restart the application server for 
your changes to take effect. Clients connected to the MIPO system must stop and restart the EIS 
application for the changes to take effect.

Enabling and disabling automatic loading of reports

You can set reports to load automatically or on command. By default, when you select a report in the 
Reports menu, you must select the Refresh button to generate the report. 

You can set a report to load on command only by changing the report’s .auto setting to False in the 
ReportConfigResources.properties file. With the .auto setting disabled, a Refresh button will 
appear in the report window; users must click on this button to generate the report. For example, if 
you want the Inventory Components Report to refresh manually, the entry in the 
ReportConfigResources.properties file would be:

ExtractionReport.auto=False

The auto fields of the reports are listed in the ReportConfigResources.properties file, as shown in 
the table below.

Note: Increasing the value of the max.items.page.excel parameter above the default 
setting can cause an Out of Memory error. Consider the limits of your environment 
when modifying this parameter.

Report name Auto field name

Forecast Demand Report ForcastDemand.auto

Stocking Point Static Inputs Report SPoint_StaticInput.auto
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Modifying the STAGE attribute

The STAGE attribute is a node attribute used to group stocking points into different levels in a supply 
chain in MIPO. It is the default method of displaying inventory quantities in the Master Summary and 

Stocking Point Time Varying Inputs Report (Single 
Node)

SPoint_Input1Node.auto

Stocking Point Time Varying Inputs Report (Single 
Period)

SPoint_Input1Period.auto

Stocking Point Time Varying Inputs Report (Single 
Property)

SPoint_Input1Property.auto

Supply Path Static Inputs Report SPath_StaticInput.auto

Supply Path Time Varying Inputs report (Single 
Path) 

SPath_TV_1Path.auto

Supply Path Time Varying Inputs report (Single 
Period) 

SPath_TV_1Period.auto

Supply Path Time Varying Inputs report (Single 
Property) 

SPath_TV_1Property.auto

Master Summary Report MasterSummary.auto

Inventory Summary Report InventorySummary.auto

Inventory Summary by Attribute Report InventorySummaryAttribute.auto

Inventory Detail by Item Report AggInv_bySKU.auto

Inventory Detail by Location Report AggInv_byLocation.auto

Inventory Detail by Attribute Report  AggInv_byAttribute.auto

Stocking Point Static Outputs Report SPoint_StaticOutput.auto

Stocking Point Time Varying Outputs Report (Single 
Node)

SPoint_Output1Node.auto

Stocking Point Time Varying Outputs Report (Single 
Period)

SPoint_Output1Period.auto

Stocking Point Time Varying Outputs Report (Single 
Property)

SPoint_Output1Property.auto

Replenishment Report Replenishment.auto

Inventory Components Report ExtractionReport.auto

Report name Auto field name
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Inventory Summary output reports. The number and names of stages in a supply chain are specific to 
your supply chain. The number of stages and their names are defined by your organization and must 
be created using the MIPO interface or uploaded from a .zip file, and are then assigned to each node 
as appropriate. 

For example, the stages in a supply chain could resemble the following:

• Suppliers

• Manufacturing 

• Assembly

• Dealers

For the Master Summary and Inventory Summary reports results to be meaningful and accurate, each 
stocking point in your supply chain must be assigned a STAGE attribute value. If a stocking point is 
not assigned a STAGE attribute value, the results for the Master Summary and Inventory Summary 
reports contain a column called “Unassigned.” The sum of relevant data for stocking points not 
associated with a STAGE is displayed under this heading.

Sorting STAGES

STAGE attribute values in MIPO are sorted alphabetically. To guarantee that stages are sorted 
according to the order that they occur in the supply chain, you must enter STAGE attribute values as 
names preceded by a two-digit number value. For example, for the following stages to be sorted 
according to the order they occur in a supply chain, they must be named as follows:

• 01 - Suppliers

• 02 - Manufacturing 

• 03 - Assembly

• 04 - Dealers

Using a Node Attribute other than STAGE

You can group stocking point inventories in the Master Summary and Inventory Summary reports 
using a node attribute other than the STAGE attribute. To do so, you must change the value of the 
following setting in the ReportConfigResources.properties file:

report.STAGE_ATTRIBUTE_NAME=STAGE

For example, if you wanted to group stocking points according to the node attribute “COUNTRY” 
the entry in the ReportConfigResources.properties file would be:

report.STAGE_ATTRIBUTE_NAME=COUNTRY

Note: A zero must precede a one-digit number for the stages to be ordered correctly. 
For example, if you use the numbers 1, 2, 10, 11, and 21 preceding the names of stages, 
they would be returned as 1, 10, 11, 2, and 2.
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In addition, you would need to create attribute values similar to the following, and assign them to each 
stocking point appropriately. Note that it’s not necessary to ensure that the names coincide with an 
particular order in the physical supply chain:

• United States

• Canada

• Mexico

• France

• Germany

• Brazil

Setting an environment label 
You can use the Manage Module Settings feature, located under the Settings menu, to access the 
Customer Support Settings module and define an environment label to differentiate between multiple 
EIS environments.

1. Log on to the EIS application.

2. Select Module Settings under the Settings menu.

3. Select Customer Support Settings from the dropdown list.

4. Locate the Environment Identification field and enter the specified label. 

5. When you are finished with your configuration, click OK.

If you decide not to implement the changes you made, click Cancel.

Changing export settings 
MIPO users can export optimized data sets to the application server via the Data Set > Export Data 
Set menu in the MIPO user interface. These files can then be imported into other applications, either 
manually or through an automated process.

You can use the Manage Module Settings feature, located under the Settings menu, to access the 
Export Data Set module and define your export configuration settings.

Note: The value of the report.STAGE_ATTRIBUTE_NAME setting is case-sensitive. An 
attribute named “COUNTRY” is a different attribute than one named “Country”. 
Ensure that you name and assign attributes consistently.
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Modifying the destination directory of exported data sets

You can specify the destination directory on the application server that contains exported data set .zip 
files by doing the following:

1. Log on to the EIS application.

2. Select Module Settings under the Settings menu.

3. Select Export Data Set from the dropdown list.

4. Locate the Export Data Set Target Directory field and enter the specified destination 
directory. 

5. When you are finished with your configuration, click OK.

If you decide not to implement the changes you made, click Cancel.

After you have made the desired changes, you must stop and restart the application server for your 
changes to take effect. Clients connected to the EIS application must stop and restart that application 
for the changes to take effect.

Changing published report settings 
MIPO users can generate published reports to the application server via the Reports menu in the 
MIPO user interface. These reports can then be imported into other applications, either manually or 
through an automated process.

For published reports, you can customize the following settings:

• Dstination directory that contains the exported files on the application server

• File formatting

• Header (column) names in the exported file

• Name of the exported file

• File extension of the exported file

• Name of the file displayed in the Published Reports window

You can use the Manage Module Settings feature, located under the Settings menu, to access the 
Published Reports module and define your published reports configuration settings.

Modifying the destination directory of published reports

You can specify the destination directory that contains published reports on the application server by 
doing the following:

1. Log on to the EIS application.

2. Select Module Settings under the Settings menu.

3. Select Published Reports from the dropdown list.
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4. Locate the Publisher Target Directory field and enter the specified destination 
directory. 

5. When you are finished with your configuration, click OK.

If you decide not to implement the changes you made, click Cancel.

After you have made the desired changes, you must stop and restart the application server for your 
changes to take effect. Clients connected to the EIS application must stop and restart that application 
for the changes to take effect.

Modifying file formatting

You can modify the formatting of published reports by doing the following:

1. Log on to the EIS application.

2. Select Module Settings under the Settings menu.

3. Select Published Reports from the dropdown list.

4. Locate the Report Format: Date Format field and enter your changes, if necessary. 

5. Locate the Report Format: Decimal Precision field and enter your changes, if 
necessary. 

6. Locate the Report Format: Field Separator field and enter your changes, if necessary. 

7. Locate the Report Format: MDF File Extension field and enter your changes, if 
necessary. 

8. Locate the Report Format: Suffix Format field and enter your changes, if necessary. 

9. Locate the Report Format: Suffix in GMT field and enter your changes, if necessary. 

10. When you are finished with your configuration, click OK.

If you decide not to implement the changes you made, click Cancel.

After you have made the desired changes, you must stop and restart the application server for your 
changes to take effect. Clients connected to the EIS application must stop and restart that application 
for the changes to take effect.

Modifying file extensions

By default, the file extensions for Interface files and MDFs are .txt and .csv, respectively. You can 
change these extensions by doing the following:

1. Log on to the EIS application.

2. Select Module Settings under the Settings menu.

3. Select Published Reports from the dropdown list.

4. Locate the Report Format: MDF File Extension field and enter a new file extension, if 
necessary. 
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5. Locate the Report Format: OBI File Extension field and enter a new file extension, if 
necessary. 

6. When you are finished with your configuration, click OK.

If you decide not to implement the changes you made, click Cancel.

After you have made the desired changes, you must stop and restart the application server for your 
changes to take effect. Clients connected to the EIS application must stop and restart that application 
for the changes to take effect.

Modifying exported file names

The names of the exported files are configurable. You can change them by doing the following:

1. Log on to the EIS application.

2. Select Module Settings under the Settings menu.

3. Select Published Reports from the dropdown list.

4. Locate the File Name: field for your specific report and enter a new file name. 

5. Repeat step 5 to rename the file name of any other published reports. 

6. When you are finished with your configuration, click OK.

If you decide not to implement the changes you made, click Cancel. 

After you have made the desired changes, you must stop and restart the application server for your 
changes to take effect. Clients connected to the EIS application must stop and restart that application 
for the changes to take effect.

Modifying column header names in exported files

You can change the column header names displayed in exported Published Reports by doing the 
following:

1. Log on to the EIS application.

2. Select Module Settings under the Settings menu.

3. Select Published Reports from the dropdown list.

4. Locate the Header Name: field for your specific report and enter a new column header 
name. 

Note: Changing a file name in the Manage Module Settings window only modifies 
the name of the exported file on the application server. 

If you change a file name in the Manage Module Settings window, you can modify the 
corresponding name in the PublishTextResources.properties file so the modified file 
name is also displayed in the Published Reports window. 
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5. Repeat step 4 to rename the column header name of any other published reports. 

6. When you are finished with your configuration, click OK.

If you decide not to implement the changes you made, click Cancel.

After you have made the desired changes, you must stop and restart the application server for your 
changes to take effect. Clients connected to the EIS application must stop and restart that application 
for the changes to take effect.

Modifying file names displayed in the user interface

You can change the name of the file displayed in the Published Reports window by modifying 
settings in the PublishTextResources.properties file, for example:

label.ItemMaster=Items - Master Data

After you have made the desired changes to the PublishTextResources.properties file, save and 
close it. Stop and restart the application server for your changes to take effect. Clients connected to 
the EIS application must stop and restart that application for the changes to take effect.

Changing scenario settings
Scenario settings are parameters that alter the way MIPO interprets data inputs and computes outputs. 
Two database tables in MIPO control scenario settings:

• SETTING_DEFINITION: Describes application-wide settings and default allowable 
values for scenarios.

• SCENARIO_SETTING: Describes an individual scenario’s settings. 

New scenarios can either be based on an existing scenario or created from scratch. If the scenario is 
created from scratch, it uses the default values from the SETTING_DEFINITION table. New 
scenarios based on existing scenarios inherit the existing settings in the SCENARIO_SETTINGS 
table. For both types of new scenario, users and software entities such as the data loader can then 
change scenario settings freely.

The parameters in these tables are identical. For each scenario, the SCENARIO_SETTINGS table is 
populated with values for all fields, even if the scenario will use the application-wide defaults. The 

Note: Changing a file name in the PublishTextResources.properties file only 
modifies the name of the file displayed in the Published Reports window in the user 
interface.

If you change a file name in the PublishTestResources.properties file, you can 
modify the corresponding name in the PublisherModule.properties file so the 
exported file on the application server uses the same file name that is displayed in the 
user interface.
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parameters in the SETTING_DEFINITION and SCENARIO_SETTINGS tables are described 
below:

Parameter Definition, defaults and constraints

ANALYSIS_HORIZON The analysis horizon is the number of periods beyond the 
start/base period (in other words, in the future) for which 
accurate results are desired. It is the amount of future data 
required to be reliable. MIPO computes this data and checks 
its reliability based on the characteristics and amount of input 
data. 

The analysis horizon cannot exceed the value for 
DATA_HORIZON.

Possible values: positive (non-zero) numbers

Default value: should be set by customer support depending 
on data requirements and characteristics.

INITIAL_IP_DATA_SOURCE Determines whether the ideal values for initializing the 
system should be inferred from past inventories and 
scheduled receipts across all sticking points and supply paths 
during the first period of computation, or if these values 
should be provided by the user.

Possible values: INFERRED and USER

Default value: should be set by customer support depending 
on data requirements and characteristics.

OUTPUT_STOCKING_POINTS_ONLY When this parameter is set to TRUE, the algorithms will 
output values for stocking points, but not for supply paths. 
For most installations, supply path values are negligible and 
can be ignored, allowing faster calculation times.

Possible values: TRUE and FALSE

Default value: TRUE (should not be changed without analysis 
and consultation).

DATA_HORIZON The number of periods of data available for optimization 
(computation) in MIPO. 

Possible values: Positive (non-zero) numbers

Default value: should be set by customer support depending 
on data requirements and characteristics.

Table 7-32: SETTING_DEFINITION and SCENARIO_SETTING parameters
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HISTORICAL_DATA_HORIZON The amount of historical data available for creating a timeline 
in MIPO. The initial value of the historical data horizon 
grows with time as more data becomes available for use in 
historical calculations.

Possible values: Non-negative numbers (zero or greater)

Default value: should be set by customer support depending 
on data requirements and characteristics.

LEAD_TIME_ERROR_MULTIPLIER The weight given to standard deviation of lead time during 
computation. 

Possible values: Non-negative number (zero or greater)

Default value: 1 (should not be changed without consulting 
SAP Support).

SERVICE_LEVEL_TIME Sets the service level time (out of stock or fill rate) used as 
input.

Possible values: OUT_OF_STOCK and FILLRATE

Default value: Determined on a per-client basis by customer 
support.

COMPUTATION_TYPE Should not be changed.

Default value: DEFAULT

BUSINESS_ALERTS_ON_INPUTS Severity of Business Alert which will stop MIPO processing.

Possible values: FATAL ERROR, ERROR, WARNING, 
INFORMATIONAL, NONE, DISABLED

Note: DISABLED skips that Business Alert step altogether.

Default value: ERROR.

BUSINESS_ALERTS_ON_OUTPUTS Severity of Business Alert which will stop MIPO processing.

Possible values: FATAL ERROR, ERROR, WARNING, 
INFORMATIONAL, NONE, DISABLED

Note: DISABLED skips that Business Alert step altogether.

Default value: ERROR.

Parameter Definition, defaults and constraints

Table 7-32: SETTING_DEFINITION and SCENARIO_SETTING parameters
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Changing scenario settings for a single data set 
The SSD.dat file can be used to override default scenario settings by passing values for a specific data 
set. An example of the SSD.dat file is given below:

SSD||SETTING_NAME|SETTING_VALUE

ADD||BUSINESS_ALERTS_ON_INPUTS|ERROR

ADD||BUSINESS_ALERTS_ON_OUTPUTS|ERROR

END_OF_SET|||

Set a Supply Chain ID in the SST.DAT file
You can set an optional user-defined supply chain ID in the SST.DAT file to link data in the flat file to 
data stored in persistent tables. 

This loadset setting is processed in the Data Gateway. However, the setting is not editable through 
MIPO or the SGLT. If a Supply Chain ID is not provided in SST. DAT file, the field is left null and 
data loading occurs as normal. The data in the file is not linked to the persistent tables.

To set a supply chain ID for a loadset:

1. Identify the loadset for which you want to set the supply chain ID.

2. Locate the file named sst.dat and open it in a text editor. 

3. Identify the header field named SST_SUPPLY_CHAIN_ID and its corresponding data 
field.

4. Modify the value as desired.

5. Save and close the .dat file. 

Update and close the .zip file.

Loading Persisted Forecast and Sales Data from 
Flat Files
You can create flat files that will load forecast and sales data into the EIS persistent tables once the flat 
files are placed into the Data Loader listener directory.

The STG_PERSISTENT_FORECAST table can be updated from data in the flat file 
PERSISTFORE.dat. The columns in the PERSISTFORE.dat file are the same as in the 
STG_PERSISTENT_FORECAST table, but the name are preceded by PERSISTFORE.

For example:

PERSISTFORE||PERSISTFORE_ID|PERSISTFORE_LOCATION_ID|PERSISTFORE_SHIP_TO|PERSISTF
ORE_REVISION_DATE|PERSISTFORE_PERIOD_DATE|PERSISTFORE_FORECAST_VALUE|PERSISTFORE
_SUPPLY_CHAIN_ID 
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The STG_PERSISTENT_SALES table can be updated from data in the flat file PERSISTSAL.dat 
The columns in the PERSISTSAL.dat file are the same as in the STG_PERSISTENT_SALES table, 
but the name are preceded by PERSISTSAL.

For example:

PERSISTSAL||PERSISTSAL_ITEM_ID|PERSISTSAL_LOCATION_ID|PERSISTSAL_SHIP_TO|PERSIST

SAL_PERIOD_DATE|PERSISTSAL_SALES_VALUE|PERSISTSAL_SUPPLY_CHAIN_ID 

Defining Gateway Connector library path
You can use the Manage Module Settings feature, located under the Settings menu, to define the 
library path used by the Gateway Connector when the external Java process is invoked through the 
EIS portal, via the Manage Data Gateway screen.

1. Log on to the EIS application.

2. Select Module Settings under the Settings menu.

3. Select Gateway Connector from the dropdown list.

4. Locate the Connector Application Library Path field and enter the library path. 

5. When you are finished with your configuration, click OK. If you decide not to implement 
the changes you made, click Cancel.

Transferring MIPO scenario data to Data Store

Perform the following steps to transfer a EIS scenario into the Data Store:

1. If necessary, click Portal > Data Store to open the Data Store module.

2. Click Data Set > Manage Data Store to open the Manage Data Store window.

Note: All of the fields are required in the .dat file, except the SHIP_TO field. Specially, 
the supply chain ID that must be a integer greater than or equal to zero. 

Note:  For customers using the Gateway Connector as part of their unattended ETL 
process, this setting can be left blank as the library path is defined in the 
runSAPConnector script.

 Note: The Data Store Management feature is a user privilege in the Portal. You can 
only transfer EIS scenarios into the Data Store if you have privileges to do so.
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3. Use the Product Module Selector to select the EIS application associated with the 
scenario.

4. Use the product-specific data set selector (e.g., Supply Chain or Model) to select the 
data set associated with the scenario.

5. Use the Scenario Selector to select the scenario you wish to transfer.

6. Click Transfer. The data associated with the scenario you selected is written into the 
Data Store.

Using the Auto Transfer Feature to Transfer to Data Store
The Auto Transfer feature allows EIS modules to automatically copy scenario data to the Data Store 
after the data set has been optimized or computed. The following EIS modules can use this feature:

• MIPO

• DIM

• SLO

This feature requires the following configurations:

1. A global setting to activate the feature

2. A scenario-specific setting to identify when the feature should be implemented

3. Scenario-specific settings identifying which data types should be transferred.

Global setting activation

The global setting Allow Data Store Transfer activates the Auto Transfer feature; it defaults to 
Enabled. This setting can be changed in the application by selecting Settings, then the Module 
Settings, then Data Store settings.

Scenario setting activation

The Scenario Settings screen provides access to a setting called Auto Transferable that defaults to 
No. Changing this setting to Yes ensures that each scenario data set gets automatically transferred to 
the Data Store. This setting can be changed using the Scenario Settings screen, under Data Store 
settings.

 Note: Once a scenario has been transferred to the Data Store, you cannot transfer the 
same scenario again. Instead, you must delete the existing scenario from the Data Store 
before transferring the same EIS scenario.
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Scenario-specific parameter configurations

Auto Transfer settings can also be configured globally through the Scenario Settings screen 
(Settings > Scenario Settings> Data Store); the Auto Transfer parameters are included with the 
corresponding modules.

The following data transfer options are available:

• Transfer Demand Processor Output data

• Transfer Forecast data

• Transfer Process point data (not available for DIM)

• Transfer Sales data

• Transfer Stocking point data

• Transfer Supply path data (not available for DIM)

You also have the option to edit a data set’s ssd.dat file to include these configuration parameters, or 
to override the global parameter settings defined under the Scenario Settings screen.

These settings can also be entered through the Scenario Settings tab in the SGLT, if you are using the 
SGLT.

A list of the parameter names and their associated values is provided below.

Business Alert settings
The Business Alerts feature lets you define validation rules to be used during MIPO’s exception 
management process. When MIPO validates input or output data against these customer-specific 

Parameter Setting Name Setting Values

DATA_STORE_AUTO_TRANSFERABLE YES, NO

DEMAND_PROCESSOR_TRANSFER YES, NO

FORECAST_TRANSFER YES, NO

PROCESS_POINT_TRANSFER YES, NO

SALES_TRANSFER YES, NO

STOCKING_POINT_TRANSFER ALL, INPUTS, OUTPUTS

SUPPLY_PATH_TRANSFER ALL, INPUTS, NO

Table 7-33  Data Store Scenario setting definitions
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business rule, it will generate an alert whenever it is determined that data exceeds the specified trigger 
value.

There are three parts of the Business Alerts feature that you can configure:

• What severity level must be reached before MIPO stops the validation and optimization 
process.

• How many individual alerts must be generated before MIPO can consolidate the infor-
mation into a summary alert

• The settings for specific business alerts

Changing settings in BusinessAlertsModule.properties
Using the EIS Manage Module Setting feature, you can set a threshold limit for how many individual 
alerts must be generated before MIPO can consolidate the information into a summary alert. 

You can change the consolidation threshold by doing the following:

1. Log on to the EIS application.

2. Select Module Settings under the Settings menu.

3. Select Business Alerts from the dropdown list.

4. Locate the Consolidation Threshold field and enter a new value. 

5. When you are finished with your configuration, click OK.

If you decide not to implement the changes you made, click Cancel.

After you have made the desired changes, you must stop and restart the application server for your 
changes to take effect. Clients connected to the EIS application must stop and restart that application 
for the changes to take effect.

Note: See the EIS Online Help for detailed information on setting global parameters for 
Business Alerts. 
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Changing settings in BAS.DAT
The BAS.DAT file lets you configure the business alerts for a specific data set to be used instead of 
the global parameters. The configuration settings for each individual alert and associated examples 
from the BAS.DAT file are given in the sections below.

Business Alert: Demand CV

This business alert is generated when the demand CV has exceeded the specified criteria, as defined by 
a percentage. 

An example of the BAS.DAT file is given below:

ADD||DEMAND_CV|active|false

ADD||DEMAND_CV|severity|ERROR

ADD||DEMAND_CV|params|pct

ADD||DEMAND_CV|pct|1.0

Note: If you do not identify a comparison scenario when using one of the comparison 
Business Alerts, a fatal error alert will be generated and the loadset will fail. When this 
alert occurs, the user can either delete the failed scenario, fix the incoming data set, and 
resubmit, or, disable the output business alerts on the Manage Scenarios screen and 
proceed.

Business Alert 
Name Business Alert Property Business Alert Value

DEMAND_CV Is Active true or false

DEMAND_CV Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

DEMAND_CV pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 7-34 Demand CV business alert
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Business Alert: Demand Mean comparison 

This business alert is generated when the forecast demand mean between scenarios has changed more 
than the specified criteria, as defined by a percentage. 

An example of the BAS.DAT file is given below:

ADD||DEMAND_MEAN_COMPARISON|active|false

ADD||DEMAND_MEAN_COMPARISON|severity|ERROR

ADD||DEMAND_MEAN_COMPARISON|params|pct

ADD||DEMAND_MEAN_COMPARISON|pct|1.0

By default, MIPO compares the data set being loaded to the parent scenario. You can specify a 
specific scenario you wish to use for comparison by editing the BAS.DAT file. An example of the text 
code to add to BAS.DAT is given below:

ADD||DEMAND_MEAN_COMPARISON|comparison_scenario_name|Example Supply 
Chain

Business Alert: Demand Standard Deviation comparison 

This business alert is generated when the forecast demand standard deviation between scenarios has 
changed more than the specified criteria, as defined by a percentage. 

Business Alert 
Name Business Alert Property Business Alert Value

DEMAND_MEAN_
COMPARISON

Is Active true or false

DEMAND_MEAN_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

DEMAND_MEAN_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 7-35 Demand Mean comparison business alert

Business Alert 
Name Business Alert Property Business Alert Value

DEMAND_STD_
COMPARISON

Is Active true or false

DEMAND_STD_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

Table 7-36 Demand Standard Deviation comparison business alert
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An example of the BAS.DAT file is given below:

ADD||DEMAND_STD_COMPARISON|active|false

ADD||DEMAND_STD_COMPARISON|severity|ERROR

ADD||DEMAND_STD_COMPARISON|params|pct

ADD||DEMAND_STD_COMPARISON|pct|1.0

By default, MIPO compares the data set being loaded to the parent scenario. You can specify a 
specific scenario you wish to use for comparison by editing the BAS.DAT file. An example of the text 
code to add to BAS.DAT is given below:

ADD||DEMAND_STD_COMPARISON|comparison_scenario_name|Example Supply 
Chain

Business Alert: Implied Service Level comparison (SPT)

This business alert is generated when the implied service level between scenarios from the Stocking 
Point TIP table has changed more than the specified criteria, as defined by a percentage.

An example of the BAS.DAT file is given below:

ADD||ISL_SPT_COMPARISON|active|false

ADD||ISL_SPT_COMPARISON|severity|ERROR

ADD||ISL_SPT_COMPARISON|params|pct

ADD||ISL_SPT_COMPARISON|pct|1.0

DEMAND_STD_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Business Alert 
Name Business Alert Property Business Alert Value

ISL_SPT_
COMPARISON

Is Active true or false

ISL_SPT_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

ISL_SPT_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 7-37 Implied Service Level comparison (SPT) business alert

Business Alert 
Name Business Alert Property Business Alert Value

Table 7-36 Demand Standard Deviation comparison business alert
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By default, MIPO compares the data set being loaded to the parent scenario. You can specify a 
specific scenario you wish to use for comparison by editing the BAS.DAT file. An example of the text 
code to add to BAS.DAT is given below:

ADD||ISL_SPT_COMPARISON|comparison_scenario_name|Example Supply Chain

Business Alert: Lead time CV (PRF)

This business alert is generated when the lead time CV from the Process Resource Forecast table has 
exceeded the specified criteria, as defined by a percentage. 

An example of the BAS.DAT file is given below:

ADD||LT_CV_PRF|active|false

ADD||LT_CV_PRF|severity|ERROR

ADD||LT_CV_PRF|params|pct

ADD||LT_CV_PRF|pct|1.0

Business Alert: Lead time CV (SPF)

This business alert is generated when the lead time CV from the Supply Path Forecast table has 
exceeded the specified criteria, as defined by a percentage. 

Business Alert 
Name Business Alert Property Business Alert Value

LT_CV_PRF Is Active true or false

LT_CV_PRF Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

LT_CV_PRF pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 7-38 Lead Time CV (PRF) business alert

Business Alert 
Name Business Alert Property Business Alert Value

LT_CV_SPF Is Active true or false

LT_CV_SPF Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

Table 7-39 Lead time CV (SPF) business alert
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An example of the BAS.DAT file is given below:

ADD||LT_CV_SPF|active|false

ADD||LT_CV_SPF|severity|ERROR

ADD||LT_CV_SPF|params|pct

ADD||LT_CV_SPF|pct|1.0

Business Alert: Lead Time Mean comparison (PRF)

This business alert is generated when the lead time mean between scenarios from the Process 
Resource Forecast table has exceeded the specified criteria, as defined by a percentage. 

An example of the BAS.DAT file is given below:

ADD||LT_MEAN_PRF_COMPARISON|active|false

ADD||LT_MEAN_PRF_COMPARISON|severity|ERROR

ADD||LT_MEAN_PRF_COMPARISON|params|pct

ADD||LT_MEAN_PRF_COMPARISON|pct|1.0

By default, MIPO compares the data set being loaded to the parent scenario. You can specify a 
specific scenario you wish to use for comparison by editing the BAS.DAT file. An example of the text 
code to add to BAS.DAT is given below:

ADD||LT_MEAN_PRF_COMPARISON|comparison_scenario_name|Example Supply 
Chain

LT_CV_SPF pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Business Alert 
Name Business Alert Property Business Alert Value

LT_MEAN_PRF_
COMPARISON

Is Active true or false

LT_MEAN_PRF_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

LT_MEAN_PRF_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 7-40 Lead Time Mean comparison (PRF) business alert

Business Alert 
Name Business Alert Property Business Alert Value

Table 7-39 Lead time CV (SPF) business alert
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Business Alert: Lead Time Mean comparison (SPF)

This business alert is generated when the lead time mean between scenarios from the Supply Path 
Forecast table has changed more than the specified criteria, as defined by a percentage. 

An example of the BAS.DAT file is given below:

ADD||LT_MEAN_SPF_COMPARISON|active|false

ADD||LT_MEAN_SPF_COMPARISON|severity|ERROR

ADD||LT_MEAN_SPF_COMPARISON|params|pct

ADD||LT_MEAN_SPF_COMPARISON|pct|1.0

By default, MIPO compares the data set being loaded to the parent scenario. You can specify a 
specific scenario you wish to use for comparison by editing the BAS.DAT file. An example of the text 
code to add to BAS.DAT is given below:

ADD||LT_MEAN_SPF_COMPARISON|comparison_scenario_name|Example Supply 
Chain

Business Alert: Lead Time Standard Deviation comparison (PRF)

This business alert is generated when the lead time standard deviation between scenarios from the 
Process Resource Forecast table has changed more than the specified criteria, as defined by a 
percentage. 

Business Alert 
Name Business Alert Property Business Alert Value

LT_MEAN_SPF_
COMPARISON

Is Active true or false

LT_MEAN_SPF_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

LT_MEAN_SPF_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 7-41 Lead Time Mean comparison (SPF) business alert

Business Alert 
Name Business Alert Property Business Alert Value

LT_STD_PRF_
COMPARISON

Is Active true or false

Table 7-42 Lead Time Standard Deviation comparison (PRF) business alert
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An example of the BAS.DAT file is given below:

ADD||LT_STD_PRF_COMPARISON|active|false

ADD||LT_STD_PRF_COMPARISON|severity|ERROR

ADD||LT_STD_PRF_COMPARISON|params|pct

ADD||LT_STD_PRF_COMPARISON|pct|1.0

By default, MIPO compares the data set being loaded to the parent scenario. You can specify a 
specific scenario you wish to use for comparison by editing the BAS.DAT file. An example of the text 
code to add to BAS.DAT is given below:

ADD||LT_STD_PRF_COMPARISON|comparison_scenario_name|Example Supply 
Chain

Business Alert: Lead Time Standard Deviation comparison (SPF)

This business alert is generated when the lead time standard deviation between scenarios from the 
Supply Path Forecast table has changed more than the specified criteria, as defined by a percentage. 

An example of the BAS.DAT file is given below:

ADD||LT_STD_SPF_COMPARISON|active|false

ADD||LT_STD_SPF_COMPARISON|severity|ERROR

LT_STD_PRF_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

LT_STD_PRF_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Business Alert 
Name Business Alert Property Business Alert Value

LT_STD_SPF_
COMPARISON

Is Active true or false

LT_STD_SPF_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

LT_STD_SPF_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 7-43 Lead Time Standard Deviation comparison (SPF) business alert

Business Alert 
Name Business Alert Property Business Alert Value

Table 7-42 Lead Time Standard Deviation comparison (PRF) business alert
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ADD||LT_STD_SPF_COMPARISON|params|pct

ADD||LT_STD_SPF_COMPARISON|pct|1.0

By default, MIPO compares the data set being loaded to the parent scenario. You can specify a 
specific scenario you wish to use for comparison by editing the BAS.DAT file. An example of the text 
code to add to BAS.DAT is given below:

ADD||LT_STD_SPF_COMPARISON|comparison_scenario_name|Example Supply 
Chain

Business Alert: On hand safety stock in periods comparison (SPT)

This business alert is generated when the on hand safety stock between scenarios from the Stocking 
Point TIP table has changed more than the specified criteria, as defined by a percentage. 

Business Alert 
Name Business Alert Property Business Alert Value

OHSP_SPT_
COMPARISON

Is Active true or false

OHSP_SPT_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

OHSP_SPT_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 7-44 On hand stock comparison (SPT) business alert
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An example of the BAS.DAT file is given below:

ADD||OHSP_SPT_COMPARISON|active|false

ADD||OHSP_SPT_COMPARISON|severity|ERROR

ADD||OHSP_SPT_COMPARISON|params|pct

ADD||OHSP_SPT_COMPARISON|pct|1.0

By default, MIPO compares the data set being loaded to the parent scenario. You can specify a 
specific scenario you wish to use for comparison by editing the BAS.DAT file. An example of the text 
code to add to BAS.DAT is given below:

ADD||OHSP_SPT_COMPARISON|comparison_scenario_name|Example Supply Chain

Business Alert: On hand stock comparison (SPT)

This business alert is generated when the on hand stock between scenarios from the Stocking Point 
TIP table has changed more than the specified criteria, as defined by a percentage. 

An example of the BAS.DAT file is given below:

ADD||OHS_SPT_COMPARISON|active|false

ADD||OHS_SPT_COMPARISON|severity|ERROR

ADD||OHS_SPT_COMPARISON|params|pct

ADD||OHS_SPT_COMPARISON|pct|1.0

By default, MIPO compares the data set being loaded to the parent scenario. You can specify a 
specific scenario you wish to use for comparison by editing the BAS.DAT file. An example of the text 
code to add to BAS.DAT is given below:

ADD||OHS_SPT_COMPARISON|comparison_scenario_name|Example Supply Chain

Business Alert 
Name Business Alert Property Business Alert Value

OHS_SPT_
COMPARISON

Is Active true or false

OHS_SPT_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

OHS_SPT_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 7-45 On hand stock comparison (SPT) business alert
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Business Alert: Supply ratio comparison (SPF)

 This business alert is generated when the supply ratio between scenarios from the Supply Path 
Forecast table has changed more than the specified criteria, as defined by a percentage.

An example of the BAS.DAT file is given below:

ADD||RATIO_SPF_COMPARISON|active|false

ADD||RATIO_SPF_COMPARISON|severity|ERROR

ADD||RATIO_SPF_COMPARISON|params|pct

ADD||RATIO_SPF_COMPARISON|pct|1.0

By default, MIPO compares the data set being loaded to the parent scenario. You can specify a 
specific scenario you wish to use for comparison by editing the BAS.DAT file. An example of the text 
code to add to BAS.DAT is given below:

ADD||RATIO_SPF_COMPARISON|comparison_scenario_name|Example Supply 
Chain

Business Alert: Safety Stock in periods comparison 

This business alert is generated when the safety stock in periods between scenarios from the Stocking 
Point TIP table has changed more than the specified criteria, as defined by a percentage. 

Business Alert 
Name Business Alert Property Business Alert Value

RATIO_SPF_
COMPARISON

Is Active true or false

RATIO_SPF_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

RATIO_SPF_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 7-46 Supply ratio comparison (SPF) business alert

Business Alert 
Name Business Alert Property Business Alert Value

SSP_SPT_
COMPARISON

Is Active true or false

SSP_SPT_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

Table 7-47 Safety stock in periods comparison business alert
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An example of the BAS.DAT file is given below:

ADD||SSP_SPT_COMPARISON|active|false

ADD||SSP_SPT_COMPARISON|severity|ERROR

ADD||SSP_SPT_COMPARISON|params|pct

ADD||SSP_SPT_COMPARISON|pct|1.0

By default, MIPO compares the data set being loaded to the parent scenario. You can specify a 
specific scenario you wish to use for comparison by editing the BAS.DAT file. An example of the text 
code to add to BAS.DAT is given below:

ADD||SSP_SPT_COMPARISON|comparison_scenario_name|Example Supply Chain

Business Alert: Safety Stock comparison 

This business alert is generated when the safety stock between scenarios from the Stocking Point TIP 
table has changed more than the specified criteria, as defined by a percentage. 

An example of the BAS.DAT file is given below:

ADD||SS_SPT_COMPARISON|active|false

ADD||SS_SPT_COMPARISON|severity|ERROR

ADD||SS_SPT_COMPARISON|params|pct

ADD||SS_SPT_COMPARISON|pct|1.0

SSP_SPT_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Business Alert 
Name Business Alert Property Business Alert Value

SS_SPT_
COMPARISON

Is Active true or false

SS_SPT_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

SS_SPT_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 7-48 Safety stock in periods comparison business alert

Business Alert 
Name Business Alert Property Business Alert Value

Table 7-47 Safety stock in periods comparison business alert
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By default, MIPO compares the data set being loaded to the parent scenario. You can specify a 
specific scenario you wish to use for comparison by editing the BAS.DAT file. An example of the text 
code to add to BAS.DAT is given below:

ADD||SS_SPT_COMPARISON|comparison_scenario_name|Example Supply Chain

Business Alert: TIP comparison 

This business alert is generated when the TIP between scenarios from the Stocking Point TIP table 
has changed more than the specified criteria, as defined by a percentage. 

An example of the BAS.DAT file is given below:

ADD||TIP_SPT_COMPARISON|active|false

ADD||TIP_SPT_COMPARISON|severity|ERROR

ADD||TIP_SPT_COMPARISON|params|pct

ADD||TIP_SPT_COMPARISON|pct|1.0

By default, MIPO compares the data set being loaded to the parent scenario. You can specify a 
specific scenario you wish to use for comparison by editing the BAS.DAT file. An example of the text 
code to add to BAS.DAT is given below:

ADD||TIP_SPT_COMPARISON|comparison_scenario_name|Example Supply Chain

Business Alert 
Name Business Alert Property Business Alert Value

TIP_SPT_
COMPARISON

Is Active true or false

TIP_SPT_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

TIP_SPT_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 7-49 Safety stock comparison business alert
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Chapter 8:
Maintaining EIS

his section provides instructions for maintaining your EIS application. It describes how to: 

• Delete EIS log files

• Delete published reports

• Delete archived and rejected data sets

• Database backup

• Delete supply chains and scenarios

• View logs and alerts

• Encrypt updated database administration account passwords

Deleting EIS log files
It is recommended that you delete EIS log files from the application server machine every week. 
Application log files can consume about 2 MB of disk space per day of use. 

The EIS application has an automatic log file deletion feature that can be configured through the 
Customer Service module on the Manage Module Settings screen. Use this feature to set the length 
of time between deleting log files. The default is set for every 15 days.

T
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Deleting published reports
EIS users can export published reports (also called flat files, model data files, and interface files) to the 
application server via the user interface. You should periodically delete outdated and unused files and 
subdirectories from the export directory on the application server.

When a published report is exported, a subdirectory using either the Supply Chain Name or the 
Scenario Name is automatically created to contain the exported file. The destination directory that 
contains the exported files on the application server is specified by the Publisher Target Directory 
field in the Published Reports module of the Manage Module Settings feature.

To delete interface files and published report files from your EIS application server, navigate to the /
publications directory under the EIS home directory in your installation and follow standard 
procedures for your OS to delete files based on your corporate IT policy. 

Deleting archived and rejected data sets
Archived and rejected data sets can be deleted from the database server on a nightly to weekly basis. 
Depending on the size of your data sets, these files can consume a considerable amount of disk space. 

To delete archived and rejected data sets stored on the database server

1. Log in to the database server as root or the dlasm user.

2. From a UNIX command prompt, navigate to the directory specified by the 
smartops.dataloader.application.archive_directory and 
smartops.dataloader.application.rejected_directory parameters in the 
smartops.properties file (for example, $ORACLE_BASE/admin/$ORACLE_SID
/dloader/oracle_archive).

3. Enter the following command:

# find archive rejected -ctime 2 -type f | xargs rm; rmdir archive/* 
rejected/* >/dev/null

You can modify this command to keep files a greater or fewer number of days by 
modifying the flag for the -ctime argument. 

Note: Use the Manage Module Setting feature to disable the saving of archived and 
rejected data sets. From the main menu, click Settings > Module Settings. The 
associated configuration parameters can be found by selecting Data Loader from the 
module dropdown list.

Note: You can schedule this command to run automatically on a 
regular basis using cron. 
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In addition, you can compress and tar the archived and rejected directories by entering the following 
command in the Bourne shell:

# for d in archive/*[0-9] rejected/*[0-9]; do tar cf $d.tar $d && rm -rf $d; gzip 
$d.tar; done

You can also schedule this command to be run automatically on a regular basis using cron.

Backing up and restoring database schemas
It is recommended that you to back up the EIS database schemas, based on your IT policy on 
database backups. The following database schemas should be included in your routine backup 
procedure:

• MIPO

• Data Loader (DLASM)

• Data Store (if licensed for the application)

• Data Gateway (if licensed for the application)

Please note that the application server must be turned off prior to running a backup procedure of the 
database schemas.

In event of database failure, you’ll restore the database from the last backup. Use the restore procedure 
defined by your IT policy to restore the database schemas.

Deleting supply chains and scenarios
You can create and analyze multiple supply chains in MIPO. Each supply chain is associated with a 
base scenario that is protected (read-only) and any number of user scenarios. The base scenario contains 
live data, based upon which a client executes their actual supply chain. A user scenario contains “what-
if ” or edited data, which can be used to test hypotheses or validate input parameters. A user scenario 
can be created based upon an existing base scenario (its “parent”) or independent of any other 
scenario. 

A base scenario can change over time. For example, a user scenario can be upgraded to the base 
scenario. When a base scenario is modified, it is first archived before changes are applied to it. The 
archived base scenario is referred to as a historical scenario. A historical scenario remains associated with 
its supply chain even after it has been replaced by a different base scenario. 

You can envision base, user, and historical scenarios associated with a supply chain as follows:
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Deleting supply chains and scenarios in MIPO involves two main tasks:

• Marking the supply chain or scenario for deletion, which prevents it from being displayed 
or referenced in the MIPO interface

• Deleting the supply chain or scenario from the database, which permanently removes it 
and all references to it from the database

Note: Deletion of data from the MIPO database instance should be done by an on-site 
database administrator (DBA) or IT professional familiar with issues related to the 
permanent removal of large amounts of data.

Supply Chain
(Base scenario)

Historical 
scenario 4

Historical 
scenario 3

Historical 
scenario 2

Historical 
scenario 1

User 
scenario 1

User 
scenario 3

User 
scenario 4

User 
scenario 2
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Marking supply chains and scenarios for deletion
Users who have appropriate Scenario Access Control privileges have access to a “Delete” command 
for supply chains and scenarios in the Analyze menu in MIPO. “Deleting” a supply chain or scenario 
in this manner merely hides them in the interface; the actual data is not removed from the database.

Mark for deletion through the MIPO user interface

To mark a scenario for deletion through the MIPO user interface:

1. Log on to the MIPO module through the EIS portal.

2. Use the Supply Chain Selector to select the supply chain containing the base, historical, 
or user scenario you want to delete.

3. If you want to delete a user scenario, use the Scenario Selector to select it.

4. Click Analyze > Manage Scenarios to open the Manage Scenarios window.

5. Choose one of the following deletion options:

• If you have selected a base scenario, click TASKS > Delete Supply Chain or 
TASKS > Delete Historical Scenario.

• If you have selected a user scenario, click TASKS > Delete Scenario.

6. A confirmation dialog opens and prompts you to confirm the deletion. 

7. Click OK to delete the supply chain or scenario. The Manage Scenarios window is 
reloaded and it displays a status message indicating that the supply chain or scenario has 
been deleted.

8. Alternatively, you can delete multiple supply chains, user scenarios, and historical 
scenarios at one time by using the Delete Scenarios screen available under the Analyze 
menu. Access to this screen is a privileged feature.

Note: The ability to delete supply chains (base scenarios), historical scenarios, and user 
scenarios are user privileges in MIPO. If you are not authorized to delete supply chains 
and scenarios, the TASKS > Delete menu items are disabled.

Note: Processes invoked when you delete a supply chain or 
scenario can take some time to execute. During this time, you can 
continue using the EIS application. To determine the status of a 
scenario-related process, click Analyze > Manage Scenarios to 
open the Manage Scenarios window. Then click REFRESH to 
view the Scenario Status.
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Mark for deletion through SQL script

Database administrators can mark scenario data for deletion by running a SQL script called 
mark_for_delete.sql. The script can be configured to run as part of an automated maintenance 
process or it can be run manually at any time.

To use the mark for delete script, you must configure the parameter settings associated with the 
scenario names. To edit the sql script:

1. Copy the Database\utilities directory from the EIS installation media to the server 
where the SQL*Plus application runs. Navigate to the mark_for_delete.sql file in this 
directory

2. Using a text editor, open the mark_for_delete.sql script. You can edit the following 
settings in the script:

• DELETE_SCENARIO_STR_1: The name of the scenario to flag; this parameter 
can also include the % wildcard to mark multiple scenarios for deletion.

• DELETE_SCENARIO_STR_2: The name of the scenario to flag; this parameter 
can also include the % wildcard to mark multiple scenarios for deletion.

• DELETE_DAYS: Only scenarios older than the number of days specified will be 
flagged for deletion.

• DELETE_DATASTORE: Set to 1 to flag the corresponding MIPO scenario data in 
the Data Store; set to 0 to leave Data Store scenarios alone.

• DELETE_GATEWAY: Set to 1 to flag the corresponding MIPO scenario data in 
the Data Gateway; set to 0 to leave Data Gateway scenarios alone.

Example 1:

To flag a scenario named ‘Test Exercise 1’ and any scenario with the word ‘Example’ in it regardless of 
how old AND flag the corresponding scenario data in the Data Gateway and Data Store:

Set DELETE_SCENARIO_STR_1 =’Test Exercise 1’ 

Set DELETE_SCENARIO_STR_2 =’%Example%’

Set DELETE_DAYS=’0’

Set DELETE_DATASTORE=’1’

Set DELETE_GATEWAY=’1’

Note: It is not necessary to use both STR variables. When deleting 
single scenarios only, it is recommended to set STR_2 to a string 
that doesn’t match anything (e.g., FISH).
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Example 2: 

To flag all scenarios with the words ‘New Product’ that are at least 14 days old from MIPO only:

Set DELETE_SCENARIO_STR_1=’%New Product%’ 

Set DELETE_SCENARIO_STR_2=’FISH’

Set DELETE_DAYS=’14’

Set DELETE_DATASTORE=’0’

Set DELETE_DATAGATEWAY=’0’

Example 3:

To flag all scenarios older than 30 days from MIPO, Data Store and Data Gateway:

Set DELETE_SCENARIO_STR_1=’%’

Set DELETE_SCENARIO_STR_2=’FISH’

Set DELETE_DAYS=’30’

Set DELETE_DATASTORE=’1’

Set DELETE_GATEWAY=’1’

To run the script:

1. Log on with SQL*Plus as the MIPO schema owner (e.g. sops_mipo).

2. Execute the script mark_for_delete.sql.

Removing scenario data from EIS schemas
Removing scenario data marked for deletion requires running a SQL script that performs specific 
pruning functionality on the EIS database. This pruning script can be configured to run as part of an 
automated maintenance process on the database server.

Alternatively, an on-site DBA can manually execute the pruning script at any time in order to remove 
EIS data marked for deletion.

Note: You must run the mipo_pruning.sql script for each 
schema to permanently remove data flagged for deletion by the 
mark_for_delete.sql script.

Note: The EIS application server must be shut down when pruning data from the 
database. See your specific application server section for instructions on how to stop the 
EIS application from running on the application server.
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Deleting a scenario from the Data Store

Perform the following steps to delete a scenario from the Data Store:

1. If necessary, click Portal > Data Store to open the Data Store module.

2. Click Data Set > Manage Data Store to open the Manage Data Store window.

3. Use the Product Module Selector to select the EIS application associated with the 
scenario.

4. Under the Data Store Scenarios Available for Deletion heading, click the checkbox 
associated with the scenario you wish to remove from the Data Store.

5. Click Delete. The selected scenario is removed from the Data Store.

Deleting Gateway data
The Manage Data Gateway window lets you delete one or more data sets no longer being used.

Perform the following steps to delete a data set:

1. From the Manage Data Gateway window, look in the Data Gateway Queue History 
table to see the list of available data sets. 

2. Select the check box corresponding to each data set you wish to delete.

3. Click DELETE.

The Data Gateway deletes all selected data sets from the Data Gateway schema. 

When the procedure is complete the selected data sets are removed from the Data Gateway Queue 
History table.

Configuring EIS pruning
The basic EIS pruning process is as follows:

Step #1 – The EIS application MUST be shut down.

Step #2 – The pruning process must be executed.

Step #3 – The results of the pruning process must be evaluated. If the pruning process completes 
without error, the EIS application can be restarted. If the pruning process completes with an error, 
the EIS application should NOT be restarted and SAP Support should be contacted to help address 
the underlying problem.

 Note: The Data Store Management feature is a user privilege in the Portal. You can 
only delete scenarios from the Data Store if you have privileges to do so.
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mipo_pruning.sql configuration variables

To edit the MIPO pruning script:

1. Copy the Database\utilities directory from the EIS installation media onto the 
machine from which SQL*Plus will be run. Navigate to the mipo_pruning.sql file in 
this directory

2. Use a text editor to open the mipo_pruning.sql script. You can update the configuration 
settings for the following:

a. Logging destination: S for screen or F for file

The recommended value, set by default, is ‘S’ for screen. This will spool the results of the 
pruning process to the screen; should an error occur.

If you change this setting to ‘F’, note that the process will write the output to the /tmp 
directory. Note also that UTL_FILE_DIR will have to be set to /tmp in the MIPO 
INIT.ORA file for the appropriate instance.

b. Prune unused global data: N for No or Y for Yes

The default value is ‘N.’ Set to ‘Y’ to be able to prune unused global data (items, locations, 
attributes & values) that aren't in any existing scenario.

gateway_pruning.sql configuration variables

To edit the Data Gateway pruning script:

1. Copy the Database\utilities directory from the EIS installation media onto the 
machine from which SQL*Plus will be run. Navigate to the gateway_pruning.sql file in 
this directory

2. Use a text editor to open the gateway_pruning.sql script. You can update the 
configuration settings for the following:

a. Logging destination: S for screen or F for file

The recommended value, set by default, is ‘S’ for screen. This will spool the results of the 
pruning process to the screen; should an error occur.

If you change this setting to ‘F’, note that the process will write the output to the /tmp 
directory. Note also that UTL_FILE_DIR will have to be set to /tmp in the MIPO 
INIT.ORA file for the appropriate instance.

b. Prune unused global data: N for No or Y for Yes

The default value is ‘N.’ Set to ‘Y’ to be able to prune unused global data (items, locations, 
attributes & values) that aren't in any existing scenario.

datastore_pruning.sql configuration variables

To edit the Data Store pruning script:
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1. Copy the Database\utilities directory from the EIS installation media onto the machine 
from which SQL*Plus will be run. Navigate to the datastore_pruning.sql file in this 
directory

2. Use a text editor to open the datastore_pruning.sql script. You can update the 
configuration settings for the following:

a. Logging destination: S for screen or F for file

The recommended value, set by default, is ‘S’ for screen. This will spool the results of the 
pruning process to the screen; should an error occur.

If you change this setting to ‘F’, note that the process will write the output to the /tmp 
directory. Note also that UTL_FILE_DIR will have to be set to /tmp in the MIPO 
INIT.ORA file for the appropriate instance.

b. Prune unused global data: N for No or Y for Yes

The default value is ‘N.’ Set to ‘Y’ to be able to prune unused global data (items, locations, 
attributes & values) that aren't in any existing scenario.

Step 1: Shut down EIS

Before the pruning process can begin, the EIS application must be shut down. This is important as 
the pruning process alters the state of the database in order to run in a timely manner. Any scripting to 
automate this shutdown must be completed by the customer. The command to shut down the EIS 
application will vary by application server platform.

Step 2a: Run the pruning process (MIPO)

Once the EIS application has been shut down, the pruning process can be invoked manually:

1. Log into SQL*Plus as the MIPO schema owner (e.g., sops_mipo).

2. Execute the mipo_pruning.sql script.

Pruning of the database schema begins and can take several minutes to complete.

3. Verify that no errors occurred during the pruning by checking on screen or in the files 
located in the log directory. If the log files contain unknown errors, contact SAP Support.

The pruning process can also be automated via a script. A sample shell script built on a Solaris server 
appears below:

PATH=$PATH/etc:/usr/sbin:/usr/ucb:$HOME/bin:/usr/bin/X11:/sbin:.:/usr/
local/bin

export PATH

ORACLE_BASE=/u01/app/oracle9;export ORACLE_BASE

Note: If the pruning process fails, the information provided in the 
pruning failure messages can be reviewed for additional 
instructions.
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ORACLE_HOME=/u01/app/oracle9/product/9.2.0;export ORACLE_HOME

PATH=$PATH:$ORACLE_HOME/bin;export PATH

sqlplus sops_mipo/sops_mipo@sopsdb @mipo_pruning.sql

if [ $? -eq 0 ]

then

  echo "Pruning successful – restart MIPO"

else

  echo "Pruning failed – contact SAP SUPPORT"

fi

The following items should be noted:

• This script will need to be modified to match your database server environment. The syn-
tax may vary by operating system, local settings, and EIS implementation settings.

• All text in bold needs to be altered to match the applicable information for the underly-
ing database server, MIPO schema and/or instance, and mipo_pruning.sql script (see 
below for more information).

• The “if/then/else” section will need to be modified to execute the appropriate com-
mands required by the customer.

• A common command in the “then” section, indicating that pruning has completed suc-
cessfully without error, is the automated restart of the EIS application.

• If the EIS application and database are running on two different servers, the automated 
restarting of the EIS application from the database server may be more difficult. If this is 
something that can not easily be done, a common workaround is to install the Oracle cli-
ent on the application server and simply script all actions on the application server.

• A common command in the “else” section is the generation of an e-mail/alert to the 
appropriate personnel who should contact SAP Support. Please note that the EIS appli-
cation should NOT be restarted until the pruning error is resolved. If the EIS application 
is restarted before error resolution, the outputs of the pruning process will be required – 
see the section above for more information on configuring the destination of pruning log 
messages.

If there are any questions around this script which can be used to invoke automated pruning, contact 
SAP Support.

Step 2b: Run the pruning process (Data Gateway)

Once the EIS application has been shut down the pruning process can be invoked manually:

1. Log into SQL*Plus as the Data Gateway schema owner (e.g., sops_gateway).

2. Execute the gateway_pruning.sql script.

Pruning of the database schema begins and can take several minutes to complete.
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3. Verify that no errors occurred during the pruning by checking on screen or in the files 
located in the log directory. If the log files contain unknown errors, contact SAP support.

The pruning process can also be automated via a script. A sample shell script built on a Solaris server 
appears below:

PATH=$PATH/etc:/usr/sbin:/usr/ucb:$HOME/bin:/usr/bin/X11:/sbin:.:/usr/
local/bin

export PATH

ORACLE_BASE=/u01/app/oracle9;export ORACLE_BASE

ORACLE_HOME=/u01/app/oracle9/product/9.2.0;export ORACLE_HOME

PATH=$PATH:$ORACLE_HOME/bin;export PATH

sqlplus sops_gateway/sops_gateway@sopsdb @gateway_pruning.sql

if [ $? -eq 0 ]

then

  echo "Pruning successful – restart MIPO"

else

  echo "Pruning failed – contact SAP Support"

fi

The following items should be noted:

• This script will need to be modified to match your database server environment. The syn-
tax may vary by operating system, local settings, and EIS implementation settings.

• All text in bold needs to be altered to match the applicable information for the underly-
ing database server, Data Gateway schema and/or instance, and gateway_pruning.sql 
script (see below for more information).

• The “if/then/else” section will need to be modified to execute the appropriate com-
mands required by the customer.

• A common command in the “then” section, indicating that pruning has completed suc-
cessfully without error, is the automated restart of the EIS application.

• If the EIS application and database are running on two different servers, the automated 
restarting of the EIS application from the database server may be more difficult. If this is 
something that can not easily be done, a common workaround is to install the Oracle cli-
ent on the application server and simply script all actions on the application server.

• A common command in the “else” section is the generation of an e-mail/alert to the 
appropriate personnel who should contact SAP Support. Please note that the EIS appli-
cation should NOT be restarted until the pruning error is resolved. If the EIS application 
is restarted before error resolution, the outputs of the pruning process will be required – 

Note: If the pruning process fails, the information provided in the 
pruning failure messages can be reviewed for additional 
instructions.
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see the section above for more information on configuring the destination of pruning log 
messages.

If there are any questions around this script which can be used to invoke automated pruning, contact 
SAP Support.

Step 2c: Run the pruning process (Data Store)

Once the EIS application has been shut down the pruning process can be invoked manually:

1. Log into SQL*Plus as the Data Store schema owner (e.g., sops_datastore).

2. Execute the datastore_pruning.sql script.

Pruning of the database schema begins and can take several minutes to complete.

3. Verify that no errors occurred during the pruning by checking on screen or in the files 
located in the log directory. If the log files contain unknown errors, contact SAP Support.

The pruning process can also be automated via a script. A sample shell script built on a Solaris server 
appears below:

PATH=$PATH/etc:/usr/sbin:/usr/ucb:$HOME/bin:/usr/bin/X11:/sbin:.:/usr/
local/bin

export PATH

ORACLE_BASE=/u01/app/oracle9;export ORACLE_BASE

ORACLE_HOME=/u01/app/oracle9/product/9.2.0;export ORACLE_HOME

PATH=$PATH:$ORACLE_HOME/bin;export PATH

sqlplus sops_datastore/sops_datastore@sopsdb @datastore_pruning.sql

if [ $? -eq 0 ]

then

  echo "Pruning successful – restart MIPO"

else

  echo "Pruning failed – contact SAP Support"

fi

The following items should be noted:

• This script will need to be modified to match your database server environment. The syn-
tax may vary by operating system, local settings, and EIS implementation settings.

• All text in bold needs to be altered to match the applicable information for the underly-
ing database server, Data Store schema and/or instance, and datastore_pruning.sql script 
(see below for more information).

Note: If the pruning process fails, the information provided in the 
pruning failure messages can be reviewed for additional 
instructions.
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• The “if/then/else” section will need to be modified to execute the appropriate com-
mands required by the customer.

• A common command in the “then” section, indicating that pruning has completed suc-
cessfully without error, is the automated restart of the EIS application.

• If the EIS application and database are running on two different servers, the automated 
restarting of the EIS application from the database server may be more difficult. If this is 
something that can not easily be done, a common workaround is to install the Oracle cli-
ent on the application server and simply script all actions on the application server.

• A common command in the “else” section is the generation of an e-mail/alert to the 
appropriate personnel who should contact SAP Support. Please note that the EIS appli-
cation should NOT be restarted until the pruning error is resolved. If the EIS application 
is restarted before error resolution, the outputs of the pruning process will be required – 
see the section above for more information on configuring the destination of pruning log 
messages.

If there are any questions around this script which can be used to invoke automated pruning, contact 
SAP Support.

Step 3: Restart EIS

If the EIS application was not configured to automatically restart in the previous step (i.e., customized 
scripting in the “then” section of the automated shell script), then the EIS application must be 
restarted at this time. Note that the EIS application should NOT be restarted unless pruning has 
completed without error.

Viewing logs and alerts
The EIS Portal allows you to view log files and alerts associated with various EIS modules. For SAP 
NetWeaver application users, EIS informational and exception alerts can be viewed through the 
NetWeaver Administrator web application.

Viewing EIS application server log files
The Application Server Logs screen displays hyperlinks to log files stored on the EIS application 
server. Use this screen to download and view application server logs in a text editor on your local 
machine.

Along with logging application errors and events, the application server log tracks all module setting 
changes, including the original value and the changed value, along with which user account made the 
changes and a timestamp.

The application server log also includes user management activities, such as:

• User account creation
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• User account deletion

• User account log-on time

• User account log-off time

• User account password change

• User account User Settings change

• User account Locking

• User account UnLocking

To view application server logs:

1. Select Settings > Application Server Logs. The Application Server Logs screen will 
appear, showing a list of links to the most recent log files available on the EIS application 
server.

2. Click on the log file you want to view and open it in a text editor of your choice. 

Note: We recommend deleting application server log files on a weekly 
basis.

Note: For NetWeaver CE users, application server log files can also be 
accessed through the SAP System Administrator.
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Viewing EIS processor log files
The Processor Logs screen displays hyperlinks to log files stored on the EIS application server. Use 
this screen to download and view processor logs in a text editor on your local machine.

To view processor logs:

1. Select Settings > Processor Logs. The Processor Logs screen will appear, showing a 
list of links to the most recent log files available on the EIS application server.

2. Click on the log file you want to view and open it in a text editor of your choice. 

Viewing EIS application alerts
The Alerts window allows you to view and manage alerts generated by EIS modules. You can limit 
which alerts you view and manage by filtering them based on their Source, Class, Severity, Data 
Context, Status, Date, or any combination thereof. After you have filtered the alerts that you want to 
view, you can sort alerts displayed in the Alerts window.

See the EIS Online Help for detailed information on viewing and managing EIS application alerts.

Viewing EIS informational alerts in NetWeaver Administrator
The NetWeaver Administrator web application can be used to view and monitor EIS informational 
alerts through its Log Viewer feature.

To view informational alerts:

1. Select Netweaver Administrator > Availability and Performance Management > 
Resource Monitoring. The Resource Monitoring screen will appear.

2. Click Log View. You will see the Log Viewer: Overview screen.

3. Click the <Select View> dropdown list to select SAP Logs (Java). You will see a table 
displaying SAP Log information, including severity level, date and time, the specific log 
message, category, and location of the log file.

4. To display log information specific to EIS informational alerts, you can filter the SAP 
Log table by typing SmartOps in the field at the top of the Category column. You can 
also type com.smartops in the field at the top of the Location column.

5. Click any log record to see details for the selected log under Log Record Details.
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Viewing EIS exception alerts in NetWeaver Administrator
The NetWeaver Administrator web application can be used to view and monitor EIS exception alerts 
through its Log Viewer feature.

To view exception alerts:

1. Select Netweaver Administrator > Availability and Performance Management > 
Resource Monitoring. The Resource Monitoring screen will appear.

2. Click Log View. You will see the Log Viewer: Overview screen.

3. Click the <Select View> dropdown list to select Default Trace (Java). You will see a 
table displaying default trace information, including severity level, date and time, the 
specific trace message, category, and location of the trace file.

4. To display trace information specific to EIS exception alerts, you can filter the Default 
Trace table by typing SmartOps in the field at the top of the Category column. You can 
also type com.smartops in the field at the top of the Location column.

5. Click any trace record to see details for the selected trace under Trace Record Details.

Encrypting an updated database password
A parameter option is available for the EIS Installer application to generate an encrypted password. 
Use this option when changing the EIS Oracle administration account password in order to generate 
an encryption string of the new password. The new encryption string replaces the previous encrypted 
password used by the application server for connectivity with the Oracle database server.

The script used and steps for updating the password entry are dependent on the application server.
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Chapter 9:
Configuring DIM

his chapter describes the installation process and specific configuration items related to the Demand 
Intelligence Module. 

DIM Overview
The Demand Intelligence Module includes the Demand Intelligence Error processor, which 

runs during the preprocessing phase of MIPO optimization. This process requires RFS (historical and 
future forecasts) and TDD (historical sales) data in order to run correctly.

The Demand Intelligence Error processor determines and populates per period demand standard 
deviation by item-location-period at all customer facing stocking points (including those that contain 
insufficient demand data or no data at all) for periods in the MIPO data horizon.

DIM also includes the Demand Error Cleanup processor, which runs during the preloading phase of 
MIPO optimization. This processor cleans up the historical sales and historical and future forecasts 
that exist from a previous run for the current scenario only. This guarantees that the data used for the 
latest calculation will not be mixed with older data for the scenario.

DIM installation takes place during the MIPO installation process.

DIM configuration
After you have successfully installed MIPO, you can set up DIM and its associated processors.

T
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Activating and deactivating the Demand Intelligence Error 
processor
You can specify whether or not the Demand Intelligence Error processor is invoked for a particular 
loadset by changing a setting in the processor settings file, commonly named PSS.dat, which is 
contained in the loadset itself. By default, both processors are activated for each loadset that includes 
the PSS.dat file.

1. Identify and unzip the loadset where you want to change processor settings.

2. Locate the PSS.dat file and open it in a text editor.

3. In PSS.dat, find or add the set of parameters below:

      ADD||DemandErrorCleanup|Processing Phase|Preloading

      ADD||DemandErrorCleanup|Execution Order|1

      ADD||DemandErrorCleanup|Is Active|true

      ADD||DemandErrorIntelligenceProcessor|Is Active|true

      ADD||DemandIntelligenceErrorProcessor|Processing Phase|Preprocessing

      ADD||DemandIntelligenceErrorProcessor|Execution Order|2

4. To deactivate the Demand Intelligence Error processor, change the 
|DemandIntelligenceErrorProcessor|Is Active| setting above to false.

5. Likewise, to deactivate the Demand Error Cleanup processor, change the 
|DemandErrorCleanup|Is Active| setting above to false.

6. Save and close the .dat file.

7. Update and close the .zip archive.

Changing processor default parameter settings
The Demand Intelligence module, found in the Manage Module Settings feature, contains the 
Demand Intelligence Error processor’s default parameter settings. There are two ways to change these 
default settings: globally, for all loadsets, via the Manage Module Settings feature; or locally, for 

Note: The processor settings file for your organization can be named something other 
than PSS.dat. A processor settings file will always contain the text “PSS” in the first 
field of the header line. 
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individual loadsets, via PSS.dat files. Changes in the PSS.dat file override the settings in the Demand 
Intelligence module.

To configure Demand Intelligence Error processor properties on a per-loadset basis (in PSS.dat):

1. Identify and unzip the loadset where you want to change processor settings.

2. Locate the PSS.dat file and open it in a text editor. If PSS.dat has already been 
configured for the Demand Intelligence processor, the file will resemble the following:

PSS||PSS_PROCESSOR_NAME|PSS_PROPERTY|PSS_VALUE

ADD||DemandErrorCleanup|Processing Phase|Preloading

ADD||DemandErrorCleanup|Execution Order|1

ADD||DemandErrorCleanup|Is Active|true

ADD||DemandIntelligenceErrorProcessor|Is Active|true

ADD||DemandIntelligenceErrorProcessor|Processing Phase|Preprocessing

ADD||DemandIntelligenceErrorProcessor|Execution Order|2

ADD||DemandIntelligenceErrorProcessor|Demand_STD_CV_Computation|MAD

ADD||DemandIntelligenceErrorProcessor|Demand_STD_Historical_Data_Horizon|20

ADD||DemandIntelligenceErrorProcessor|Demand_STD_Raw_Data_Log|true

ADD||DemandIntelligenceErrorProcessor|Demand_STD_BiasAdjustment|AdjustAll

ADD||DemandIntelligenceErrorProcessor|Demand_STD_Exclude_Outliers|true

ADD||DemandIntelligenceErrorProcessor|Demand_STD_Outlier_Multiplier|3

ADD||DemandIntelligenceErrorProcessor|Demand_STD_Default_Demand_CV|1

ADD||DemandIntelligenceErrorProcessor|Demand_STD_CV_Cap|3

ADD||DemandIntelligenceErrorProcessor|Demand_STD_APE_Cap|2.4

ADD||DemandIntelligenceErrorProcessor|Demand_STD_APE_Default|0.8

END_OF_SET||||

The Demand Intelligence Error processor parameters, their possible values, and 
explanations of their behavior are listed below.

3. In PSS.dat, add or modify the properties associated with the Demand Intelligence Error 
processor and the Demand Cleanup processor. The parameters, their possible values, and 
explanations of their behavior are listed below.

4. Save and close the .dat file.

5. Update and close the .zip archive.

Note: The following processors are dependent on data generated by the Demand Node 
Creation processor: Demand Intelligence Error processor, Unit Cost Calculator, and 
New Item Processor. See the Processors Dependencies section in the EIS Processors 
Spreadsheet for information on the proper execution order when invoking these 
processors.
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Assigning automatic DIM Import processor settings
The DIM workflow design allows for specified data updates to MIPO to first be processed by DIM in 
order to compute DIM scenario outputs. The DIM Import processor can be invoked during the data 
loading process to automatically create a DIM scenario from MIPO data and generate demand 
outputs. This processor can be configured in the PSS.DAT file for the data set.To configure DIM 
Import processor properties on a per-loadset basis (in PSS.DAT):

1. Identify and unzip the loadset where you want to change processor settings.

2. Locate the PSS.dat file and open it in a text editor. If PSS.dat has already been 
configured for the DIM Import processor, the file will resemble the following:

PSS||PSS_PROCESSOR_NAME|PSS_PROPERTY|PSS_VALUE

ADD||DemandIntelligenceImportProcessor|Is Active|true

ADD||DemandIntelligenceImportProcessor|Processing Phase|Report 
Generation

ADD||DemandIntelligenceImportProcessor|Execution Order|1

ADD||DemandIntelligenceImportProcessor|IMPORT_TRANSITION|TRUE

ADD||DemandIntelligenceImportProcessor|TargetScenarioName|YourDIMModelN
ame

ADD||DemandIntelligenceImportProcessor|TargetScenarioDescription|YourDI
MModelDescription

END_OF_SET||||

3. In PSS.dat, add or modify the properties associated with the DIM Import processor. 

4. Save and close the PSS.DAT file.

5. Update and close the .zip archive.

Assigning automatic DIM Export processor settings
The DIM workflow design allows for specified data updates to MIPO to automatically include DIM 
scenario outputs as the demand inputs for MIPO optimization. The DIM Export processor can be 
invoked during the data loading process to automatically copy this data. This processor can be 
configured in the PSS.DAT file for the data set.To configure DIM Export processor properties on a 
per-loadset basis (in PSS.DAT):

1. Identify and unzip the loadset where you want to change processor settings.

2. Locate the PSS.dat file and open it in a text editor. If PSS.dat has already been 
configured for the DIM Export processor, the file will resemble the following:

Note: These settings can be entered through the Processor Settings tab in the SGLT.
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PSS||PSS_PROCESSOR_NAME|PSS_PROPERTY|PSS_VALUE

ADD||DemandIntelligenceExportProcessor|Is Active|true

ADD||DemandIntelligenceExportProcessor|Processing Phase|Preprocessing

ADD||DemandIntelligenceExportProcessor|Execution Order|2

END_OF_SET||||

3. In PSS.dat, add or modify the properties associated with the DIM Export processor. 

4. Save and close the PSS.DAT file.

5. Update and close the .zip archive.

Note: These settings can be entered through the Processor Settings tab in the SGLT.
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Assigning automatic MIPO scenario access settings
To configure a DIM scenario to automatically inherit the MIPO scenario access settings (in 
PSS.DAT):

1. Identify and unzip the loadset where you want to change processor settings.

2. Locate the PSS.dat file and open it in a text editor. If PSS.dat has already been 
configured for DIM, the file will resemble the following:

PSS||PSS_PROCESSOR_NAME|PSS_PROPERTY|PSS_VALUE

ADD||DemandIntelligenceErrorProcessor|Processing Phase|Preprocessing

ADD||DemandIntelligenceErrorProcessor|Execution Order|3

ADD||DemandIntelligenceErrorProcessor|Is Active|True

ADD||DemandIntelligenceErrorProcessor|InheritScenarioUserAccess|True

ADD||ScenarioAssociationProcessor|Processing Phase|Preloading

ADD||ScenarioAssociationProcessor|Execution Order|1

ADD||ScenarioAssociationProcessor|Is Active|true

ADD||ScenarioAssociationProcessor|User|<InsertUserNameHere>

END_OF_SET||||

3. In PSS.dat, add the property InheritScenarioUserAccess and set it to True. 

4. Add the Scenario Association Processor properties, setting the User property to the 
name of the user assigned to the MIPO scenario. 

5. Save and close the PSS.DAT file.

6. Update and close the .zip archive.

Transferring DIM scenario data to Data Store
The Demand Intelligence Module can automatically transfer scenario data to the Data Store module 
after the data set has been computed by DIM. 

See the EIS Online Help for more information on the Auto Transfer feature.

Note: These settings can be entered through the Processor Settings tab in the SGLT.
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Chapter 10:
Configuring SLO

his chapter describes the procedure for configuring the Service Level Optimization (SLO) 
application. 

Transferring SLO scenario data to Data Store
The Service Level Optimization module can automatically transfer scenario data to the Data Store 
module after the data set has been optimized by SLO. 

See the EIS Online Help for more information on the Auto Transfer feature.

SLO data set configuration
The SLO workflow design allows for weekly data updates to MIPO to include SLO scenario outputs 
as the service level inputs for MIPO optimization. The SLO Output Copy processor can be invoked 
during the data loading process to automatically copy this data. This processor can be configured in 
the PSS.DAT file for the data set

T
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The SLO scenario can also be configured to automatically inherit the scenario access information 
associated with its source MIPO scenario.

Assigning SLO Copy Output processor settings
To configure SLO Output Copy processor properties on a per-loadset basis (in PSS.DAT):

1. Identify and unzip the loadset where you want to change processor settings.

2. Locate the PSS.dat file and open it in a text editor. If PSS.dat has already been 
configured for the SLO Output Copy processor, the file will resemble the following:

PSS||PSS_PROCESSOR_NAME|PSS_PROPERTY|PSS_VALUE

ADD||SloOutputCopyProcessor|Is Active|true

ADD||SloOutputCopyProcessor|Processing Phase|Preprocessing

ADD||SloOutputCopyProcessor|Execution Order|1

ADD||SloOutputCopyProcessor|SourceScenarioName|EnterSLOSupplyChainName
Here

END_OF_SET||||

3. In PSS.dat, add or modify the properties associated with the SLO Output Copy 
processor. 

4. Save and close the PSS.DAT file.

5. Update and close the .zip archive.

Assigning automatic MIPO scenario access settings
To configure a SLO scenario to automatically inherit the MIPO scenario access settings (in 
PSS.DAT):

1. Identify and unzip the loadset where you want to change processor settings.

2. Locate the PSS.dat file and open it in a text editor. If PSS.dat has already been 
configured for SLO, the file will resemble the following:

PSS||PSS_PROCESSOR_NAME|PSS_PROPERTY|PSS_VALUE

ADD||ScenarioTransformationProcessor|Is Active|True

Note: The processor settings file for your organization can be named something other 
than PSS.dat. A processor settings file will always contain the text “PSS” in the first 
field of the header line. 

Notes: These settings can be entered through the Processor Settings tab in the SGLT. 
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ADD||ScenarioTransformationProcessor|Processing Phase|Preprocessing

ADD||ScenarioTransformationProcessor|Execution Order|1

ADD||ScenarioTransformationProcessor|TargetScenarioName|5Items-SLO

ADD||ScenarioTransformationProcessor|TargetScenarioModuleName|SLO

ADD||ScenarioTransformationProcessor|ImportTransition|True

ADD||ScenarioTransformationProcessor|InheritScenarioUserAccess|True

ADD||ScenarioAssociationProcessor|Processing Phase|Preloading

ADD||ScenarioAssociationProcessor|Execution Order|1

ADD||ScenarioAssociationProcessor|Is Active|true

ADD||ScenarioAssociationProcessor|User|<InsertUserNameHere>

END_OF_SET||||

3. In PSS.dat, add the property InheritScenarioUserAccess and set it to True. 

4. Add the Scenario Association Processor properties, setting the User property to the name 
of the user assigned to the MIPO scenario. 

5. Save and close the PSS.DAT file.

6. Update and close the .zip archive.

Reviewing SLO processor logs
The SLO module generates processor logs to aid in troubleshooting support-related issues. The 
following logs are available:

• SLO Output Copy Processor log

To review SLO processor logs:

1. Select Settings > Processor Logs. The Processor Logs screen will appear, showing a list 
of links to the most recent log files available on the EIS application server.

2. Click on the log file you want to view. If you are prompted to select an application with 
which to open the file, choose a text editor such as TextPad or NotePad.  

An example of the SLO Output Copy Processor log is shown below:

  Start of Log @ Fri Aug 19 09:26:54 EDT 2011

SloOutputCopyProcessor for scenario "SLO-Hybrids"---------------------
-----------

Inserted scenario_transform_history record

The following supply paths were optimized in SLO:

Note: These settings can be entered through the Processor Settings tab in the SGLT.
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  Updated supply path n2_nw10_Customer; set desired_service_level from 
0.95 to 0.998 for supply path key 1114

  Updated supply path n2_nw34_Customer; set desired_service_level from 
0.95 to 0.9698078202764007 for supply path key 1116

  Updated supply path n1_nw10_Customer; set desired_service_level from 
0.85 to 0.99775 for supply path key 1112

  Updated supply path n1_nw34_Customer; set desired_service_level from 
0.85 to 0.9801424681888146 for supply path key 1113

SLO scenario key = 1010

SLO scenario data handle key = 1019

SLO scenario output data handle key = 1020

Updating MIPO scenario MIPO - SLO Test SGLT

MIPO scenario key = 1009

MIPO scenario data handle key = 1018

Successfully updated 4 out of 4 stocking points at Fri Aug 19 09:26:56 
EDT 2011.

This is 100% of the stocking points from the MIPO scenario.

Log ends @ Fri Aug 19 09:26:56 EDT 2011

-----------------
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Chapter 11:
Configuring PIM

his chapter describes specific configuration items related to the Production Intelligence 
Module. 

PIM Overview
The Production Intelligence Module manipulates historical production data, including planned and 
actual production. It calculates the percentage (schedule attainment percentage) and coefficient of 
variation (schedule attainment CV) for the amount by which actual production quantities differ from 
the quantities that were scheduled to be produced. This analysis is performed for all plant “out-bin” 
stocking points. For stocking points with insufficient data, the average of all other items at that plant is 
used. If the value for the schedule attainment percentage is negative, overproduction has occurred and 
the data are ignored by PIM. The following sections describe how to adjust the processor 
configuration.

PIM installation takes place during the MIPO installation process.

PIM configuration
After you have successfully installed MIPO, you can set up PIM and its associated processors.

T
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Activating and deactivating PIM
You can specify whether the Production Intelligence Module is invoked for a particular loadset by 
changing settings in the processor settings file, commonly named PSS.dat, contained in the loadset 
itself. By default, PIM is activated for each loadset that includes a PSS.dat file.

To deactivate or activate PIM:

1. Identify the loadset for which you want to deactivate or activate one or both processors 
and unzip it.

2. Locate the file named PSS.dat and open it in a text editor. Its contents resemble the 
following:

PSS||PSS_PROCESSOR_NAME|PSS_PROPERTY|PSS_VALUE

ADD||ProductionIntelligenceProcessor|Is Active|true

ADD||ProductionIntelligenceProcessor|Processing Phase|Preprocessing

ADD||ProductionIntelligenceProcessor|Execution Order|2

END_OF_SET||||

3. To deactivate PIM, modify the line below, as follows:

ADD||ProductionIntelligenceProcessor|Is Active|false

4. Save and close the .dat file. 

5. Update and close the .zip file.

Note: The processor settings file for your organization can be named something other 
than PSS.dat. A processor settings file will, however, always contain the text “PSS” in 
the first field of the header line. 

Note: To re-activate PIM, change the Is Active value to true.
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Setting the historical data horizon
The historical data horizon is the number of periods preceding the base period that contain historical 
forecast data to be preprocessed. The base period is latest recognized date in the database when 
historical data transitions to forecast data.

You can specify the number of periods in the historical data horizon for a particular loadset by 
changing a setting in the scenario settings file within the loadset itself. 

To set the historical data horizon for a loadset:

1. Identify the loadset for which you want to change the historical data horizon.

2. Locate the file named sst.dat and open it in a text editor. 

3. Identify the header field named SST_HISTORICAL_HRZN and its corresponding data 
field that contains a numerical value.

4. Modify the value as desired.

5. Save and close the .dat file. 

6. Update and close the .zip file. 

Caution: The historical data horizon must be set to a non-zero value when processors 
are being invoked. If not, the processors will fail.

Base Period

Future
Analysis Horizon

Future
Data Horizon

Historical
Data Horizon
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Chapter 12:
Configuring SIM

his chapter describes the configuration items related to the Supply Intelligence Module. 

SIM Overview
The Supply Intelligence Module includes the Supply Lead Time processor, which runs during the 
preprocessing phase of MIPO optimization. This process requires purchase order (POF) data in order 
to run correctly.

The Supply Lead Time processor calculates the mean order processing lead time, the mean physical 
lead time, and the total lead time standard deviation for all supply paths with sufficient historical 
transactional data. The processor then overwrites the values originally provided in the loadset with its 
newly calculated values. 

SIM also includes the Lead Time Cleanup processor, which runs during the preloading phase of 
MIPO optimization. This processor truncates the purchase order tables (Purchase Order and 
Purchase Order Fulfillment) before the next run of the Supply Intelligence processor. This guarantees 
that the data used for the latest calculation will not be mixed with older data for the scenario.

SIM installation takes place during the MIPO installation process.

T
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SIM Configuration
After you have successful installed MIPO, you can set up SIM and its associated processors.

Activating and deactivating the processor
1. Identify and unzip the loadset where you want to change processor settings

2. Locate the PSS.dat file and open it in a text editor.

3. In PSS.dat, find or add one of the sets of parameters below:

ADD||LeadTimeCleanup|Processing Phase|Preloading

ADD||LeadTimeCleanup|Execution Order|1

ADD||LeadTimeCleanup|Is Active|true

ADD||SupplyLeadTimeProcessor|Is Active|true

ADD||SupplyLeadTimeProcessor|Processing Phase|Preprocessing

ADD||SupplyLeadTimeProcessor|Execution Order|2

By default, processors are active (set to true). To deactivate the Supply Lead Time 
processor, change the |SupplyLeadTimeProcessor|Is Active| setting above to false. 
Likewise, to deactivate the Lead Time Cleanup processor, set |LeadTimeCleanup|Is 
Active| to false.

4. Save and close the .dat file.

5. Update and close the .zip archive.

Changing processor default parameter settings
The Supply Lead Time processor's default parameter settings are coded in the processor itself. You 
can override hard-coded values for individual loadsets by configuring a PSS.dat file with Supply Lead 
Time processor properties as described below. This process changes processor parameters only for 
the individual loadsets in which the modified PSS.dat file is included.

To configure parameters for the Supply Lead Time processor in PSS.dat:

1. Identify and unzip the loadset where you want to change processor settings.

2. Locate the PSS.dat file and open it in a text editor. If PSS.dat has already been configured 
for the Lead Time processor, the file will resemble the following:

PSS||PSS_PROCESSOR_NAME|PSS_PROPERTY|PSS_VALUE

ADD||LeadTimeCleanup|Processing Phase|Preloading

Note: The EIS Processor Logs feature can be used to troubleshoot any SIM processor-
related issues. 
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ADD||LeadTimeCleanup|Execution Order|1

ADD||LeadTimeCleanup|Is Active|true

ADD||SupplyLeadTimeProcessor|Is Active|true

ADD||SupplyLeadTimeProcessor|Processing Phase|Preprocessing

ADD||SupplyLeadTimeProcessor|Execution Order|2

ADD||SupplyLeadTimeProcessor|Lead_Time_Historical_Data_Horizon|52

ADD||SupplyLeadTimeProcessor|Lead_Time_Order_Processing_Mean_Cap|5

ADD||SupplyLeadTimeProcessor|Lead_Time_Physical_Mean_Cap|5

ADD||SupplyLeadTimeProcessor|Lead_Time_Outlier_Multiplier|3

ADD||SupplyLeadTimeProcessor|Lead_Time_Exclude_Outliers|True

ADD||SupplyLeadTimeProcessor|Lead_Time_CV_Cap|3

ADD||SupplyLeadTimeProcessor|Lead_Time_Min_Data_Point_Count|5

ADD||SupplyLeadTimeProcessor|Supply_Lead_Time_Raw_Data_Log|True

ADD||SupplyLeadTimeProcessor|Lead_Time_Log_Details|True

END_OF_SET||||

3. In PSS.dat, add or modify the properties associated with the Supply Lead Time processor. 
The parameters, their possible values, and explanations of their behavior are listed below.

4. Save and close the .dat file.

5. Update and close the .zip archive and drop the loadset according to your normal 
workflow.
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Chapter 13:
Upgrading EIS

his chapter provides instructions for upgrading the EIS database and application software 
Prerequisites for using the current version of the EIS are described in “Chapter 1: 
Requirements” on page 15 of this guide. 

Note: If you are upgrading from a version earlier than 6.10 to a version later than 6.10, 
you must first upgrade to 6.10 and then apply the later version.

T
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Upgrading the EIS database schema
You can upgrade the EIS database schema directly on the database server or from a Windows 
machine that has connectivity to the database. 

Prerequisite: Grant schema privileges

Before beginning to upgrade the database schema on Windows or UNIX, you may need to assign the 
required schema privileges. Log into database as user sysdba and run the following statements:

SQL>grant select on sys.v_$parameter to sops_mipo;

SQL>grant select on sys.v_$timer to system with grant option;

Upgrading the EIS schema from Windows or UNIX
You can upgrade the EIS database schema from a Windows or UNIX machine that has connectivity 
to the database. Upgrading the database schema includes the following main tasks:

• Copying the schema upgrade files from the EIS installation media

• Upgrading the EIS database schema

• Reinstalling the data loader schema

The following sections describe each of these tasks in detail.

Step 1: Copy the schema upgrade files.

Note: The database portion of the EIS upgrade must be performed by either a database 
administrator (DBA) or someone who has an advanced background working directly 
with Oracle database systems. Please refer to documentation supplied with the Oracle 
database for further information on specific Oracle functionality.

UNIX:

• Log in to the machine containing the 
database instance and create a new 
directory to contain the copied EIS files.

• Copy and uncompress the files from the
 /INTERNAL<version>/Database 
and                            /
DataLoader<version>/Database 
directories on the EIS installation media 
to the new directory.

Windows:

• Copy the files from the 
\INTERNAL<version>\Database 
and \DataLoader<version>\Database 
directories on the EIS installation media 
to a directory on your local machine.
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Step 2: Upgrade the database schema

1. Shut down the application server machine using your standard procedures and ensure 
that no machines can connect to the database server during the upgrade process.

2. Use Oracle EXPORT or a different utility to create a backup of the Oracle database 
instance containing the EIS database schema.

3. Navigate to the INTERNAL<version>\Database directory and log in to SQL*Plus as 
schema owner SOPS_MIPO (the default password is sops_mipo).

4. Execute the upgrade script:

SQL> @upgrade.sql

Installation of the database schema begins and can take several minutes to complete. A 
message will indicate that upgrade is complete.

5. During the upgrade process, log files are created in the \Database directory. Check all 
log files to verify that no errors occurred during the upgrade. If you find errors in the log 
files, contact your EIS Project Manager.

6. After the upgrade is complete, start SQL*Plus, log in to the database instance as the 
schema owner SOPS_MIPO (the default password is sops_mipo) and execute the 
following SQL command:

SQL> select object_name, object_type from user_objects where 
status=’INVALID’;

If this query returns no rows, then the database schema upgrade was completed 
successfully. If invalid objects are found, contact your EIS Project Manager.

Step 3: Reinstall the EIS data loader schema

After upgrading the EIS database schema used to store supply chain data, reinstall the schema used by 
the data loader, as follows:

1. Navigate to the DataLoader<version>\Database directory and log into SQL*Plus as 
the system user.

2. Execute the install.sql script.

Installation of the database schema begins and can take several minutes to complete.

- The schema owner SOPS_DLASM is created. 

- The SOPS_DLASM schema is created.

- Static data is imported into the schema.

Note: Errors can be generated when the upgrade script attempts 
to drop tables, sequences, indexes, or views that do not exist. It is 
safe to ignore these errors.
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A message indicates that the PL/SQL procedure and installation was successfully 
completed.

3. Verify that no errors occurred during the installation or static data import process by 
checking the files located in the \Database directory. If the log files contain unknown 
errors, contact SAP Support.

Upgrading the Data Gateway database schema
You can upgrade the Data Gateway database schema directly on the database server or from a 
Windows machine that has connectivity to the database. The following sections provide instructions 
for each option.

Prerequisite: Grant schema privilege

Before beginning to upgrade the database schema on Windows or UNIX, you may need to assign the 
required schema privilege. Log into database as user system and run the following statement:

SQL>grant select any dictionary to sops_gateway

Upgrading the Data Gateway schema 
Upgrading the database schema includes the following tasks:

• Copying the schema upgrade files from the Data Gateway installation media

• Upgrading the Data Gateway database schema

The following sections describe each of these tasks in detail.

Step 1: Copy the schema upgrade files.

Copy the Data Gateway schema upgrade files from the EIS installation media to the EIS database 
server. These files are located under the \DataGateway<version>\Database directory (where 
<version> represents the release number for the software application).

Step 2: Upgrade the database schema

1. Shut down the application server machine using your standard procedures and ensure 
that no machines can connect to the database server during the upgrade process.

2. Use Oracle EXPORT or a different utility to create a backup of the Oracle database 
instance containing the Data Gateway schema.

Note: Errors can be generated when the installation script 
attempts to drop tables, sequences, indexes, or views that do not 
exist. It is safe to ignore these errors.
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3. Log into SQL*Plus as the system user.

4. Execute the upgrade script

SQL> @upgrade.sql

Installation of the database schema begins and can take several minutes to complete. A 
message will indicate that upgrade is complete.

5. During the upgrade process, log files are created in the \Database directory. Check all 
log files to verify that no errors occurred during the upgrade. If you find errors in the log 
files, contact your EIS Project Manager.

6. After the upgrade is complete, start SQL*Plus, log in to the database instance as the 
schema owner sops_gateway (the default password is sops_gateway) and execute the 
following SQL command:

SQL> select object_name, object_type from user_objects where 
status=’INVALID’;

If this query returns no rows, then the database schema upgrade was completed 
successfully. If invalid objects are found, contact your EIS Project Manager .

Upgrading the Data Store database schema
You can upgrade the Data Store database schema directly on the database server or from a Windows 
machine that has connectivity to the database. The following sections provide instructions for each 
option.

Prerequisite: Grant schema privilege

Before beginning to upgrade the database schema on Windows or UNIX, you may need to assign the 
required schema privilege. Log into database as user system and run the following statement:

SQL>grant select any dictionary to sops_datastore

Upgrading the Data Store schema 
Upgrading the database schema includes the following tasks:

• Copying the schema upgrade files from the Data Store installation media

• Upgrading the Data Store database schema

The following sections describe each of these tasks in detail.

Note: Errors can be generated when the upgrade script attempts 
to drop tables, sequences, indexes, or views that do not exist. It is 
safe to ignore these errors.
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Step 1: Copy the schema upgrade files.

Copy the Data Store schema upgrade files from the EIS installation media to the EIS database server. 
These files are located under the \DataStore<version>\Database directory (where <version> 
represents the release number for the software application).

Step 2: Upgrade the database schema

1. Shut down the application server machine using your standard procedures and ensure 
that no machines can connect to the database server during the upgrade process.

2. Use Oracle EXPORT or a different utility to create a backup of the Oracle database 
instance containing the Data Store schema.

3. Log into SQL*Plus as the system user.

4. Execute the upgrade script

SQL> @upgrade.sql

Installation of the database schema begins and can take several minutes to complete. A 
message will indicate that upgrade is complete.

5. During the upgrade process, log files are created in the \Database directory. Check all 
log files to verify that no errors occurred during the upgrade. If you find errors in the log 
files, contact your EIS Project Manager.

6. After the upgrade is complete, start SQL*Plus, log in to the database instance as the 
schema owner sops_datastore (the default password is sops_datastore) and execute the 
following SQL command:

SQL> select object_name, object_type from user_objects where 
status=’INVALID’;

If this query returns no rows, then the database schema upgrade was completed 
successfully. If invalid objects are found, contact your EIS Project Manager.

Upgrading the EIS Application
To upgrade the application, you must reinstall the EIS application. See “Chapter 3: Installing and 
configuring EIS for the SAP Web Application Server” on page 37 for more information.

Note: Errors can be generated when the upgrade script attempts 
to drop tables, sequences, indexes, or views that do not exist. It is 
safe to ignore these errors.
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Verifying the upgrade
To ensure that EIS was upgraded successfully:

1. Ensure that the Oracle database instance containing the MIPO schema is running. 

2. Start the application server by using the instructions in this guide. 

3. Start Internet Explorer on a client PC and entering the following text in the Address 
field:

http://app_server_name:50000/SmartOps

In this example, app_server_name represents the name of the machine on which the 
application server is running and 50000 represents the port number for your NetWeaver 
installation.

4. The EIS Portal window opens in full-screen mode.

5. Sign in to MIPO with your user name and password.

http://app_server:8080/SmartOps/
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Appendices

Appendix A: Business Alerts
This section contains details on the parameters used to define business alerts configuration settings 
for an SGLT data set. 

Business Alert: Demand CV
This business alert is generated when the forecast demand CV (coefficient of variation) between 
scenarios has changed more than the specified criteria, as defined by a percentage.. 

Business Alert 
Name

Business Alert Property Business Alert Value

DEMAND_CV Is Active true or false

DEMAND_CV Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

DEMAND_CV pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 14-1 Demand CV business alert
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Business Alert: Demand CV Comparison
This business alert is generated when the demand CV has exceeded the specified criteria, as defined by 
a percentage. 

Business Alert: Demand Mean comparison 
This business alert is generated when the forecast demand mean between scenarios has changed more 
than the specified criteria, as defined by a percentage. 

Business Alert 
Name

Business Alert Property Business Alert Value

DEMAND_CV_
COMPARISON

Is Active true or false

DEMAND_CV_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

DEMAND_CV_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

DEMAND_CV_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Table 14-2 Demand CV Comparison business alert

Business Alert 
Name

Business Alert Property Business Alert Value

DEMAND_MEAN_
COMPARISON

Is Active true or false

DEMAND_MEAN_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

DEMAND_MEAN_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 14-3 Demand Mean comparison business alert
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Business Alert: Demand Standard Deviation comparison 
This business alert is generated when the forecast demand standard deviation between scenarios has 
changed more than the specified criteria, as defined by a percentage. 

DEMAND_MEAN_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Business Alert 
Name

Business Alert Property Business Alert Value

DEMAND_STD_
COMPARISON

Is Active true or false

DEMAND_STD_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

DEMAND_STD_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

DEMAND_STD_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Table 14-4 Demand Standard Deviation comparison business alert

Business Alert 
Name

Business Alert Property Business Alert Value

Table 14-3 Demand Mean comparison business alert
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Business Alert: Implied Service Level comparison (SPT)
This business alert is generated when the implied service level between scenarios from the Stocking 
Point TIP table has changed more than the specified criteria, as defined by a percentage.

Business Alert: Implied Demand
This business alert is generated when the the ratio of safety stock to implied demand or safety stock to 
implied demand error has changed more than the specified criteria, as defined by a percentage.

Business Alert 
Name

Business Alert Property Business Alert Value

ISL_SPT_
COMPARISON

Is Active true or false

ISL_SPT_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

ISL_SPT_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

ISL_SPT_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Table 14-5 Implied Service Level comparison (SPT) business alert

Business Alert 
Name

Business Alert Property Business Alert Value

IMPLIED_DEMAND Is Active true or false

IMPLIED_DEMAND Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

IMPLIED_DEMAND pct Any non-negative percentage 
value (e.g., 0.15 for 15% or 1.2 for 
120%)

Table 14-6 Implied Demand business alert



Appendix

179

Business Alert: Lead time CV (PRF)
This business alert is generated when the lead time CV from the Process Resource Forecast table has 
exceeded the specified criteria, as defined by a percentage. 

Business Alert: Lead time CV (SPF)
This business alert is generated when the lead time CV from the Supply Path Forecast table has 
exceeded the specified criteria, as defined by a percentage. 

Business Alert 
Name

Business Alert Property Business Alert Value

LT_CV_PRF Is Active true or false

LT_CV_PRF Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

LT_CV_PRF pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 14-7 Lead Time CV (PRF) business alert

Business Alert 
Name

Business Alert Property Business Alert Value

LT_CV_SPF Is Active true or false

LT_CV_SPF Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

LT_CV_SPF pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 14-8 Lead time CV (SPF) business alert
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Business Alert: Lead Time Mean comparison (PRF)
This business alert is generated when the lead time mean between scenarios form the Process 
Resource Forecast table exceeds the specified criteria, as defined by a percentage. 

Business Alert: Lead Time Mean comparison (SPF)
This business alert is generated when the lead time mean between scenarios from the Supply Path 
Forecast table has changed more than the specified criteria, as defined by a percentage. 

Business Alert 
Name

Business Alert Property Business Alert Value

LT_MEAN_PRF_
COMPARISON

Is Active true or false

LT_MEAN_PRF_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

LT_MEAN_PRF_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

LT_MEAN_PRF_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Table 14-9 Lead Time Mean comparison (PRF) business alert

Business Alert 
Name

Business Alert Property Business Alert Value

LT_MEAN_SPF_
COMPARISON

Is Active true or false

LT_MEAN_SPF_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

LT_MEAN_SPF_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 14-10 Lead Time Mean comparison (SPF) business alert
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Business Alert: Lead Time Standard Deviation comparison 
(PRF)
This business alert is generated when the lead time standard deviation between scenarios from the 
Process Resource Forecast table has changed more than the specified criteria, as defined by a 
percentage. 

LT_MEAN_SPF_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Business Alert 
Name

Business Alert Property Business Alert Value

LT_STD_PRF_
COMPARISON

Is Active true or false

LT_STD_PRF_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

LT_STD_PRF_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

LT_STD_PRF_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Table 14-11 Lead Time Standard Deviation comparison (PRF) business alert

Business Alert 
Name

Business Alert Property Business Alert Value

Table 14-10 Lead Time Mean comparison (SPF) business alert
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Business Alert: Lead Time Standard Deviation comparison 
(SPF)
This business alert is generated when the lead time standard deviation between scenarios from the 
Supply Path Forecast table has changed more than the specified criteria, as defined by a percentage. 

Business Alert: On hand stock in periods comparison (SPT)
This business alert is generated when the on-hand stock in periods value between scenarios from the 
Stocking Point TIP table has changed more than the specified criteria, as defined by a percentage. 

Business Alert 
Name

Business Alert Property Business Alert Value

LT_STD_SPF_
COMPARISON

Is Active true or false

LT_STD_SPF_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

LT_STD_SPF_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

LT_STD_SPF_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Table 14-12 Lead Time Standard Deviation comparison (SPF) business alert

Business Alert 
Name

Business Alert Property Business Alert Value

OHSP_SPT_
COMPARISON

Is Active true or false

OHSP_SPT_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

OHSP_SPT_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 14-13 On hand stock in periods comparison (SPT) business alert
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Business Alert: On hand stock comparison (SPT)
This business alert is generated when the on-hand stock between scenarios from the Stocking Point 
TIP table has changed more than the specified criteria, as defined by a percentage. 

OHSP_SPT_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Business Alert 
Name

Business Alert Property Business Alert Value

OHS_SPT_
COMPARISON

Is Active true or false

OHS_SPT_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

OHS_SPT_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

OHS_SPT_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Table 14-14 On hand stock comparison (SPT) business alert

Business Alert 
Name

Business Alert Property Business Alert Value

Table 14-13 On hand stock in periods comparison (SPT) business alert
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Business Alert: Supply ratio comparison (SPF)
 This business alert is generated when the supply ratio between scenarios from the Supply Path 
Forecast table has changed more than the specified criteria, as defined by a percentage.

Business Alert: Safety stock in periods comparison (SPT)
This business alert is generated when the safety stock in periods value between scenarios from the 
Stocking Point TIP table has changed more than the specified criteria, as defined by a percentage. 

Business Alert 
Name

Business Alert Property Business Alert Value

RATIO_SPF_
COMPARISON

Is Active true or false

RATIO_SPF_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

RATIO_SPF_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

RATIO_SPF_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Table 14-15 Supply ratio comparison (SPF) business alert

Business Alert 
Name

Business Alert Property Business Alert Value

SSP_SPT_
COMPARISON

Is Active true or false

SSP_SPT_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

SSP_SPT_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

Table 14-16 Safety stock in periods comparison (SPT) business alert
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Business Alert: Safety stock comparison (SPT)
This business alert is generated when the safety stock between scenarios from the Stocking Point TIP 
table has changed more than the specified criteria, as defined by a percentage. 

SSP_SPT_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Business Alert 
Name

Business Alert Property Business Alert Value

SSP_SPT_
COMPARISON

Is Active true or false

SSP_SPT_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

SSP_SPT_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

SSP_SPT_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Table 14-17 Safety stock comparison (SPT) business alert

Business Alert 
Name

Business Alert Property Business Alert Value

Table 14-16 Safety stock in periods comparison (SPT) business alert
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Business Alert: TIP comparison (SPT)
This business alert is generated when the TIP between scenarios from the Stocking Point TIP table 
has changed more than the specified criteria, as defined by a percentage. 

Appendix B: Reject message definitions
This section contains details on the message definitions related to the reject ID codes to be used as a 
reference when reviewing reject log data. Warning messages warn of an issue but do not halt data 
loading, Error messages halt data loading. 

Business Alert 
Name

Business Alert Property Business Alert Value

TIP_SPT_
COMPARISON

Is Active true or false

TIP_SPT_
COMPARISON

Severity FATAL ERROR, ERROR, 
WARNING, or 
INFORMATIONAL

TIP_SPT_
COMPARISON

pct Any percentage value between 0 
and 1.0 (e.g., 0.15 for 15%)

TIP_SPT_
COMPARISON

comparison_scenario_name Scenario name to be used for 
comparison (e.g., Example 
Supply Chain) Note: If not 
specified, parent supply chain will 
be used.

Table 14-18 TIP comparison (SPT) business alert

Reject 
ID

Package Name Message Classifi-
cation

113 PACK_STOCKING
_POINT

LOCATION is null. Warning

114 PACK_STOCKING
_POINT

Item name is null. Warning

115 PACK_STOCKING
_POINT

Location name is not found in the 
PLANNING_LOCATION table.

Warning

116 PACK_STOCKING
_POINT

SKU_CODE is not found in the 
PLANNING_SKU table.

Warning

Table 14-19 Reject message definitions
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117 PACK_STOCKING
_POINT

STOCKING_POINT_TYPE_CODE is not 
found in the STOCKING_POINT_TYPE table.

Warning

118 PACK_LOCATION
_ATTRIBUTE

LOCATION_NAME is null. Warning

119 PACK_LOCATION
_ATTRIBUTE

LOCATION_NAME is not found in the 
PLANNING_LOCATION table.

Warning

120 PACK_LOCATION
_ATTRIBUTE

LOCATION_ATTRIBUTE_NAME is not found 
in the ATTRIBUTE table.

Warning

121 PACK_LOCATION
_ATTRIBUTE

LOCATION_ATTRIBUTE_VALUE is not 
found in the ATTRIBUTE_VALUE table.

Warning

122 PACK_NODE
_ATTRIBUTE

NODE_NAME is null. Warning

123 PACK_NODE
_ATTRIBUTE

NODE_ATTRIBUTE_NAME is null. Warning

124 PACK_NODE
_ATTRIBUTE

NODE_ATTRIBUTE_NAME is not found in 
the ATTRIBUTE table.

Warning

136 PACK_LOCATION Location name is null. Warning

164 PACK_ITEM
_ATTRIBUTE

ITEM_NAME is null. Warning

165 PACK_ITEM
_ATTRIBUTE

ITEM_ATTRIBUTE_NAME is null. Warning

168 PACK_ITEM
_ATTRIBUTE

ITEM_ATTRIBUTE_NAME is not found in the 
ATTRIBUTE table.

Warning

322 PACK_ITEM UOM is null. Warning

323 PACK_ITEM UOM is not found in the UNIT_OF_MEASURE 
table.

Warning

432 PACK_SUPERSESSION_
ITEM

OLD_ITEM_NAME is null. Warning

433 PACK_SUPERSESSION_
ITEM

NEW_ITEM_NAME is null. Warning

434 PACK_SUPERSESSION_
ITEM

EFFECTIVE_DATE is null. Warning

Reject 
ID

Package Name Message Classifi-
cation

Table 14-19 Reject message definitions
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435 PACK_SUPERSESSION_
ITEM

CONVERSION_FACTOR is null. Warning

481 PACK_PO_
FULFILLMENT

PO_NUMBER is null. Warning

482 PACK_PO_
FULFILLMENT

CREATION_DATE is null. Warning

483 PACK_PO_
FULFILLMENT

SHIPMENT_ID is null. Warning

484 PACK_PO_
FULFILLMENT

FULFILLMENT_SKU_CODE is null. Warning

485 PACK_PO_
FULFILLMENT

SKU_CODE is not found in the 
PLANNING_SKU table.

Warning

486 PACK_PO_
FULFILLMENT

DEST_LOCATION_NAME is null. Warning

487 PACK_PO_
FULFILLMENT

DEST_LOCATION_NAME is not found in the 
PLANNING_LOCATION table.

Warning

488 PACK_PO_
FULFILLMENT

SRC_LOCATION_NAME is not found in the 
PLANNING_LOCATION table.

Warning

489 PACK_PO_
FULFILLMENT

SUBMISSION_DATE is null. Warning

490 PACK_PO_
FULFILLMENT

RECEIPT_DATE is null. Warning

491 PACK_PO_
FULFILLMENT

ORDER_QUANTITY is null. Warning

492 PACK_PO_
FULFILLMENT

ORDER_QUANTITY is < 0. Warning

493 PACK_PO_
FULFILLMENT

UOM is null. Warning

494 PACK_PO_
FULFILLMENT

UOM is not found in the UNIT_OF_MEASURE 
table.

Warning

495 PACK_PO_
FULFILLMENT

CREATION_DATE must be <= 
FULFILLMENT_SUBMISSION_DATE.

Warning

Reject 
ID

Package Name Message Classifi-
cation
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496 PACK_PO_
FULFILLMENT

SUBMISSION_DATE must be <= 
FULFILLMENT_RECEIPT_DATE.

Warning

599 PACK_HISTORICAL_
SALES

Sales is null. Warning

600 PACK_HISTORICAL_
SALES

Item_name is null. Warning

601 PACK_HISTORICAL_
SALES

Location name is null. Warning

602 PACK_HISTORICAL_
SALES

SKU_CODE is not found in the 
PLANNING_SKU table.

Warning

603 PACK_HISTORICAL_
SALES

LOCATION_NAME is not found in the 
PLANNING_LOCATION table.

Warning

604 PACK_HISTORICAL
_PRODUCTION

Item_name is null. Warning

605 PACK_HISTORICAL
_PRODUCTION

Location name is null. Warning

606 PACK_HISTORICAL
_PRODUCTION

SKU_CODE is not found in the 
PLANNING_SKU table.

Warning

607 PACK_HISTORICAL
_PRODUCTION

LOCATION_NAME is not found in the 
PLANNING_LOCATION table.

Warning

608 PACK_HISTORICAL
_PRODUCTION

Period Date not found in PLANNING_PERIOD 
table.

Warning

610 PACK_HISTORICAL_
SALES

SHIP_TO is not found in the 
PLANNING_LOCATION table.

Warning

611 PACK_HISTORICAL_
SALES

Period Date not found in PLANNING_PERIOD 
table.

Warning

700 PACK_DEMAND_
FORECAST

Item_name is null. Warning

701 PACK_DEMAND_
FORECAST

Location name is null. Warning

702 PACK_DEMAND_
FORECAST

SKU_CODE is not found in the 
PLANNING_SKU table.

Warning

Reject 
ID

Package Name Message Classifi-
cation
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703 PACK_DEMAND_
FORECAST

LOCATION_NAME is not found in the 
PLANNING_LOCATION table.

Warning

704 PACK_DEMAND_
FORECAST

REVISION_PERIOD_DATE is null. Warning

705 PACK_DEMAND_
FORECAST

FORECAST_PERIOD_DATE is null. Warning

706 PACK_DEMAND_
FORECAST

DEMAND_FORECAST is null. Warning

707 PACK_DEMAND_
FORECAST

SHIP_TO is not found in the 
PLANNING_LOCATION table.

Warning

710 PACK_EXTERNAL_
DEMAND_FORECAST

Supply_path_name is null. Warning

711 PACK_EXTERNAL_
DEMAND_FORECAST

Period_date is null. Warning

712 PACK_EXTERNAL_
DEMAND_FORECAST

Demand_mean is null. Warning

713 PACK_EXTERNAL
_DEMAND_FORECAST

Demand_error is null. Warning

714 PACK_EXTERNAL
_DEMAND_FORECAST

SUPPLY_PATH_NAME is not found in the 
SUPPLY_PATH table.

Warning

720 PACK_PROCESS_BOM BOM_name is null. Warning

721 PACK_PROCESS_BOM Base Item name is null. Warning

722 PACK_PROCESS_BOM Component Item is null. Warning

723 PACK_PROCESS_BOM BOM quantity is null or 0. Warning

724 PACK_PROCESS_BOM Base Item is not found in the PLANNING_SKU 
table.

Warning

725 PACK_PROCESS_BOM Component Item is not found in the 
PLANNING_SKU table.

Warning

726 PACK_PROCESS_BOM Component Item and Base Item cannot be the 
same.

Warning

750 PACK_SUPPLY_PATH Source_Node_Name is null. Warning

Reject 
ID

Package Name Message Classifi-
cation
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751 PACK_SUPPLY_PATH Destination_Node_Name is null. Warning

752 PACK_SUPPLY_PATH Source_Node_Name is not found in the 
NETWORK_NODE table.

Warning

753 PACK_SUPPLY_PATH Destination_Node_Name is not found in the 
NETWORK_NODE table.

Warning

760 PACK_SUPPLY_RATIO Period_date is null. Warning

761 PACK_SUPPLY_RATIO Supply_path_name is not found in the MIPO 
SUPPLY_PATH table.

Warning

770 PACK_SUPPLY_PATH_
TV

Period_date is null. Warning

771 PACK_SUPPLY_PATH
_TV

Order_quantity is null. Warning

772 PACK_SUPPLY_PATH
_TV

Supply_path_name is not found in the MIPO 
SUPPLY_PATH table.

Warning

780 PACK_SUPPLY_PATH
_ATTRIBUTE

Supply_path_name is null. Warning

781 PACK_SUPPLY_PATH
_ATTRIBUTE

Supply_path_attribute_name is null. Warning

782 PACK_SUPPLY_PATH
_ATTRIBUTE

Supply_path_attribute_value is null. Warning

783 PACK_SUPPLY_PATH
_ATTRIBUTE

Supply_path_attribute_name not found in the 
ATTRIBUTE table.

Warning

790 PACK_PROCESS
_POINT

Location_name is null. Warning

791 PACK_PROCESS
_POINT

Process_BOM is null. Warning

792 PACK_PROCESS
_POINT

Location_name not found in the 
PLANNING_LOCATION table.

Warning

793 PACK_PROCESS
_POINT

Process_BOM not found in the 
BILL_OF_MATERIAL table.

Warning

800 PACK_SKU_PACKAGE Packaged_item not found in the 
PLANNING_SKU table.

Warning

Reject 
ID

Package Name Message Classifi-
cation
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801 PACK_SKU_PACKAGE Finished_item not found in the 
PLANNING_SKU table.

Warning

820 PACK_SKU_PACKAGE Superceded Item not found in MIPO 
planning_sku table.

Warning

821 PACK_SKU_PACKAGE New Item Name not found in MIPO 
planning_sku table.

Warning

822 PACK_SKU_PACKAGE Superceded Location Name not found in MIPO 
planning_location table.

Warning

823 PACK_SKU_PACKAGE New Location Name not found in MIPO 
planning_location table.

Warning

1018 PACK_STOCKING
_POINT_TV

Stocking Point name is null. Warning

2000 PACK_CREATE
_TOPOLOGY

STG_FORECAST_DATE IS OUTSIDE THE 
DATA HORIZON.

Warning

2001 PACK_CREATE
_TOPOLOGY

STG_FORECAST ITEM_ID IS NOT IN THE 
STG_ITEM TABLE.

Warning

2002 PACK_CREATE
_TOPOLOGY

STG_FORECAST LOCATION_ID IS NOT IN 
THE STG_LOCATION TABLE.

Warning

2003 PACK_CREATE
_TOPOLOGY

STG_FORECAST SHIP TO IS NOT NULL 
BUT IS NOT IN THE STG_LOCATION 
TABLE.

Warning

2010 PACK_CREATE
_TOPOLOGY

STG_SOURCING_DATES ARE OUTSIDE 
THE DATA HORIZON.

Warning

2011 PACK_CREATE
_TOPOLOGY

STG_SOURCING ITEM_ID IS NOT IN THE 
STG_ITEM TABLE.

Warning

2012 PACK_CREATE
_TOPOLOGY

STG_SOURCING FROM_LOCATION_ID IS 
NOT IN THE STG_LOCATION TABLE.

Warning

2013 PACK_CREATE
_TOPOLOGY

STG_SOURCING TO_LOCATION_ID IS 
NOT IN THE STG_LOCATION TABLE.

Warning

2020 PACK_CREATE
_TOPOLOGY

STG_BOM BASE_ITEM_ID IS NOT IN THE 
STG_ITEM TABLE.

Warning

2021 PACK_CREATE
_TOPOLOGY

STG_BOM COMP_ITEM_ID IS NOT IN THE 
STG_ITEM TABLE.

Warning

Reject 
ID

Package Name Message Classifi-
cation
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2022 PACK_CREATE
_TOPOLOGY

STG_BOM LOCATION_ID IS NOT IN THE 
STG_LOCATION TABLE.

Warning

2023 PACK_CREATE_
TOPOLOGY

STG_BOM FROM_DATE OR TO_DATE IS 
NOT VALID.

Warning

2024 PACK_CREATE_
TOPOLOGY

STG_BOM TO_DATE IS LESS THAN 
FROM_DATE.

Warning

2030 PACK_CREATE_
TOPOLOGY

STG ITEM ID IS NULL Warning

2031 PACK_CREATE_
TOPOLOGY

STG ITEM NAME IS NULL Warning

2035 PACK_CREATE_
TOPOLOGY

STG ITEM ATTRIBUTE ID IS NULL Warning

2036 PACK_CREATE_
TOPOLOGY

STG ITEM ATTRIBUTE ID IS NOT IN 
STG_ITEM_LIST

Warning

2037 PACK_CREATE_
TOPOLOGY

STG ITEM ATTRIBUTE NAME IS NULL Warning

2038 PACK_CREATE_
TOPOLOGY

STG ITEM ATTRIBUTE VALUE IS NULL Warning

2040 PACK_CREATE_
TOPOLOGY

STG LOCATION ID IS NULL Warning

2041 PACK_CREATE_
TOPOLOGY

STG LOCATION NAME IS NULL Warning

2045 PACK_CREATE_
TOPOLOGY

STG LOCATION ATTRIBUTE ID IS NULL Warning

2046 PACK_CREATE_
TOPOLOGY

STG LOCATION ATTRIBUTE ID IS NOT IN 
STG_LOCATION_LIST

Warning

2047 PACK_CREATE_
TOPOLOGY

STG LOCATION ATTRIBUTE NAME IS 
NULL

Warning

2048 PACK_CREATE_
TOPOLOGY

STG LOCATION ATTRIBUTE VALUE IS 
NULL

Warning

2050 PACK_CREATE_
TOPOLOGY

STG SALES ITEM_ID IS NULL Warning

Reject 
ID

Package Name Message Classifi-
cation
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2051 PACK_CREATE_
TOPOLOGY

STG SALES ITEM_ID IS NOT IN 
STG_ITEM_LIST

Warning

2052 PACK_CREATE_
TOPOLOGY

STG SALES LOCATION_ID IS NULL Warning

2053 PACK_CREATE_
TOPOLOGY

STG SALES LOCATION_ID IS NOT IN 
STG_LOCATION_LIST

Warning

2054 PACK_CREATE_
TOPOLOGY

STG SALES SHIP_TO IS NOT IN 
STG_LOCATION_LIST

Warning

2055 PACK_AUGMENT_
DATA

STG SALES PERIOD_DATE IS NOT IN 
PLANNING_PERIOD

Warning

2060 PACK_CREATE_
TOPOLOGY

STG_HISTORICAL_PRODUCTION 
ITEM_ID IS NULL

Warning

2061 PACK_CREATE_
TOPOLOGY

STG_HISTORICAL_PRODUCTION 
ITEM_ID IS NOT IN STG_ITEM_LIST

Warning

2062 PACK_CREATE_
TOPOLOGY

STG_HISTORICAL_PRODUCTION 
LOCATION_ID IS NULL

Warning

2063 PACK_CREATE_
TOPOLOGY

STG_HISTORICAL_PRODUCTION 
LOCATION_ID IS NOT IN 
STG_LOCATION_LIST

Warning

2070 PACK_CREATE_
TOPOLOGY

STG_PURCHASE_ORDER ITEM_ID IS 
NULL

Warning

2071 PACK_CREATE_
TOPOLOGY

STG_PURCHASE_ORDER ITEM_ID IS NOT 
IN STG_ITEM_LIST

Warning

2072 PACK_CREATE_
TOPOLOGY

STG_PURCHASE_ORDER 
SOURCE_LOCATION_ID IS NULL

Warning

2073 PACK_CREATE_
TOPOLOGY

STG_PURCHASE_ORDER 
SOURCE_LOCATION_ID IS NOT IN 
STG_LOCATION_LIST

Warning

2074 PACK_CREATE_
TOPOLOGY

STG_PURCHASE_ORDER 
DESTINATION_LOCATION_ID IS NULL

Warning

2075 PACK_CREATE_
TOPOLOGY

STG_PURCHASE_ORDER 
DESTINATION_LOCATION_ID IS NOT IN 
STG_LOCATION_LIST

Warning

Reject 
ID
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cation
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2080 PACK_CREATE_
TOPOLOGY

STG NODE ATTRIBUTE NAME IS NULL Warning

2081 PACK_CREATE_
TOPOLOGY

STG NODE ATTRIBUTE VALUE IS NULL Warning

2200 PACK_PATTERN Item_name not found in MIPO planning_sku 
table.

Warning

2201 PACK_PATTERN Pattern_name not found in MIPO pattern table. Warning

2205 PACK_LINE Plant_name not found in MIPO location table. Warning

2210 PACK_LINE_ITEM_
INPUT

Line_name not found in MIPO line table. Warning

2211 PACK_LINE_ITEM_
INPUT

Item_name not found in MIPO planning_sku 
table.

Warning

2215 PACK_LINE_
ATTRIBUTE_MAP

Line_name not found in MIPO line table. Warning

2220 PACK_LINE_ITEM_
ATTRIBUTE_MAP

Line Item combination not found in MIPO 
line_sku_input table.

Warning

2222 PACK_LINE_ITEM_
ATTRIBUTE

Line Item combination not found in MIPO 
line_sku_input table.

Warning

2225 PACK_ITEM_DEMAND Plant item combo did not have a corresponding 
sku_input_key in MIPO.

Warning

2230 PACK_CHANGEOVER_
MATRIX

Line_name not found in MIPO line table. Warning

2231 PACK_CHANGEOVER_
MATRIX

Source item_name not found in MIPO 
planning_sku table.

Warning

2232 PACK_CHANGEOVER_
MATRIX

Target item_name not found in MIPO 
planning_sku table.

Warning

2235 PACK_PRODUCTION
_CONSTRAINTS

Source_line_name did not have a corresponding 
line_name in MIPO line table.

Warning

2236 PACK_PRODUCTION
_CONSTRAINTS

Target_line_name did not have a corresponding 
line_name in MIPO line table.

Warning

Reject 
ID

Package Name Message Classifi-
cation
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2237 PACK_PRODUCTION
_CONSTRAINTS

Source_item_name was not null and did not have 
a corresponding value in MIPO planning_sku 
table.

Warning

2238 PACK_PRODUCTION
_CONSTRAINTS

Target_item_name was not null and did not have a 
corresponding value in MIPO planning_sku table.

Warning

2239 PACK_PRODUCTION
_CONSTRAINTS

Target_item_name was null but 
source_item_name was not null.

Warning

2240 PACK_PRODUCTION
_CONSTRAINTS

Source_item_name was null but 
target_item_name was not null.

Warning

2245 PACK_PLANT_ITEM
_ATTRIBUTE

Plant not found in MIPO plant table. Warning

2246 PACK_PLANT_ITEM
_ATTRIBUTE

Item not found in MIPO planning_sku table. Warning

2250 PACK_AUGMENT_
DATA

ALERT_NAME IS NULL Warning

2251 PACK_AUGMENT_
DATA

ALERT_INSTANCE_NUMBER IS NULL Warning

2252 PACK_AUGMENT_
DATA

SETTING_NAME IS NULL Warning

2253 PACK_AUGMENT_
DATA

SETTING_NAME NOT IN ERROR, 
INFORMATIONAL,WARNING, FATAL FOR 
SETTING_NAME SEVERITY

Warning

2256 PACK_BUSINESS_
ALERTS

ALERT_NAME IS NULL OR NOT IN THE 
LIST FROM TABLE 
MIPO_BUSINESS_ALERTS_RULE

Warning

2257 PACK_BUSINESS_
ALERTS

ALERT_INSTANCE_NUMBER IS NULL Warning

2258 PACK_BUISNESS_
ALERTS

SETTING_NAME IS NULL Warning

2259 PACK_BUISNESS_
ALERTS

SETTING_VALUE NOT IN ERROR, 
INFORMATIONAL,WARNING, FATAL FOR 
SETTING_NAME SEVERITY

Warning

Reject 
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2260 PACK_BUISNESS_
ALERTS

COMPARE_SCENARIO_NAME NOT VALID Warning

2270 PACK_AUGMENT_
DATA

ship_to_location_id is null Warning

2271 PACK_AUGMENT_
DATA

demand_interval must be a positive integer Warning

2280 pack_demand_stream_
input

planning_sku_key is null Warning

2281 pack_demand_stream_
input

planning_location_key is null Warning

2282 pack_demand_stream_
input

ship_to_location_key is null Warning

2300 PACK_STG_TABLE
_VALIDATION

STG_FORECAST FORECAST_VALUE IS 
NULL.

Error

2301 PACK_STG_TABLE
_VALIDATION

STG_FORECAST FORECAST_VALUE IS 
NEGATIVE.

Error

2302 PACK_STG_TABLE
_VALIDATION

STG_PERSISTENT_FORECAST 
FORECAST_VALUE IS NULL.

Error

2303 PACK_STG_TABLE
_VALIDATION

STG_PERSISTENT_FORECAST 
FORECAST_VALUE IS NEGATIVE.

Error

2304 PACK_STG_TABLE
_VALIDATION

STG_EXTERNAL_DEMAND 
DEMAND_VALUE IS NULL OR NEGATIVE.

Error

2305 PACK_STG_TABLE
_VALIDATION

STG_EXTERNAL_DEMAND 
DEMAND_ERROR_VALUE IS NULL OR 
NEGATIVE.

Error

2306 PACK_STG_TABLE
_VALIDATION

STG_DEMAND_STREAM_INPUT 
DEMAND_INTERVAL IS NEGATIVE.

Error

2307 PACK_STG_TABLE
_VALIDATION

STG_DEMAND_STREAM_INPUT 
DEMAND_INTERVAL IS GREATER THAN 
HISTORICAL HORIZON.

Error

2308 PACK_STG_TABLE
_VALIDATION

STG_BOM QUANTITY LESS THAN OR 
EQUAL TO 0.

Error

Reject 
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2309 PACK_STG_TABLE
_VALIDATION

STG_SOURCING FROM_LOCATION_ID IS 
CUSTOMER.

Error

2310 PACK_STG_TABLE
_VALIDATION

STG_SOURCING TO_LOCATION_ID IS 
CUSTOMER.

Error

2311 PACK_STG_TABLE
_VALIDATION

STG_SOURCING MODE_UTILIZATION IS 
NEGATIVE.

Error

2312 PACK_STG_TABLE
_VALIDATION

STG_SOURCING DURATION IS 
NEGATIVE.

Error

2313 PACK_STG_TABLE
_VALIDATION

STG_SOURCING SOURCING_QUOTA IS 
NEGATIVE.

Error

2314 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC 
SERVICE_LEVEL MUST BE BETWEEN 
(.50,.9999).

Error

2315 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC 
MIN_SERVICE_LEVEL MUST BE 
BETWEEN (.50,.9999).

Error

2316 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC 
MAX_SERVICE_LEVEL MUST BE 
BETWEEN (.50,.9999).

Error

2317 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC 
MAX_SERVICE_LEVEL MUST BE GE 
MIN_SERVICE_LEVEL

Error

2318 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC 
STOCKING_POINT_TYPE MUST BE one of 
(StockingNode, NonManagedNode, 
NonStockingNode)

Error

2319 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC 
HOLDING_COST_PCT MUST BE GREATER 
THAN 0

Error

2320 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC 
INVENTORY_UNIT_COST MUST BE 
GREATER THAN 0

Error

2321 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC 
INVENTORY_UNIT_COST MUST BE LE 
UNIT_TRANSFER_PRICE

Error
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2322 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC 
UNIT_PURCHASE_COST MUST BE LE 
INVENTORY_UNIT_COST

Error

2323 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC PBR MUST 
BE AN INTEGER > 0

Error

2324 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC PSLR 
MUST BE NULL OR AN INTEGER GE 0

Error

2325 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC PSLR 
MUST BE < PBR

Error

2326 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC 
MAX_SHIP_LIFE MUST BE NULL OR A 
NUMBER > 0 OR -1 (INFINITY)

Error

2327 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC 
STORAGE_CAPACITY MUST BE NULL OR A 
NUMBER > 0 OR -1 (INFINITY)

Error

2328 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC 
LOST_SALES_PERCENTAGE MUST BE 
NULL OR A NUMBER GE 0

Error

2329 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_TV 
MIN_REQUIRED_STOCK CANNOT BE A 
NEGATIVE NUMBER OR NULL

Error

2330 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_STATIC 
PHYSICAL_LEAD_TIME CANNOT BE A 
NEGATIVE NUMBER

Error

2331 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_STATIC 
PROCESSING_LEAD_TIME CANNOT BE A 
NEGATIVE NUMBER

Error

2332 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_STATIC 
LEAD_TIME_ERROR CANNOT BE A 
NEGATIVE NUMBER

Error

2333 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_STATIC 
SERVICE_TIME CANNOT BE A NEGATIVE 
NUMBER

Error

2334 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_STATIC YIELD 
CANNOT BE A NEGATIVE NUMBER

Error

Reject 
ID

Package Name Message Classifi-
cation
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2335 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_STATIC 
BATCH_SIZE CANNOT BE A NEGATIVE 
NUMBER

Error

2336 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_STATIC 
RELIABILITY MUST BE A NUMBER 
BETWEEN 0 AND 1

Error

2337 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_STATIC 
MINIMUM_BATCH_SIZE CANNOT BE A 
NEGATIVE NUMBER

Error

2338 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_STATIC 
FROZEN_WINDOW CANNOT BE A 
NEGATIVE NUMBER

Error

2339 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_STATIC 
MIN_BATCH_SIZE_IN_PERIODS CANNOT 
BE A NEGATIVE NUMBER

Error

2340 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_STATIC AT LEAST 
ONE OF THE NUMERIC COLUMNS MUST 
BE NON-NULL

Error

2341 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_TV 
PLANNED_RECEIPTS CANNOT BE A 
NEGATIVE NUMBER

Error

2342 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_TV 
MIN_PROCESS_QUANTITY CANNOT BE A 
NEGATIVE NUMBER

Error

2343 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_TV 
MAX_PROCESS_CAPACITY MUST BE NULL 
OR A NUMBER GE 0 OR -1 (INFINITY)

Error

2344 PACK_STG_TABLE
_VALIDATION

STG_DEFAULT_PATH_TV AT LEAST ONE 
OF THE NUMERIC COLUMNS MUST BE 
NON-NULL

Error

2345 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
PHYSICAL_LEAD_TIME CANNOT BE A 
NEGATIVE NUMBER

Error

Reject 
ID

Package Name Message Classifi-
cation
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2346 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
PROCESSING_LEAD_TIME CANNOT BE A 
NEGATIVE NUMBER

Error

2347 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
LEAD_TIME_ERROR CANNOT BE A 
NEGATIVE NUMBER

Error

2348 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
SERVICE_TIME CANNOT BE A NEGATIVE 
NUMBER

Error

2349 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC YIELD 
CANNOT BE A NEGATIVE NUMBER

Error

2350 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
BATCH_SIZE CANNOT BE A NEGATIVE 
NUMBER

Error

2351 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
RELIABILITY MUST BE A NUMBER 
BETWEEN 0 AND 1

Error

2352 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
MINIMUM_BATCH_SIZE CANNOT BE A 
NEGATIVE NUMBER

Error

2353 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
FROZEN_WINDOW CANNOT BE A 
NEGATIVE NUMBER

Error

2354 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
MIN_BATCH_SIZE_IN_PERIODS CANNOT 
BE A NEGATIVE NUMBER

Error

2355 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
SERVICE_LEVEL MUST BE BETWEEN 
(.50,.9999)

Error

2356 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
MIN_SERVICE_LEVEL MUST BE 
BETWEEN (.50,.9999)

Error

2357 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
MAX_SERVICE_LEVEL MUST BE 
BETWEEN (.50,.9999)

Error

Reject 
ID
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2358 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
MAX_SERVICE_LEVEL MUST BE GE 
MIN_SERVICE_LEVEL

Error

2359 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
LOST_SALES_PERCENTAGE MUST BE A 
NUMBER BETWEEN 0 AND 1

Error

2360 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC 
LOSS_FREE_SERVICE_LEVEL MUST BE A 
NUMBER BETWEEN 0 AND 1

Error

2361 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_STATIC AT LEAST 
ONE OF THE NUMERIC COLUMNS MUST 
BE NON-NULL

Error

2362 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_TV 
PLANNED_RECEIPTS CANNOT BE A 
NEGATIVE NUMBER

Error

2363 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_TV 
MIN_PROCESS_QUANTITY CANNOT BE A 
NEGATIVE NUMBER

Error

2364 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_TV 
MAX_PROCESS_CAPACITY MUST BE NULL 
OR A NUMBER GE 0 OR -1 (INFINITY)

Error

2365 PACK_STG_TABLE
_VALIDATION

STG_OVERRIDE_PATH_TV AT LEAST ONE 
OF THE NUMERIC COLUMNS MUST BE 
NON-NULL

Error

2366 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_STATIC 
INV_ALLOC_POLICY must be Divide or 
Priority

Error

2367 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
HOLDING_COST_PCT MUST BE GREATER 
THAN 0

Error

2368 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
INVENTORY_UNIT_COST MUST BE 
GREATER THAN 0

Error

Reject 
ID

Package Name Message Classifi-
cation
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2369 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
INVENTORY_UNIT_COST MUST BE LE 
UNIT_TRANSFER_PRICE

Error

2370 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC PBR 
MUST BE AN INTEGER > 0

Error

2371 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
PSLR MUST BE NULL OR AN INTEGER GE 
0

Error

2372 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
PSLR MUST BE < PBR

Error

2373 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
SERVICE_LEVEL MUST BE BETWEEN 
(.50,.9999).

Error

2374 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
MAX_SHIP_LIFE MUST BE NULL OR A 
NUMBER > 0 OR -1 (INFINITY)

Error

2375 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
UNIT_PURCHASE_COST MUST BE LE 
INVENTORY_UNIT_COST

Error

2376 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
STOCKING_POINT_TYPE MUST BE one of 
(StockingNode, NonManagedNode, 
NonStockingNode)

Error

2377 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
MIN_SERVICE_LEVEL MUST BE 
BETWEEN (.50,.9999).

Error

2378 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
MAX_SERVICE_LEVEL MUST BE 
BETWEEN (.50,.9999).

Error

2379 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
MAX_SERVICE_LEVEL MUST BE GE 
MIN_SERVICE_LEVEL

Error

2380 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
LOST_SALES_PERCENTAGE MUST BE 
NULL OR A NUMBER GE 0

Error

Reject 
ID
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2381 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
STORAGE_CAPACITY MUST BE NULL OR A 
NUMBER > 0 OR -1 (INFINITY)

Error

2382 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
INV_ALLOC_POLICY must be Divide or 
Priority

Error

2383 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
PROCESSING_LEAD_TIME CANNOT BE A 
NEGATIVE NUMBER

Error

2384 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
LEAD_TIME_ERROR CANNOT BE A 
NEGATIVE NUMBER

Error

2385 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
SERVICE_TIME CANNOT BE A NEGATIVE 
NUMBER

Error

2386 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
YIELD CANNOT BE A NEGATIVE 
NUMBER

Error

2387 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
BATCH_SIZE CANNOT BE A NEGATIVE 
NUMBER

Error

2388 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
RELIABILITY MUST BE A NUMBER 
BETWEEN 0 AND 1

Error

2389 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
MINIMUM_BATCH_SIZE CANNOT BE A 
NEGATIVE NUMBER

Error

2390 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
FROZEN_WINDOW CANNOT BE A 
NEGATIVE NUMBER

Error

2391 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
MIN_BATCH_SIZE_IN_PERIODS CANNOT 
BE A NEGATIVE NUMBER

Error

Reject 
ID

Package Name Message Classifi-
cation
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2392 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_TV 
PLANNED_RECEIPTS CANNOT BE A 
NEGATIVE NUMBER

Error

2393 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_TV 
MIN_PROCESS_QUANTITY CANNOT BE A 
NEGATIVE NUMBER

Error

2394 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_TV 
MAX_PROCESS_CAPACITY MUST BE NULL 
OR A NUMBER GE 0 OR -1 (INFINITY)

Error

2395 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_TV AT 
LEAST ONE OF THE NUMERIC COLUMNS 
MUST BE NON-NULL

Error

2396 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LOCATION_PATH_TV 
MIN_REQUIRED_STOCK CANNOT BE A 
NEGATIVE NUMBER

Error

2397 PACK_STG_TABLE
_VALIDATION

STG_NEW_ITEM_MAP CONVERSION 
FACTOR MUST GREATER THAN 0

Error

2398 PACK_STG_TABLE
_VALIDATION

STG_HISTORICAL_PRODUCTION 
PLANNED_PRODUCTION CANNOT BE A 
NEGATIVE NUMBER

Error

2399 PACK_STG_TABLE
_VALIDATION

STG_HISTORICAL_PRODUCTION 
ACTUAL_PRODUCTION CANNOT BE A 
NEGATIVE NUMBER

Error

2400 PACK_STG_TABLE
_VALIDATION

STG_HISTORICAL_PRODUCTION AT 
LEAST ONE OF THE NUMERIC COLUMNS 
MUST BE NON-NULL

Error

2401 PACK_STG_TABLE
_VALIDATION

STG_PURCHASE_ORDER 
CREATION_DATE MUST BE LE 
SUBMISSION_DATE

Warning

2402 PACK_STG_TABLE
_VALIDATION

STG_PURCHASE_ORDER 
SUBMISSION_DATE MUST BE LE 
RECEIPT_DATE

Warning

2403 PACK_STG_TABLE
_VALIDATION

STG_PURCHASE_ORDER ORDER 
QUANTITY MUST GREATER THAN 0

Warning

Reject 
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2404 PACK_STG_TABLE
_VALIDATION

STG_ITEM_LIST ITEM_ID SHOULD NOT 
CONTAIN THE | CHARACTER

Error

2405 PACK_STG_TABLE
_VALIDATION

STG_LOCATION_LIST LOCATION_ID 
SHOULD NOT CONTAIN THE | 
CHARACTER

Error

2410 PACK_AUGMENT
_DATA

SUPPLY_PATH 
PERIOD_BETWEEN_SHIPMENTS SHOULD 
NOT BE LESS THAN 0 

Warning

2411 PACK_AUGMENT
_DATA

DATA SUPPLY_PATH - WARNING - 
PERIOD_BETWEEN_SHIPMENTS ON A 
SUPPLY PATH IS GREATER THAN BOTH 
INPUT PBR ON THE TARGET NODE OF 
THE SUPPLY PATH AND 
MIN_BATCH_SIZE_IN_PERIODS ON THE 
SUPPLY PATH

Warning

2412 PACK_STG_TABLE_
VALIDATION

STG_SOURCING - WARNING - THERE ARE 
DUPLICATE ROWS IN STG_SOURCING.

Warning

2415 PACK_STG_TABLE_
VALIDATION

STG_SALES SALES_VALUE IS NEGATIVE. Error

2416 PACK_STG_TABLE_
VALIDATION

STG_PERSISTENT_SALES SALES_VALUE IS 
NEGATIVE.

Error

2420 PACK_STG_TABLE_
VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
SCHEDULE_ATTAINMENT_CV CANNOT 
BE A NEGATIVE NUMBER

Error

2421 PACK_STG_TABLE_
VALIDATION

STG_ITEM_LOCATION_STATIC 
SCHEDULE_ATTAINMENT_CV CANNOT 
BE A NEGATIVE NUMBER

Error

2422 PACK_STG_TABLE_
VALIDATION

STG_ITEM_LOCATION_PATH_STATIC 
SCHEDULE_ATTAINMENT MUST BE 
GREATER THAN 0

Error

2423 PACK_STG_TABLE_
VALIDATION

'STG_ITEM_LOCATION_STATIC 
SCHEDULE_ATTAINMENT MUST BE 
GREATER THAN 0

Error

Reject 
ID

Package Name Message Classifi-
cation

Table 14-19 Reject message definitions
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